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[, Ivan Zatkovich, hereby declare:

1. INTRODUCTION
1. | have been retained by Counsel for Patent Owner to provide opinions
on certain issues concerning Inter Partes Review No. IPR2013-00593 of U.S.

Patent No. 8,045,952 (“the ‘952 Patent”).

2. | am aware that the Petition filed in the above-identified proceeding
asserted various grounds and that the Board instituted this proceeding on a subset
of the asserted grounds. | am also aware that Petitioner submitted with the Petition
adeclaration of V. Michael Bove, Jr., Ph.D. (“the Bove Report”) opining on claim

construction and the validity of the challenged claims.

3. | have been asked to analyze the * 952 Patent, the art cited by the
Petitioner, the Bove Report, and the Institution Decision dated March 20, 2014
(“the Institution Decision”) as they relate to the particular grounds instituted by the
Board. My opinions are set forth below. | make these statements based upon facts
and matters within my own knowledge or on information provided to me by others.

All such facts and matters are true to the best of my knowledge and belief.

4, | am a Principal Consultant at eComp Consultants. My firmis

compensated at a standard rate of $475 per hour for my work on this matter. This
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compensation is not dependent on my opinions or testimony or the outcome of this

matter.

2. BACKGROUND AND QUALIFICATIONS

5. A copy of my curriculum vitae is attached as Exhibit 1.

6. | received a Bachelor’ s degree in Computer Science, with aminor in
Electrical Engineering Digital Circuit Design, from the University of Pittsburghin
1980. | completed a Master’ s thesis in Computer Networksin 1981 at the

University of Pittsburgh, the results of which were published in Byte Magazine.

7. | have over 28 years of experience in computer science, including
media file sharing and Web multi-media publishing (e.g., content, images,
audio/video streaming), early wireless/cell phone communication, CTl (Computer

Telephony Integration), eCommerce, and Geolocation.

8. | have been a Principal Consultant at eComp Consultants for over ten
years. eComp Consultants provides professional consulting services relating to
computer and technical mattersin awide range of industries including embedded
internet systems, cellular telephony, and cloud-based services. Such consulting
services include working with clients on specific information technology projects,
process improvement, project management, and other technology issues. eComp

Consultants also provides professional expert witness services.
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9. At eComp Consultants, | have been frequently called upon to provide
my expert opinion on matters concerning patent disputes. | have been qualified as
atechnical expert in over 24 matters including mediafile sharing, Web muilti-
media publishing, embedded internet systems, cellular telephony, and cloud-based
services, and have given testimony as an expert at trial and by deposition,
including in areas that relate to the technology described in the * 952 Patent. A
complete list of the cases in which | have testified in the last four yearsisincluded
in Exhibit 1. Relevant exemplary casesinclude:

e Certain Media Devices, Including Televisions, Blu-Ray Disc Players,
Home Theater Systems, Tablets and Mobile Phone, Components Ther eof
and Associated Software, Proceeding No. 337-TA-882 (pending) — |
served as an expert for Complainant Black Hills Media, LLC (the Patent
Owner in the above-identified proceedings) and provided severa expert
reports, which included my analysis and opinions regarding claim
construction, validity, and infringement of various claims of the ‘952
Patent inter alia.

e Zamorav. CBSRadio et al., 09-20940-CIV-MORENO (S.D. Fl.) (settled
2010) — | served as an expert for Plaintiff on issues of patent validity and

infringement for Internet radio technology. | also provided an expert
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report and was deposed regarding the use of streaming media and Web
radio players. The patents at issue claimed priority to 1999.

e ABCV.ENCetal., H-06-1032 (S.D. TX.) — I served as an expert for
Plaintiff in a patent infringement dispute concerning computer remote
controls, remote command processing, and remote communication. The
patents at issue claimed priority to 1998. | provided non-infringement

and invalidity rebuttal reports and was deposed regarding the same.

10. Inmy professional career, | have worked for companies such as
Digital Equipment Corp. and GTE Data Services (now Verizon) on projects
designing, developing, and integrating software and hardware for major computer
and telecommunications systems as well as Eva-Tone, Inc. on projects designing
and developing eCommerce, content management, and web publishing systems.
Relevant exemplary multimedia projects from my career include:

e EvaTonelInc. (2002-2007) — implemented online video streaming and

musi ¢ purchase systems for a music eCommerce website.

e GTE Data Services/Verizon (1987-1996) — developed digital voice and

multimedia communications using high speed ISDN & FDDI.

e Digital Equipment Corp. (1980-1987) — designed and implemented video

disk driver interfaces.

4
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11. By virtue of the above experience, | have gained a detailed
understanding of the technology that is at issue in this proceeding. My experience
with mediafile sharing, embedded internet systems, cellular telephony, cloud-
based services, and Web multi-media publishing (content, images, audio/video
streaming) is directly relevant to the subject matter of the ‘952 Patent. | am also
particularly familiar with the * 952 Patent as a result of the expert testimony that |
provided on behalf of the Patent Owner in the pending I TC Proceeding No. 337-
TA-882, in which | provided my opinions regarding claim construction and

validity of the ‘952 Patent.

12. | believel am qualified to provide opinions about how one of ordinary
skill in the art in November 2000 would have interpreted and understood the ‘ 952

Patent and the art relied upon by the Petitioner as discussed below.

3. LEGAL STANDARDS

3.1. Anticipation

13. | understand that aclaim is anticipated if asingle prior art reference
discloses, explicitly or inherently, al limitations of the invention arranged or
combined in the same way asin the claim. | further understand that inherency may
not be established by probabilities or possibilities, and the fact that one of ordinary

skill in the art understands that the missing limitation could exist under certain
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circumstances is not sufficient. Instead, the party claiming inherency must prove
that the missing matter is necessarily present and that it would be so recognized by
aperson of ordinary skill intherelevant art. Whether the inherent disclosure was

recognized at the time of the reference isimmaterial.

14. | further understand that the disclosure of an anticipatory reference
must describe the claimed invention to a degree adequate to enable person of
ordinary skill in the art to not only comprehend the invention, but also to make, or
in the case of a method, use, the claimed invention without undue experimentation.
Provided that the reference asserted is enabling, it is my understanding that it need

not disclose any independent use or utility to anticipate a claimed invention.

3.2. Obviousness

15. Itismy understanding that an invention is unpatentable if the
differences between the invention and the prior art are such that the subject matter
as awhole would have been obvious at the time the invention was made to a
person having ordinary skill in the art. | further understand that obviousnessis
determined by evaluating: (1) the scope and content of the prior art, (2) the
differences between the prior art and the claim, (3) the level of ordinary skill in the
art, and (4) secondary considerations of non-obviousness. To establish

obviousness based on a combination of the elements disclosed in the prior art, it is
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my understanding that a petitioner must identify a specific combination that
teaches all limitations and establish that a person of ordinary skill in the art at the
time of the claimed invention would have found it obvious to make that

combination.

16. Toguard against hindsight and an unwarranted finding of
obviousness, | understand that an important component of any obviousness inquiry
Iswhether the petitioner has identified any teaching, suggestion or motivation that
would have prompted a person of ordinary skill in the art to make the claimed
combination and have a reasonable expectation of successin doing so. |
understand that this test should not be rigidly applied, but can be an important tool

to avoid the use of hindsight in the determination of obviousness.

17. | further understand that the teaching, suggestion, or motivation may
be found explicitly or implicitly: (1) in the prior art; (2) in the knowledge of those
of ordinary skill in the art that certain references, or disclosuresin those references,
are of special interest or importance in the field; or (3) from the nature of the
problem to be solved. Additionally, | understand that the legal determination of
the motivation to combine references allows recourse to logic, judgment, and

common sense. In order to resist the temptation to read into prior art the teachings
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of the invention in issue, however, it should be apparent that the expert is not

conflating “common sense” and what appears obvious in hindsight.

18. | understand that if the teachings of a prior art would lead a person of
ordinary skill in the art to make a modification that would render another prior art
device inoperable, then such a modification would generally not be obvious. | also
understand that if a proposed modification would render the prior art invention
being modified unsatisfactory for its intended purpose, then there is no suggestion

or motivation to make the proposed modification.

19. | understand that it isimproper to combine references where the
references teach away from their combination. | understand that a reference may
be said to teach away when a person of ordinary skill in the relevant art, upon
reading the reference, would be discouraged from following the path set out in the
reference, or would be led in a direction divergent from the path that was taken by
the applicant. In general, areference will teach away if it suggests that the line of
development flowing from the reference’ s disclosure is unlikely to be productive
of the result sought by the patentee. | understand that a reference teaches away, for
example, if (1) the combination would produce a seemingly inoperative device, or
(2) the references leave the impression that the product would not have the

property sought by the patentee. | also understand, however, that a reference does
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not teach away if it merely expresses a general preference for an alternative
invention but does not criticize, discredit, or otherwise discourage investigation

into the invention clamed.

20. | understand that where the party asserting invalidity establishes a
primafacie case of obviousness, the burden shifts to the patent owner to come
forward with objective evidence demonstrating secondary considerations of non-
obviousness. | have been instructed that secondary considerationsinclude: (1)
long-felt but unsolved need; (2) commercia success of the invention; (3) failed
efforts of others; (4) copying by others; (5) praise for the invention; (7) unexpected
results; (8) disbelief of experts; (9) general skepticism of those in the art; (10)
commercia acquiescence; and (11) simultaneous development. | understand that
evidence of secondary considerations must be considered as part of all the
evidence, not just when the decision maker remains in doubt after reviewing the

art.

21. | aso understand that there must be a nexus between the claimed
invention and the secondary considerations before the evidence is relevant to the
guestion of obviousness. In particular, in the case of commercial success of a
product embodying the claimed invention, | understand that the success must be

shown to have in some way been due to the nature of the claimed invention, as
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opposed to other economic or commercial factors unrelated to the technical quality
of the patented subject matter. | understand that commercial acquiescence and
licensing are indicative of nonobviousness where it involves prominent or a

substantial portion of the competitorsin the relevant market.

4. SUMMARY OF MY STUDY
22. | haveread the ‘952 Patent and have considered its disclosure from

the perspective of a person of ordinary skill in the art in November 2000.

23. | have aso read and considered inter alia the Petition for Inter Partes

Review of the ‘952 Patent, the Bove Report, and the Institution Decision.

24. | have aso read the following references upon which the Board
instituted this proceeding, and considered them from the perspective of the person

of ordinary skill in the art in November 2000:

e Bermanetal., U.S. Patent No. 6,502,194, entitled “ System for

Playback of Network Audio Material on Demand” (“Berman”); and

e Wolff et al., U.S. Patent No. 7,472,353, entitled “Remote Console

for Network Application Servers’ (“Wolff”).

25. | am also familiar with alarge number of other prior art referencesin

the field of the invention, including but not limited to references cited by the

10
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Petitioner in this and related | PR proceedings and references considered by the

partiesin the I TC proceeding regarding the * 952 Patent mentioned above.

S. ONE OF ORDINARY SKILL IN THE ART

26. Itismy opinion that the relevant field with respect to the ‘952 Patent
ismediafile sharing. The ordinary level of skill inthe art isaBachelor’sdegreein
computer science or electrical engineering or its equivalent and 1-2 years of

experience with mediafile sharing.

27. Inreaching the opinions contained herein, | have considered the types
of problems encountered in the art in November 2000, the sophistication of the
technology, and the education level and professional capabilities of workersin the
field. The basisof my familiarity with the level of skill in the art is my years of
interaction with large numbers of workersin the field and my knowledge of the

technical issuesin the field.

28. The Bove Report indicates that “a person of ordinary skill in the art
pertaining to the ‘952 patent would have at least a bachelor’ s degree in computer
science or electrical engineering, and at least one year of practical experience with

networked multimedia” Ex. 1002, 8.

29. Inmy opinion, thereisno material difference in my and the Bove

Report’ s opinion of the fields of experience (“mediafile sharing” versus

11
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“networked multimedia’). However, | do take issue with the Bove Report’ s open-
ended definition of the level of experience of a person of ordinary skill in the art
(i.e., “at least one year of practical experience. ..”) because it obscures the issue of

what “ordinary” skill means.

6. OVERVIEW OF THE ‘952 PATENT

30. In 2000, when the provisional application disclosing the subject
matter that was ultimately claimed in the ‘952 Patent was filed, the industry was
working to aggregate or collect audio content from multiple sources. For example,
some companies were devel oping products that aggregated content on player
devices such as a personal digital assistant (PDA) or other devices with large
amounts of storage. Alternatively, some companies focused instead on products
that aggregated audio content centrally such that a user’s player device could
receive for playback centrally-stored audio content selected by that particular

device.

31.  Whiletheindustry was predominantly focused on the significance of
the audio content in digital content distribution systems emerging in November
2000, the ‘952 Patent was focused on the role of playlistsin managing audio
content. The ‘952 Patent relates to methods and systems for assigning playliststo

one or more electronic devices and for obtaining and playing songs identified by

12
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the playlists on the electronic device(s). Therole of the playlist in content
distribution systems is one of the more significant innovations disclosed in the
‘052 Patent—more specifically, the receipt of an assigned playlist by an electronic
device enables the playlist-receiving device to obtain and play the content
indicated by the playlist. For example, the ‘952 Patent describes a process that
allows auser logged into a central server (which may authorize the user based on a
password) to assign a centrally-managed playlist, identifying a plurality of songs
aggregated from one or more remote sources, to alocal electronic device. The
centrally-managed playlists can also be controlled by the user, for example, to add
songs to and delete songs from the playlist. See ‘952 Patent, 23:35-45 and 24:8-12.
A copy of the playlist can then be transmitted from the server to the device, such
that the receiving device takes control to obtain audio content of the songs
indicated the playlist from the one or more remote sources and to sequentially play
the songs identified by the playlist. See ‘952 Patent, Figures 19B-19C and 27:47-

30:18.

32. Inevery method and system described in the ‘952 Patent, three
distinct pieces of information are received or obtained by the electronic devicein

order to the play the songs indicated by a playlist assigned thereto:

13
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I. aplaylistidentifying aplurality of mediaitems (see, e.g., ‘952 Patent,
4.:29-30, “The playlistsinclude titles of audio from a variety of audio
sources.”);

ii.  information enabling the electronic device to obtain the mediaitems
(see, e.g., ‘952 Patent, 4:30-31, “The assignments provide information
about the location of other web sites containing the audio sources.”);
and

lii.  the mediaitems themselves (see, e.g., ‘952 Patent, 4:32-33, “The
software module is configured to connect through the I SP to the web

sites to download the audio files.”).

That is, the * 952 Patent distinguishes between the information for identifying a
song (e.g., asong title), the information for obtaining a song (e.g., alocation or
source from which a song identified in a playlist may be obtained), and the song

itself (e.g., an audio file to be streamed or downloaded).

33.  Though the ‘952 Patent makes clear that the information identifying
the songs (e.g., titles of songs within aplaylist) is distinct from both the
information used to obtain the songs and the song itself, the * 952 Patent indicates
that the information used by the electronic device to obtain the song can be

received independently from the playlist or can be received together with the

14
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information identifying the songs (e.g., appended to the playlist). For example, in
one embodiment, the ‘952 Patent describes a process in which each of these three

distinct pieces of information are received or obtained separately:

Another aspect of the present invention is a method for assigning playlists of
music from one electronic device to another. First, a network connection is
used for transmitting and receiving digital data over a communication
network to an Internet service provider. Next, the process provides a first
software module to manage playlists of songs. The software module allows
a user to compose playlists from a variety of audio sources. The software
module allows a user to assign a playlist from a first device to a second
device. Next, the process checks the second device' s data storage space for
songs listed on the assigned playlist. Next, the process accesses a server
site to obtain locations of the web sites the first device downloaded its
audio files from. The process then provides a second software module to
connect to various web sites to download remaining songs needed for the
playlist. The second software module connects if songs needed to form the
playlist are not stored on the second device's data storage space. Finally, the
process uploads files to the server from the first device and downloads files
[to] the second device if the second software module is unable to download
afilefrom said web site.

‘052 Patent, 4:50-5:3 (emphasis added).

34. However, the ‘952 Patent also provides embodiments in which the

information used by the electronic device to obtain the song can be received

15
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together with the information for identifying the songs (e.g., URL s appended to a
playlist identifying a plurality of songs). For example, in one embodiment
described in the * 952 Patent, the “playlist 1528” can be appended to include
“URL’ s of where the audio files were retrieved from.” ‘952 Patent, 21:62-65. See
also ‘952 Patent, 22:48-50 (“Within the playlist, the URL’sindicate the location
from which the audio files associated with the song titlesin the playlist can be

downloaded.”)

35. Regardless, the ‘952 Patent provides that even if the playlist and
information enabling the electronic device to obtain the song are received together,
the information identifying a song is different from the information used to obtain
asong. Inother words, while the playlist provides information identifying a
plurality of songs, the information for obtaining the song is distinct from the
information provided by the playlist. For example, in every portion of the * 952
Patent that explicitly shows the contents of a playlist, the title of the song is
identified as being included in the playlist. See Figures 17D, 17E, 17H, 18D, 18E,
18F of the ‘952 Patent. There are, however, no embodiments described in the * 952
Patent in which only a URL, for example, serves as information identifying a song,
or in which aplaylist consists exclusively of alist of URLs. Thus, the ‘952 Patent
makes clear that while the “information enabling a song to be obtained” can be

associated with the “information identifying the song,” the information enabling

16
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the electronic device to obtain asong in and of itself is not sufficient to identify the

song within the meaning of the ‘952 Patent.

36. Additional exemplary teachings of the ‘952 Patent are described in

detail below.

6.1. A Network-Enabled Electronic Device

37. One aspect of the ‘952 Patent is a network-enabled audio device that
allows a user to storefiles, to play standard audio CDs, to play MP3 encoded CDs,
to record songs from CDs, to receive digitized radio broadcasts over the World
Wide Web (Web), and to receive assignments of playlists of songs from other

network-enabled audio devices. See ‘952 Patent, 2:57-62.

38. Figure 11 of the ‘952 Patent (reproduced below) depicts one
exemplary embodiment of a computing environment for a network-enabled audio
device. The network includes network-enabled electronic device A (1108),
network-enabled electronic device B (1110), and personal computer (1106). These
electronic devicesinteract with a server (1104) “through the network 1102 (such as

the Internet).” ‘952 Patent, 16:56-60.

17
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e

|_ _______________________

FIO&# 5 :

ZaaN ' |

DEVICE B |

o] I R S o |
SERVER | TRANSFER amdel

DEVICE A

I
|
I
|
1
I
| — il
1
1
I
I
I

.
) i —
R

| USER CONTROLS
I | 1PAN
CLIENT FOR DEVICE

FIG  T7

6.2. Recelving aplaylist assigned to the electronic device

39. Insystemsdescribed by in the ‘952 Patent, the electronic devices
(e.g., devices (1108) and (1110)) receive playlists and playlist content over the
Internet, or adifferent network. For example, when the network is a*home
network,” an electronic device within the network “does not need to connect to the
Internet and can retrieve the necessary file through the network connection.” ‘952
Patent, 30:19-26. The home network can be, for example, a“local area network
(LAN) connection to a PC or other network-enabled audio device.” ‘952 Patent,
3:58-60. See also Figure 15 (depicting another example of anetwork including
network-enabled devices and a server) and ‘952 Patent, 23:1-5 (“In one

18
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embodiment, thereis no server site 1104. The PC IPAN client software 1532

stores the playlists that are located throughout the IPAN 1100.”).

40. Asdiscussed in detail below, the ‘952 Patent describes that an
electronic device in the network receives a playlist that identifies thetitles of a
plurality of songs. See, e.g., ‘952 Patent, 4:29-30 (“ The playlists include titles of
audio from avariety of audio sources.”). The songs of the playlist are arranged to
be played in a sequence, which can be a default order or arandom sequence
initiated by user selection of a“shuffle’ option. See, e.q., ‘952 Patent, 24:38-43
(“The playlists will typically start from the beginning,” however, the user “can
click the shuffle button 1796 to ‘randomize’ the playlist as opposed to playing the

playlist in the same order.”).

41. The ‘952 Patent describes that playlists can be assigned to (i.e.,
directed to) an electronic device from aremote source. In some embodiments, the
same playlist can be assigned to multiple devices. For example, both devices
(1510) and (1520) in the user’ s personal audio network can be assigned the same

playlist. See, e.g., ‘952 Patent, 24:50-53.

42.  In one embodiment, the electronic device is configured to “connect to

an Internet service provider to receive assignments of playlists. . ..” ‘952 Patent,

19
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2:37-40. The electronic device can receive assignments of playlists from, for

example, server (1104). See, e.q., Figures 11 and 15.

43.  When playlists are assigned to an electronic device from a server over
the Internet, the playlist can be assigned to the electronic device in response to
“process block 1904 where the user logs into the server site IPAN 1433.” ‘952
Patent, 28:11-14. For example, “[w]hen the device 1510 connects to the server site
IPAN 1104, aplaylistisassigned toit.” ‘952 Patent, 22:47-48. “The user can list
multiple devices as being part of hisor her IPAN.... The stored software module
in each device connects to the server site home page, viathe ISP, and inquires
whether any songs or playlists have been assigned to the device.” ‘952 Patent,
3:48-49. Seealso, ‘952 Patent, 12:32-38 (“1n one embodiment, the user is
prompted for a password that is stored on the data storage device 210 or entered
using the data-entry display 450. Establishing an account may include other
actions, such as creating a username for the user ... and entering information about

the user and the user’ s account.”).

44,  In another embodiment, playlists are assigned to the electronic device
from adevice on auser’ s home network. For example, the electronic device can
“receive assignments of playlists of songs from other network-enabled audio

devices.... Optionally, alLocal Area Network can be configured in place of, or in

20
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addition to, the Internet connection to facilitate assignments of playlists and other
features.” ‘952 Patent, 2:61-67. See also, ‘952 Patent, Figure 16 and 23:6-27,
describing that at step 1606, the user can select “ Setup Now” to enable the

electronic device to obtain audio content over the personal audio network.

45. The'952 Patent describes that in some embodiments, one or more
electronic devicesin the network have all “new files and updates automatically
downloaded to the device when it is connected to the IPAN 1100.” ‘952 Patent,
25:53-58. Inthisinstance, playlists are automatically assigned to the electronic

device simply by the user logging in from that device to the IPAN Server.

6.3. ldentifying ones of the plurality of songsin the playlist that are
not stored on the electronic device

46. The ‘952 Patent describes a process that, in some embodiments,
“checks to see what devices have the audio fileslisted in the playlist.” ‘952 Patent,
17:3-4. In some embodiments, the electronic device displays an “empty cone ...
beside the song in the playlist” to indicate that the song is not stored locally on the
electronic device. ‘952 Patent, 17:21-23 (see also ‘952 Patent, 29:34-35,
“Optionaly, theicon can be a symbol other than an empty cone.”). For example,
an excerpt from Figure 18D isreproduced below. As shown, the electronic device
displays an empty speaker cone next to song “Hello Goodbye.mp3” to indicate that

the song is not stored locally on the electronic device. In contrast, afull speaker
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cone is displayed next to the song “Animals — We Gotta Get Out Of This Place” to

indicate that the song islocally stored on the electronic device.

PLAYLIS T FAVORITES | JUKEBOX cp | INJERNET

D Favorites

+---0{)2 Animals — We Cotta Get Out Of This Place
r---(J- Hello Goodbye.mp3 (Beatles)

6.4. Recelvinginformation enabling the electronic deviceto obtain the
ones of the plurality of songs from aremote sour ce and obtaining
the songs

47.  Inthe 952 Patent, an electronic device receives, in addition to the

playlist, information enabling the device to obtain the songs of the playlist that are
not stored locally on the electronic device. For example, the ‘952 Patent provides
that the electronic device can receive Universal Resource Locators (URLS) that
identify the remote storage |ocations from which the audio content can be obtained.
Seeeg., 1952 Patent, 21:62-65 (* Each network enabled audio device 1510 has

storage space 1512 for a playlist 1528, which isalist of audio files and associated

URL’s of where the audio files were retrieved from.”).

48. When an electronic device obtains and plays back the audio content
corresponding to a song within a playlist, the audio content can be streamed to, or
downloaded by, the electronic device. For example, the ‘952 Patent provides that

the URL s used by the electronic device to obtain the songs of the playlist can be
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URLSsto streaming audio or URLs to downloadable MP3 files. Seee.g., ‘952
Patent, 21:65-22:4 (“Optionally, the associated URL’s can be archived for only file
formats that are streaming audio or MP3. ... The audio files can be streaming
audio, Windows Media Audio (WMA), and other audio formats.”). In some
embodiments, the electronic device does not include local storage and therefore
can only stream the audio content corresponding to the songs of a playlist from a
remote source. Seee.g., ‘952 Patent, 3:57-58 (“In one embodiment, the network-

enabled audio device has no disk for data storage space.”).

49. Theremote source from which the electronic device obtains the audio
content via streaming or download can be an electronic device on the user’s home
network or an electronic device that is accessible over the Internet. Seee.g., ‘952
Patent, 4:4-9 (*In one embodiment, the network-enabled audio device does not
have any storage space other than memory. This embodiment provides alow-cost
system that can play songs from playlists stored on the IPAN Manager or on the

PC'’ s storage space without having to store the audio files locally”).

6.5. Personal audio network server for managing playlists and devices
50. The*952 Patent describe embodimentsin which the network includes
apersonal audio network server (IPAN server) that allows the user to manage the

devicesin the user’s personal network and/or compose playlists.

23
BHM Ex. 2007



IPR2013-00593 (U.S. Patent 8,045,952)

51. For example, in some embodiments, the user “accesses a server site
viaa PC and the Internet. From the server site, the user obtainsalist of devicesin
his or her Internet Personal Audio Network (IPAN) and what songs are on those
devices. See ‘952 Patent, Abstract and 3:34-37. “In one embodiment, the Personal
Computer (PC) is used to compose the playlists, but the user is ableto listen to
playlists and other audio sources without using the PC.” ‘952 Patent, Abstract.
See also, ‘952 Patent, 23:66-24:3 (“To help manage playlists and devices, the
Playlist Manager 1700 provides personal audio information tabs 1726. The
devices that can be managed include network-enabled audio devices 1200 and
1300, PC'’s, portable MP3 players, cell phones, etc. With the personal audio

information tabs 1726, the user can view and manage the devices, playlists, etc.”).

52.  In some embodiments, “[t]he user control buttonsin the Playlist
Manager window include a client feature control button 1702, an audio player
window button 1704, a create new playlist button 1706, a delete button 1708, a
schedule button 1710, a play button 1712, a scan hard drive button 1714, an add
device button 1716, and a synchronize button 1718.” ‘952 Patent, 23:35-40.
“[T]he user presses the synchronize button 1718 so that the next time the device
1200 or 1300 connects, an updated playlist will be downloaded.” ‘952 Patent,

24:26-28.
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1. OPINIONSASTO CLAIM CONSTRUCTION

53. | have been asked to construe various terms as they appear in the
claims of the ‘952 Patent. | understand that in an inter partes review, claim terms
in an unexpired patent are interpreted according to their broadest reasonable
construction in light of the specification of the patent in which they appear from

the vantage point of one of ordinary skill in the relevant art.

7.1. Playlist

54. | believe that the broadest reasonable construction of the term
“playlist,” when interpreted in light of the ‘952 Patent from the vantage point of a
person of ordinary skill inthe art, is “alist referencing mediaitems arranged to be

played in a sequence.”

7.1.1. TheMediaFile Sharing Art Uses Playlist to Denote A
List of Media ltems Arranged To Be Played In A

Sequence
55. Based upon my relevant experience in industry, “playlist” isaterm
that is generally recognized in the mediafile sharing arts to mean a list referencing
media items arranged to be played in a sequence, i.e., alist of mediaitems that has
been created to be played sequentially, one after another. For example, aplaylist
could be alist of my favorite songsthat | liketo listen to, alist of romantic songs

so asto set a particular mood, or alist of songsto be played at an event (e.g., a
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playlist entitled “my wedding reception songs’), wherein the group of songs
identified by the playlist can be automatically played in the order in which they
appear. The following publications, for example, use “playlist” consistent with the
common understanding of the term at the time of the ‘952 Patent:
e TerraTec M3PO High Quality Audio Decoder Manual, dated May 18,
2000 (“the TerraTec Manual”). A copy of the TerraTec Manual is
attached as Exhibit 2:
- “Theplaylist is a pre-selected sequence of titles you wish the m3po
toplay.” P. 10.
- In Play Mode, the user can select “My Playlist”: “Playsthe playlist
in sequence once.” P. 20.
- At page 20, the TerraTec Manual also describes“DJ Mode”
(emphasis added):

“In DJ mode, you can pre-select titles, which will then be
played in the sequence you selected them, basically, it isa mini-
playlist (up to 10 titles), i.e. in case you need to go and get
some more drinks, or are involved in a chit-chat you wish
would never end. The operation is quick and easy:

e Switch play mode to DJ and the wheel to SELECT

(important, as you need to choose the titles).
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e Choose a title using the wheel. If no song is playing at
that time, this song (the (first song) will be played
immediately.

e Every other title you select, will be listed for playback
and marked with a “+”. Playback of the selected song

starts automatically after the current one.”

- “Playlists consist of pre-programmed titles which are played back
by the m3po.” P. 44.
e S REN™ Jukebox, published in 2000 (“the SSREN Jukebox Manual™). A
copy of the SREN™ Jukebox Manual is attached as Exhibit 3:
- Seepage 41 of the SREN Jukebox Manual (emphasis added):

“The Current Playlist

Regardless of whether it is playing from a CD, a music view, a
custom playlist, or a network location, Sren always performs
playback using the songs and sequence displayed in the Current
Playlist. Siren generates a Current Playlist each time the user
selects a song for playback from any of Siren's available
sources.”

- Seepage 43 of the SREN Jukebox Manual (italics added):

“Play in Order versus Play Randomized

When playing music from any source, users can specify
whether the Current Playlist is generated using the original
order, or with a random order, by clicking the playback toggle
button in the Transport panel
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e When 1 Is displayed, songs are played-back in the
listed order

e When " Is displayed, songs are played-back in a
random order
Play Once ver sus Continuous Play
Like the previous feature, users are able to specify whether
Current Playlist Playback occurs once, or is looped infinitely

by clicking the appropriate toggle button in the Transport panel.

=

e When is displayed, playback is halted once the CD

or playlist is complete

e When is displayed, playback continues infinitely
(looped)”

- Seepage 45 of the SREN Jukebox Manual (italics added):

“Playing Music from a Custom Playlist
As discussed previoudly, Siren will instantly generate a Current
Playlist to allow users to immediately begin listening to music
from the music library, a CD, or a network folder/drive. In
addition, Siren also allows users to create custom playlists to
satisfy individual tastes or requirements. To playback music
from aplaylist:
1. Display the music library by clicking the Manage My
Music Library icon in the Navigator panel or by choosing

Manage My Music Library from the View menu.
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2. Double-click the My Playlists icon in the Library
Manager to display all playlists.

3. Select the desired playlist. The playlist's songs are
listed.

4. Click on the Transport panel. Sren begins playing the
first song in the list and continues through the playlist.
To begin playback with an aternate track, double-click

the track, or select it and click.”

e Microsoft Windows Media™ Player 7 Handbook, published October 4,
2000, (“the Microsoft Handbook™). A copy of the Microsoft Handbook is
attached as Exhibit 4:

- See pages 39-40 of the Microsoft Handbook:

“Skip Back

This stops the currently playing item in the playlist and plays
the previous item in the same playlist. This corresponds to the
Previous button in the Player buttons at the bottom of the full
mode Player. If you are at the first item in a playlist and you
select Skip Back, the last item in the playlist will be played.
Skip Forward

This stops the currently playing item in the playlist and plays
the next item in the same playlist. This corresponds to the Next
button in the Player buttons at the bottom of the full mode
Player. If you are at the last item in a playlist and you select
Skip Forward, thefirst item in the playlist will be played.
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Shuffle

This plays the items in the current playlist in arandom order. It
does not change the order of the items in the playlist, only the
order in which they are played while the shuffle option is
selected.

Repeat

This repeats the playing of the entire current playlist, not
gpecificitemsin aplaylist. If you want to repeat only one item,

create a new playlist, put only that item in it, and repeat that
playlist.”

- See page 49 of the Microsoft Handbook (italics added):

“Using playlists

A playlist is a convenient way to organize groups of audio and
video files. The term comes from the radio industry and refers
to the list of songs that a disc jockey plays on a particular radio
program.

Y ou might want to make up playlists for different performers or
different kinds of music or videos. You can shuffle playlists or
repeat them endlessly. This way, you can create a media
experience that is continuously entertaining.

You can see which playlist is playing by looking in the upper-
right corner of the full mode Player. Y ou will see a drop-down

list box, which shows the current playlist.”
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56. Inmy opinion, each of the above exemplary references is consistent
with the understanding by a person having ordinary skill in the art in 2000 that the
term “playlist” denoted a sequence. See, e.g., the TerraTec Manual, p. 10 (“The
playlist is a pre-selected sequence of titles you wish the m3po to play.”); the
S REN Jukebox Manual, p. 41 (“ The Current Playlist — Regardless of whether it is
playing from a CD, amusic view, a custom playlist, or a network location, Siren
aways performs playback using the songs and sequence displayed in the Current
Playlist.”); the Microsoft Handbook, p. 40 (“ Shuffle— This plays the itemsin the

current playlist in arandom order. It does not change the order of the itemsin the

playlist, only the order in which they are played while the shuffle option is

selected”).

57. Moreover, each of the above exemplary referencesis consistent with
the understanding by a person having ordinary skill in the art in 2000 that the term
“playlist” denoted that the mediaitems were to be played in a sequence one after
another (i.e., as agroup, without having to select individual songs for playback).
See, e.g., the TerraTec Manual, p. 20 (“In DJ mode, you can pre-select titles,
which will then be played in the sequence you selected them, basically, it isamini-
playlist (up to 10 titles), i.e. in case you need to go and get some more drinks, or
are involved in a chit-chat you wish would never end. . . Playback of the selected

song starts automatically after the current one.”); the SREN Jukebox Manual, p. 45
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(“Select the desired playlist. The playlist’s songs are listed. . . Siren begins playing

the first song in the list and continues through the playlist.”); the Microsoft

Handbook, p. 40 (“Repeat — This repeats the playing of the entire current playlist,

not specific itemsin aplaylist. If you want to repeat only one item, create a new

playlist, put only that item in it, and repeat that playlist.”).

58. Thus, at the time of the time of the invention described in the * 952
Patent, a person of ordinary skill in the art (and even alay person) would have
understood the plain and ordinary meaning of “playlist” to denote alist that
references mediaitems arranged to be played in a sequence. In common parlance
at the time of the ‘952 Patent, the term “playlist” denoted a list of mediaitems
(e.g., songs) to be played in a sequence, one after another as a group, without
having to select individual songsfor playback. Indeed, the two parts of the word
itself make the meaning of the term self-evident: “play” and “list.” In all cases, the
operative function is “play,” which means the songs will be played as a group, not
individually. If the songsin aplaylist must be selected and played individually,

the purpose of the playlist would be lost.

59. A person of ordinary skill in the art at the time of the * 952 Patent
would also understand that a playlist is distinct in name and function from other

types of medialists. By way of example, an online music store can offer a
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“catalog” of songs, from which songs can be purchased individually and played.
For example, awebsite may display alist of “America s Top 40,” from which a
user could locate and download each of the listed songs. That alone, however,
does not suggest aplaylist. Unlessthe songs identified in the list were provided
for playback one after another in a sequence, the list would not be considered a

playlist by a person having ordinary skill in the art.

7.1.2. The'952 Patent Uses*” Playlist” Consistent with Its
Meaning in the Media File Sharing Art

60. The ‘952 Patent usesthe term “playlist” consistently according to this
well-known meaning to one of ordinary skill in the art. The specification of the
‘952 Patent makes clear that the mediaitems referenced by the playlist are
arranged to be played in a sequence. For example, at column 24, lines 31-43, the

‘052 Patent provides:

FIG. 17B illustrates the display of an audio player window 1792 that
includes a previous track button 1782, a play button 1784, a stop
button 1786, and a next track button 1790. The audio player window
1792 isinvoked by pressing the audio player window button 1704. A
volume indicator 1794 displays the current volume. The user can
click on the volume indicator 1794 to drag it higher or lower to a
different volume. The user can click the shuffle button 1796 to
‘randomize’ the playlist as opposed to playing the playlist in the same

order. Further, the user can press the repeat button 1798 in order to
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have continuous play as opposed to the playlist stopping when it runs
out of songs to play. The playlists will typically start from the
beginning.

61. Asdescribed inthe ‘952 Patent, a“playlist” will typically start at the
beginning of alist and not stop playing until it “runs out of songsto play.” That is,
the play from one song to the next in the sequence is continuous and does not

require a user to manually select the next song to play when the current song ends.

62. Thispassage of the ‘952 Patent quoted above also describes that a
user can go back to the previous song in the sequence by selecting the “previous
track button 1782” or skip ahead to the next song in the sequence by selecting the
“next track button 1790” as depicted in Figure 17B of the ‘952 Patent, if the user
so desires. Thisalso indicates that the songs of the playlist are ordered, otherwise
“next track” and “previous track” would have no meaning. Further, the user can
click a“shuffle button 1796” to “randomize” the playlist, as opposed to playing the
entire playlist in the specific order indicated. The user can also press a“repeat
button 1798” in order to play the entire playlist over and over, rather than stopping
upon reaching the end of the playlist. Together, these additional functionalities for
playback of the songs indicated by the playlist in the ‘952 Patent demonstrate that

the playlist isintrinsically arranged to be played in a sequence.
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63. The ‘952 Patent’s description of the user’ s ability to repeat or skip
songs indicated by the playlist, shuffle the order of songsindicated by the playlist,
or repeat playback of the playlist is aso consistent with the common understanding
by a person of ordinary skill in the art that the playback of songs indicated by the
playlist can be manipulated. For example, the above exemplary references
demonstrate at the time of the ‘952 Patent that playback of the songs indicated by

the playlist could be manipulated during playback by: repeating or skipping songs

(see Microsoft Handbook, p. 39 (“ Skip Back — This stops the currently playing
item in the playlist and plays the previous item in the same playlist. . . Skip
Forward - This stops the currently playing item in the playlist and plays the next

item in the same playlist.”)); shuffling the order of songs indicated by a playlist

(see SSREN Jukebox Manual, p. 43 (“Play in Order versus Play Randomized —
When playing music from any source, user can specify whether the Current
Playlist is generated using the original order, or with arandom order. . . .");
Microsoft Handbook, p. 40 (“ Shuffle — This plays the items in the current playlist
in arandom order. It does not change the order of the itemsin the playlist, only
the order in which they are played while the shuffle option is selected”)); or

repeating the playlist (see SREN Jukebox Manual, p. 43 (“Play Once versus

Continuous Play — Like the previous feature, users are able to specify whether

Current Playlist Playback occurs once, or islooped infinitely. . ..”; Microsoft
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Handbook, p. 40 (“Repeat — This repeats the playing of the entire current playlist,

not specific itemsin aplaylist.”)).

64. | understand that the Institution Decision reached a different
conclusion on the construction of the term “playlist” (not requiring that the items
be “arranged to be played in a sequence”). | also understand, however, that this
construction was reached without the benefit of testimonial evidence from the

Patent Owner:

“Patent Owner argues that the term also includes a requirement that the
playlist be arranged to be played in a sequence. . . . On the current record,
we are not persuaded that this description of audio player window 1792
narrows the previously cited definition of aplaylist.”

Institution Decision, p. 12 (emphasis added).

65. | believe the additional evidence that | have presented above warrants
reconsideration of this claim construction issue. In my opinion, it would not be
reasonable in light of the specification of the ‘952 Patent for one skilled in the art
to alter the common meaning of a playlist as connoting an arrangement of itemsto
be played in a sequence. | believe construing the term “playlist” without any
indication that the items are to be played sequentially is inaccurate and not
reasonable in light of the specification of the ‘952 Patent. At the time of the time

of the invention described in the * 952 Patent, a person of ordinary skill in the art

36
BHM Ex. 2007



IPR2013-00593 (U.S. Patent 8,045,952)

(and even alay person) would have understood the plain and ordinary meaning of
“playlist” aswell as the use of this term throughout the * 952 Patent to denote alist

that references mediaitems arranged to be played in a sequence.

7.1.3. AList of URLsisNot aPlaylist

66. | also understand that the Institution Decision construed the term
“playlist” to be “alist of audio files or URLs of where the audio fileswere

retrieved from.” Specifically, the Institution Decision indicated at pages 12-13:

“The specification of the '952 Patent defines ‘playlist 1528 . . . [ag] alist of
audio files and associated URLs of where the audio files were retrieved
from.” Ex. 1001, 21:63-65. . . [O]n the record currently before us, we
construe playlist to mean ‘alist of audio files or URLs of where the audio

fileswereretrieved from.”

67. | believethat the Board'sinterpretation of playlist asa*“list of audio

filesor URLSs...” isincorrect for several reasons.

68. Firdt, it appearsthat the Board’' sreferenceto “alist of audio files or
URLSs...” has been derived from the * 952 Patent’ s discussion of Figure 15 that
“illustrates a configuration for assigning playlists and audio sources to a network-
enabled audio device 1510 or other devices such as PC 1508 from a network-
enabled audio device or another device.” ‘952 Patent, 21:40-43. Specifically, in
this embodiment, the 952 Patent indicates that “[€]ach network enabled audio
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device 1510 has a storage space 1512 for a playlist 1528, which isalist of audio
files and associated URL’s of where the audio files were retrieved from.” ‘952

Patent, 21:62-65 (emphasis added).

69. The Board appears to suggest that a“playlist” can be “alist of audio
filesor alist of URLs of where audio files are retrieved from.” | do not believe the
passage of the * 952 Patent upon which the Board relies implies such an
interpretation. Rather, the quoted passage uses “and” to link the itemsincluded in
the particular playlist (1528). That the playlist (1528) described in this
embodiment includes alist of both audio filesand URLs also seems clear in the
use of the phrase “associated URL s of where the audio files were retrieved from.”
That is, if the particular playlist (1528) did not also list the audio files, there would
be nothing with which the URL s could be “associated.” Moreover, with continued
reference to Figure 15, the ‘952 Patent explicitly provides that “[w]ithin the
playlist, the URL’ s indicate the location from which the audio files associated with

the song titlesin the playlist can be downloaded. See also Ex. 1001, 22:48-50.

70. Moreimportantly, | believe that any construction of “playlist” that
encompasses alist consisting solely of URLS, or even one that requires the
inclusion of associated URL s, does not comport with that which a person of

ordinary skill in the art would have understood a playlist to include when read in
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light of the ‘952 Patent. Simply, a playlist need not include URLs and alist of

URLsisnot aplaylist.

71. Based upon my relevant experience in industry, “playlist” isaterm
that is generally recognized in the mediafile sharing arts to mean a list referencing
media itemsthat is arranged to be played in a sequence. The above-referenced
exemplary publications published around the time of the ‘952 Patent discuss and
use “playlist” consistent with the common understanding of the term at the time of

the ‘952 Patent as alist referencing media items.

72. By way of example, the Microsoft Handbook provides that “[a]
playlist is a convenient way to organize groups of audio and video files. Theterm
comes from the radio industry and refers to the list of songs that a disc jockey
plays on a particular radio program.” See page 49. Likeadiscjockey’slist
referencing a plurality of songs by title (rather than a stack of records readied for
play), a“playlist” in the mediafile sharing art generally identifies the mediaitems

to be played (in a sequence).

73. Similarly, the TerraTec Manual indicates that “[t]he playlist is a pre-
selected sequence of titles you wish the m3po to play,” p. 10 (emphasis added),
and “playlists consist of pre-programmed titles which are played back by the

m3po,” p. 44 (emphasis added). Further, the TerraTec Manual providesthat “[i]n
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DJ mode, you can pre-select titles, which will then be played in the sequence you
selected them, basically, it isamini-playlist (up to 10 titles) .. ..” P. 20 (emphasis

added).

74. The'952 Patent uses the term “playlist” consistently according to this
well-known meaning to one of ordinary skill inthe art. Like the exemplary
references above, the ‘952 Patent makes clear that playlists identify the songs (e.g.,
by title), but do not necessarily include the audio files themselves or the locations

of the mediaitems referenced thereby.

75.  Though the passage of the ‘952 Patent cited by the Board indicates
that “playlist 1528 . . . isalist of audio files and associated URL’s of where the
audio fileswere retrieved from,” a person of ordinary skill in the art would
understand that the description of playlist (1528) as including URLs does not
require that URL s be included in every playlist described by the ‘952 Patent.
Aside from the statement that playlist (1528) “isalist of audio files and associated
URL’s of where the audio files were retrieved from,” the * 952 Patent specifically

references playlists (1528) and (1534) as follows:

e “playlist 1528, and associated URL’s and songs within the playlist”

(21:45-46 and 49-50);

40
BHM Ex. 2007



IPR2013-00593 (U.S. Patent 8,045,952)

e “Each client PC 1508 has a storage space 1524 for client IPAN
software 1532, a playlist 1534, and associated URL's and songs within

the playlist.” (21:50-52);

e “Multiple playlists can be stored on the storage space 1512. In
addition to the playlist 1528, the actual audio fileslisted in the playlist

are also stored in the storage space 1512.” (21:66-22:2);

e “ThePC client 1508 has a storage space 1524 for a playlist 1534 and

associated URL's and songsin the playlist.” (22:9-10).

76. The ‘952 Patent’ s repeated statements that the “ playlists ([1528/1534],
and associated URL’S’ indicates that URL s are not generally considered to be
contained within, or sufficient to constitute, a*“playlist” within the meaning of the
‘052 Patent. That is, if theterm “playlist” could simply be alist of URLS, or
necessarily included associated URLS, | do not believe there would be any reason
to continually qualify that the playlists (1528)/(1534) could be appended to include

the URL s associated with the listed audio files in this embodiment.

77. Rather, what is common among the playlists described in the * 952
Patent and consistent with the common meaning of the term to one of ordinary
skill inthe art isthat all of the playlists of the ‘952 Patent contain a list referencing
the media itemsto be played (in a sequence). For example, in some aspects, “[t]he
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playlistsincludes titles of audio from avariety of sources,” while“[t]he
assignments provide information about the location of other web sites containing
the audio source.” ‘952 Patent, 4:29-32. See also ‘952 Patent, 22:48-50 (“Within
the playlist, the URL’ s indicate the location from which the audio files associated
with the song titlesin the playlist can be downloaded.”) (emphasis added). As
discussed below, | believe that 952 Patent makes clear that these distinct pieces of
information (e.g., the titles of the songs of a playlist on one hand, and information
about a source location of the songs on the other) are not necessarily received

simultaneously, and importantly, are not both sufficient to be considered a playlist.

78. Inevery method and system described in the * 952 Patent, three
distinct pieces of information are received or obtained by the electronic device in
order to the play the mediaitems indicated by a playlist assigned thereto: i) a
playlist identifying a plurality of mediaitems; ii) information enabling the

electronic device to obtain the mediaitems; and iii) the media items themselves.

79. Claim 9 tracks this central feature of the ‘952 Patent, and on its face,
indicates that three separate pieces of information are received or obtained on the
electronic device: i) “receiving . . . the playlist identifying a plurality of songs. . .
U3 0i) “receiving . . . information enabling the el ectronic device to obtain the ones

of the plurality of songs from at least one remote source. . . .”; and, iii) “obtaining
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the ones of the plurality of the songs from the at least one source.” That is, the
method of claim 9 requires that the electronic device receive a playlist identifying a
plurality of songs (i.e., receive information to identify the songs), receive
information enabling the electronic device to obtain at least one of the plurality of

songs (i.e., receive information for obtaining a song), and obtain the song itself.

80. The*952 Patent specification specifically distinguishes between the
information for identifying songs (e.g., titles) from the information showing the
location of the song (i.e., information to obtain the song):

“A second software module is configured to use the modem to connect to an
Internet service provider to receive assignments of playlists from the second
software module. The playlists include titles of audio from a variety of
audio sources. The assignments provide information about the location of
other web sites containing the audio sources. The software module is
configured to connect through the | SP to the web sites to download the audio

files.”
‘952 Patent, 4:26-34 (emphasis added).

81. Further, in every embodiment that specifically shows examples of the
contents of a playlist, the title of the song is aways identified in the ‘952 Patent as
being included in the playlist. See Figures 17D, 17E, 17H, 18D, 18E, 18F of the

‘052 Patent. On the other hand, there are no embodiments described in the 952

Patent in which a URL is used to identify the songsin a playlist.
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82. The*'952 Patent specification also provides concrete examplesin
which the playlist and the information enabling the electronic device to obtain the
song are received independently. For example, as provided below, the ‘952 Patent
specifically contemplates an embodiment in which the playlist is assigned to a
second device, and only thereafter, is alocation or source from which a song

identified in the playlist obtained:

“Another aspect of the present invention is a method for assigning playlists
of music from one electronic device to another. First, a network connection
Is used for transmitting and receiving digital data over a communication
network to an Internet service provider. Next, the process provides a first
software module to manage playlists of songs. The software module allows
a user to compose playlists from a variety of audio sources. The software
module allows a user to assign a playlist from a first device to a second
device. Next, the process checks the second device's data storage space for
songs listed on the assigned playlist. Next, the process accesses a server
site to obtain locations of the web sites the first device downloaded its
audio files from. The process then provides a second software module to
connect to various web sites to download remaining songs needed for the
playlist. The second software module connects if songs needed to form the
playlist are not stored on the second device's data storage space. Finally, the
process uploads files to the server from the first device and downloads files
the second device if the second software module is unable to download afile

from said web site.”
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‘952 Patent, 4:50-5:3. See also Figure 19B and 28:11-43.

83. Assuch, claim 9 of the ‘952 Patent and the various embodiments
described within the * 952 Patent specification consistently describe the information
identifying a song (e.g., song titles) as part of a“playlist,” whereas information for
obtaining the song (e.g., “the location of other websites containing the audio

sources’) is distinct from a playlist and can be obtained independently therefrom.

84. Whilethe specification of the ‘952 Patent is clear that information to
identify the songs (e.g., titles) is distinct from information to obtain the songs (e.g.,
the location or URL of the song), | believe the language of claim 9 to be agnostic
as to whether the information to obtain a song is received with the playlist (e.g.,
whether the playlist is appended to include the URLs or whether the URLs are
obtained separately). Assuch, aperson of ordinary skill in the art at the time of the
‘952 Patent would understand that while a playlist can include information
enabling an electronic device to obtain the songs, information enabling the
electronic device to obtain a song aloneis not a playlist within the meaning of the

‘952 Patent.

7.2. Recelving a Playlist “Assigned to the Electronic Device”

85. | believe that the broadest reasonable construction of a playlist

“assigned to the electronic device,” when interpreted in light of the * 952 Patent
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from the vantage point of a person of ordinary skill inthe art, isaplaylist (as

defined above) that is “directed to the electronic device.”

86. | understand that the Institution Decision regards the construction of
“assigned to the electronic device’ to mean that the playlist is“directed to a

particular device selected by a user.”

87. | believe a construction of the term “assigned to” such that it requires
user selection of a particular playlist to be played by a particular deviceis
inaccurate, and does not reflect several concrete embodiments of assignments
described in the * 952 Patent in which a playlist can be directed to a device without

user selection of a particular playlist to be played by a particular device.

88. | do not believe that the construction of “assigned to” should exclude
an embodiment of the *952 Patent in which, when a new device is added to the
IPAN, the device can be configured such that the device can have “new files and
updates automatically downloaded to the device when it is connected to the IPAN
1100.” ‘952 Patent, 25:53-58 (emphasis added). In thisinstance, aplaylist could
be automatically assigned to the electronic device whenever they are created, for
example, and could be received (e.g., downloaded) by the electronic device
connecting to the IPAN Server (e.g., by logging in from the receiving electronic

device). That is, the ‘952 Patent indicates that, in some embodiments, a playlist
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can be assigned without requiring the user selection of a particular playlist for

assignment to a particular device.

89. | asodo not believe that the construction of “assigned to” should
exclude the contemplated embodiment of the 952 Patent in which playlists can be

assigned to various devices by those devices connecting to the IPAN Server:

The user can synchronize with the server site IPAN 1433 by clicking the
synchronize button 1718. Playlists are stored on the server site IPAN 1433
in addition to the PC IPAN client 1508 or device 1510. In other words, a
playlist may have been updated at the server site IPAN 1433 by adding or
deleting some songs in the playlist. The user can choose to have the same
playlist with two different songs at the server site 1104 and on the device
1200 or 1300. But, if the user made the playlist at the server site IPAN
1433, the user presses the synchronize button 1718 so that the next time the
device 1200 or 1300 connects, an updated playlist will be downloaded.

‘952 Patent, 24:17-28.

In thisinstance, playlists at the IPAN server can be assigned to any electronic
device that can connect to the network, and could be received (e.g., downloaded)
simply by an electronic device connecting to the IPAN Server (e.g., by logging in
from the receiving electronic device). Thus, | believe the * 952 Patent specifically
contemplates that a playlist can be assigned without requiring user selection of a

particular device to which the playlist is directed.
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7.3. “Receiving” aPlaylist Assigned to the Electronic Device

90. Clam 9 of the ‘952 Patent requires that the assigned playlist is
“received” at the electronic device. | note that in construing playlist “assigned to
the electronic device,” the Board indicates that “[t]he specification describes an
embodiment that does not have storage space for aplaylist. Ex. 1001, 4:4-9. In
this embodiment the playlist is stored on the IPAN manager or aPC.” Institution

Decision, p. 13.

91. | believethispassage of the Institution Decision conflates the
assignment of a playlist with the receipt of the playlist. In every embodiment of
the ‘952 Patent, an assigned playlist (i.e., aplaylist directed to one or more
electronic devices as opposed to being transferred to a single device) is received by
the electronic device. Indeed, | believe the Board misconstrues the passage at
column 4, lines 4-9 of the ‘952 Patent in stating that “[t]he specification described
an embodiment that does not have storage space for aplaylist.” Rather, this
passage indicates that in some embodiments, the audio files themselves can be
stored remotely (e.g., for streaming), as discussed below. That is, | believe the
proper reading of the indicated passage of the ‘952 Patent is of “alow-cost system

that can play songs [that are identified by a playlist and that are] stored on the
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IPAN manager or on the PC’s storage space without having to store the audio files

locally.”

8. OPINIONSASTO BERMAN

8.1. Summary of Berman

92. U.S. Patent No. 6,502,194 of Berman et a. (“Berman”), entitled
“System for Playback of Network Audio Material on Demand,” discloses a
“system for playback of network audio material on demand by using a playback
apparatus that provides an interface to network audio files that areretrieved in real
timein response to user selection.” Berman, 3:33-36. An audio playback unit
resembling a home audio component “retrieves audio data from a remote server
and plays them back in real time, using a home audio system, in response to user
selection.” Berman, Abstract. The remote server(s) also control “[a]ccess to audio

material and distribution rights.” Id.

93. Asshown in Figure 1 of Berman, the system includes one or more
audio material servers (104) that aggregate digital audio material and a directory
and user list (“DUL”) server (107) that provides the “[a] ccess to the audio material
and authority for distribution rights.” Berman, 4:47-64. The DUL server, which
acts as a ‘ gatekeeper,” maintains a catalog of al available songs contained on the

audio material server(s) to which auser hasrightsin alist known asa*“Song List.”
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See Berman, 7:4-13. The system of Berman also includes a playback unit (100)
that retrieves selected songs from the audio material server (104) for playback. See
Berman, Figure 4 (“The playback unit is now ready to retrieve audio material from
the network. The flow diagram for these operations continuesin FIG. 4,” Berman,
7:35-38). The playback unit (100) maintains its own copy of the Song List. See
Berman, 9:67-10:2 (“ The next two bytes comprise a song list version field that
provides the version number of the song list currently stored in the memory of the

playback unit.”).

94. Because the audio material on the audio material server (104) that a
user can access may change over time, Berman discloses that the DUL server (107)
synchronizes its Song List with the Song List on the playback unit (100) when the
playback unit (100) is powered on, as shown in Figure 3 (reproduced below). See
Berman, 6:55-57, “Aninitial step, as represented by the flow diagram box

numbered 301, occurs when electrical power is applied to the playback unit.”).
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95.  Upon powering on, the user selects a music category or type of song
desired for playback (by Artist, Title, etc. ) at step 302. The playback unit (100)
then sends the version number of its Song List to the DUL server in step 304. As
illustrated in Figure 6, Berman discloses that the “song list version” is sent asatwo
byte number (see Berman, 9:67-10:2 (“The next two bytes comprise a song list
version field that provides the version number of the song list currently stored in

the memory of the playback unit”)):
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MSB
——
. USER ID
(UID)
LSB
REQUEST TYPE
A
Mse SONG LIST
VERSION
LSB
MSB
CHECKSUM
LSB
FIG. 6

96. Oncethe DUL server (107) has verified that the playback unit (100)
has the latest version of the Song List (steps 306 and 308), the user can then select
which song they wish to play (step 310). See Berman, 7:21-30. Because the
playback unit (100) does not have the URLSs of the songs in the song list, it then
requests the URL of the selected song from the DUL server in step 312. See
Berman, 7:30-33 and Figure 7. In response, the DUL server (107) sends the URL
of the selected song back to the playback unit (100) in step 314. See Berman,
7:33-37. Figure 9 of Berman, which is reproduced below, “illustrates the data
packet when the DUL server sends the URL of a song to the playback unit.”

Berman, 9:49-51. See also Berman, 10:52-6:5. The DUL server receives a request
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for asingle song (or a portion thereof) and responds with asingle URL for that

selected song.

USER ID
{UID}

| PACKET TYPE

| ERROR CODE
B

MS T

LS8

MSE
FIG. 9 } SONG

LsSB

DATA

Ms8 } CHECKSUM
LSB

97. Figure 4 of Berman goes on to describe how the playback unit (100)
obtains the actual song from the audio material server (104) using the URL it
received in step 314. Asshown in step 402 of Figure 4 (reproduced below),
“[o]nce the song URL is received, the playback unit initiates communication with
the appropriate audio material server to request the song from the appropriate
directory.” Berman, 7: 41-45. The playback unit (100) additionally sends user ID
and password information to the DUL server (107) in step 404 and the DUL server

(107) confirms with the audio material server (104) that the user is authorized to
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receive the requested audio material in steps 406, 408, and 410. See Berman, 7:59-
6:3. “If the permission granted flag indicates that the user has been granted
permission to download the requested song, an affirmative outcome at decision
box 410, then at the flow diagram numbered 412 the audio material server
transmits the audio material (comprising a sound file or streaming audio

information) to the playback unit . ...” Berman, 8:27-34.

98. Figure5 of Berman depicts the processing steps performed by the
playback unit (100) during operation. Berman, 8:46-50. Berman discloses that a
song is played on the playback unit (100) only when the user initiates a“New

Track” event for each song that a user wishes to play:

“The detection of a user action at the user interface and display is
represented by the first FIG. 5 flow diagram box numbered 502, which
indicates that the processor detects a ‘New Track’ event. A ‘New Track’
event is defined to be a user action such as selection of the Play button,
Skip Track button, or other button such as ‘Jump Track’ or ‘Change
Disk’ or the like. Upon receipt of a‘New Track’ event, the microprocessor
determines the system operating mode, which may comprise either a normal
mode, random mode, or custom mode. This step is represented by the flow

diagram box numbered 504.

The system operating modes specify an algorithm for determining the next
track. The normal mode specifies that the ‘next’ track is the next sequential
track in the selected compilation. The random mode specifies that the ‘ next’
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track is a randomly selected track in the selected compilation. The custom
mode specifies that the ‘next’ track is a user programmed track, such as
when a user records a program of track selections for playback in the

programmed order.

Once the ‘next’ track is determined in accordance with the operating mode,
the microprocessor determines if the next track is in the memory buffer of
the playback unit. If the next track is not in the buffer, a negative outcome
at the decision box 506, then the microprocessor requests the missing track
from the appropriate audio material server. The request is represented by the
flow diagram box numbered 508.”

Berman, 8:63-9:15 (emphasis added).

99. Asshownin Figure 5, once the track begins streaming, the processor
then returnsto step 501 to perform any “housekeeping chores” and then step 502 to
determineif a“New Track” event has been detected, regardless of the operating

mode for determining the next track as disclosed by Berman.

8.2. Berman doesnot anticipate claim 9
100. Claim 9 of the ‘952 Patent recites “receiving, at an electronic device, a
playlist assigned to the electronic device, the playlist identifying a plurality of

songs.”

101. The Petitioner has asserted that Berman discloses “receiving a

playlist,” asfollows:
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A playback unit 100 is an electronic device and is connected via a network
102 to an audio material server 104 and a directory and user list (DUL)
server 107. See, e.g., FIG. 1; 4:47-65.

The playback unit 100 receives a song list from the DUL server 107. See,
eg., FIG. 3, step 308 (“DUL SENDS UPDATED SONG LIST TO
PLAYBACK UNIT.”). The DUL server assigns the list to the playback unit
by use of the user ID. See, e.g., FIG. 8; 10:23-30 (“confirm that the updated
song list information was sent to and recelved by the correct playback

unit.”).
‘952 Petition, p. 17.

102. | do not agree with the Petitioner’ s application of Berman to claim 9
of the ‘952 Patent. Berman's Song List isnot aplaylist. It issimply acatalog of
al available songs to which the user hasrights. A catalog of all available songsis

not aplaylist.

8.2.1. TheSongList Received from the DUL isNot Arranged
to be Played in a Sequence

103. A person of ordinary skill in the art would not consider the Song List
of Berman to be a playlist within the meaning of the ‘952 Patent because the songs
indicated by the Song List are not arranged to be played in a sequence. Rather,
the Song List of Berman is merely a catalog of all available songs contained on the

audio material server(s) to which auser hasrights. Assuch, the Petitioner’s
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identification of step 308 in Figure 3 (“DUL SENDS UPDATED SONG LIST TO
PLAYBACK UNIT") simply updates the catal og on the playback unit (100) in
order to match the catalog version number on the DUL server (107). That is, the
Song List merely identifies those songs for which the user has authorization for

playback.

104. Infact, thereisno disclosure in Berman that the Song List isalist of
songs to be played by the playback device (100), sequentially or otherwise.
Rather, only after the Song List is updated in step 308, can the user select one or
more songs in step 310. Because Berman does not disclose that the songs
identified in the Song List are provided for playback in a sequence one after
another, without having to select each individual song for playback, the Song List
would not be considered by a person having ordinary skill inthe art to be a

“playlist” within the meaning of the ‘952 Patent.

8.2.2. Neither theDUL Server Nor the Audio Material Server
Maintain Playlist Information

105. To the extent that the Song List of Berman is stored on the DUL
server (107), the Song List merely represents a catalog of all available songs
contained on the audio material server(s) to which auser has rights, without any
discussion of playback of the songsindicated thereby. This Song List istherefore

not a playlist, as discussed above.
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106. Moreover, Berman does not disclose that the DUL server (107) or the
audio material server (104) store or maintain any other list of selected songs for
playback. Rather, the only information disclosed by Berman that resembles a
sequenced list occurs when a user selects multiple songs at the playback unit (100)
in step 310. Here, Berman discloses that the user can choose one or more songs by
Artigt, Title, Album, Genre, etc. Thisselection in step 310, however, is disclosed
as being only known to the playback unit (100). That is, thereisno indication in
Berman that the DUL server (107) or the audio material server (104) receives alist
of songs from the playback unit (100) such that the list, as opposed to the audio
material indicated thereby, can be transmitted back to and received by the playback

unit (100).

107. Indeed, even if the user were to select multiple songs for playback on
the playback unit (100), Berman indicates that the playback unit only requests
URLsfrom the DUL server (104) or audio material server (107) one at atime.
Likewise, any song or URL is disclosed as being received from the remote servers
one at atime (and played one at atime). Itisnot aplaylist identifying a plurality

of songs within the meaning of the ‘952 Patent.

108. With referenceto Figures 5, 9, and 10, Berman explicitly describes

how each song is sent from the remote servers (104/107) to the playback unit
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(100), and how each song is played individually (rather than sequentially) on the
playback unit (100), regardless of the operating mode for determining the next
track. For example, Berman discloses that the next song can be played on the
playback unit (100) only when the user initiates a “ New Track” event for each
song they wish to play (e.g., through the selection of the Play button, Skip Track
button, or other buttons such as “Jump Track” or “Change Disk”). See Berman,
8:66-9:2. That is, asillustrated in the flow diagram of Figure 5, after a selected
song begins streaming on the playback unit (100), the playback unit’s processor
returns to step 501 to perform any “housekeeping chores’ and then to step 502 to
determine if another “New Track” event has been detected. Only if auser initiates

a“New Track” event will a new song be played.

109. Moreover, each of the URLs and the songs themselves are sent from
the remote servers (104/107) to the playback unit (100) one at atime:
e Berman 9:49-51 — “FIG. 9 illustrates the data packet when the DUL
server sends the URL of a song to the playback unit.”
e Berman 10:52-53 — “FIG. 9 shows the packet containing the URL of a
requested song.”
e Berman 9:51-53 — “FIG. 10 illustrates the data packet when an audio

material server sends a song to the playback unit.”
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e Berman 11: 6-7 — “FIG. 10 shows the song data sent by an audio material

server to the playback unit.”

110. Therefore, the only listing of audio material that is played by the
playback unit (100) of Berman is selected on the playback unit (100), and any
listing of such audio material remains on the playback unit (100). Moreover,
Berman discloses that any communication regarding the songs indicated by that
listing is communicated to the servers (104/107) one song at atime. In parallel, the
DUL server (107) responds with the single URL for that one song (Figure 9), and
the audio material server (104) correspondingly provides a single song (Figure 10),

until a“New Track” event occurs.

111. At no time does the playback unit (100) ever receive aplaylist or any
list of selected songs for playback from the servers (104/107). Indeed, because the
servers (104/107) have no knowledge of the list of songs selected on the playback
unit (100), an assignment of such alist is also not made to the playback unit (100)

from the servers (104/107).

0. OPINIONSASTO WOLFF
9.1. Summary of Wolff

112. U.S. Patent No. 7,472,353 of Wolff et a. (“Wolff”), entitled “Remote

Console for Network Application Servers,” discloses amethod and system for
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organizing and retrieving multimedia objects such as “Moving Picture Expert
Group (MPEG) video's, MPEG audio Layer-3 (MP3), music compact discs (CD),
etc.” Wolff, Abstract and 3:21-25. Asshown in Figure 1 of Wolff, aremote
controller (130), which can be a Personal Digital Assistant (PDA), allows the user
to select amedia object to be played by a network access appliance (NAA) that is
coupled to a network from which the NAA can retrieve the media objects. Wolff,
3:20-32. In one embodiment, the NAA can have alocal cache that stores the
media objects (e.g., media objects that the user has identified as the user’s
favorites). See Wolff, 3:34-39 (“This allows the NAA to quickly respond to the

user’ s request when the user selects afavorite media object.”).

113. Asdescribed with reference to Figure 6 of Wolff, the remote
controller allows the user to organize thumbnail images representing the media
objectsinto a“play list containing the user’s favorite songs.” Wolff, 8:16-18. The
remote controller also stores a*“resource identifier” (e.g., a uniform resource
locator (URL) that provides the network location of the media object)
corresponding to each of the thumbnail images. See Wolff, 3:53-56, 4:12-17, and
8:3-4 (“The resource identifier corresponds to the selected thumbnail image.”).
That is, the remote controller of Wolff uses thumbnail images to identify the

plurality of media objectsindicated by the play list and associates each thumbnail
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with aresource identifier to provide information regarding the location of the

media object represented by that thumbnail.

114. When the user wishes for a media object to be played by the NAA, a
desired thumbnail image is selected and a play button is pressed on the remote
controller.” Wolff, 7:67-8:1. “[T]he remote controller 200 sends a signal

containing the resource identifier out to the NAA.” Wolff, 8:1-3 (emphasis

added). That is, rather than sending a playlist to the NAA, the remote controller
simply sends the “resource identifier” (e.g., URL) “to request the NAA 120, 125,
128 to play the media object associated with the resource identifier. The NAA
120, 125, 128 then retrieves the media object from the network (e.g., Internet) or
fromaNAA local cache.” Wolff, 3:52-58. “In one embodiment, the remote
controller 130 sends multiple URLs in one request and the NAA 120, 125, 128

plays each in order.” Wolff, 3:61-63.

115. Figure 3 of Wolff isaflow diagram further illustrating the steps that
occur when athumbnail image is selected on the controller to request that a media
object be played by the NAA. See Wolff, 5:34-35. “When the user activates a
play function, such as, for example, pressing a play button on a remote controller,

the remote controller sends one or more resour ce identifiers corresponding to the

media object(s) to the specified NAA . ...” Wolff, 5:36-39. At block 135, the
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NAA “receives the resource identifier(s) and usesit as an identifier to locate the

requested media object.” Wolff, 5:43-44 (emphasis added). “For each resource
identifier, the NAA first determinesto seeif the resource identifier for the
requested media object may have already been stored in the cache within the NAA,
as shown in block 140. When the requested media object is found in the cache, the
NAA proceeds by sending an acknowledgement to the remote controller, as shown
in block 155. Alternatively, when the requested media object is not found in the
cache, the NAA attempts to locate the requested media object, using the resource
identifier, in anetwork server (e.g., network server 105 of FIG. 1), asshownin
block 145.” Wolff, 5:43-52 (emphasis added). “The media object corresponding
to the resource identifier is then played by the NAA, as shown in block 160.”

Wolff, 6:6-8.

116. Wolff discloses that the remote controller and the personalized server
can be synchronized to maintain the information stored on the remote controller.
Wolff, 4:37-40. “When the remote controller 130 is synchronized with the
personalized server 110, all the thumbnail images and the corresponding resource
identifiers are loaded onto the remote controller 130. . . In one embodiment, the
NAA 120, 125, 128 periodically accesses the personalized server 110 and update
[sic] thelocal cachein the NAA with the appropriate media objects based on the

resource identifiers stored in the personalized server 110.” Wolff, 4:54-62
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(emphasis added). Likewise, “[w]hen the remote controller is synchronized with

the personalized server 110, the play list is updated in the personalized server 110

and the indicated media objects may eventually be accessed and cached by the

appropriate NAA. . . This capability allows the user to easily find and select
individual media objects or entire play lists on the remote controller and request an
NAA to play them. When the NAA has cached the media objects (by examining
stored play lists) the user will not have to wait for any downloads from the network

server.” Wolff, 8:23-32.

9.2. Petitioner’s Arguments Regarding Wolff
117. Claim 9 of the ‘952 Patent recites “receiving, at an electronic device, a
playlist assigned to the electronic device, the playlist identifying a plurality of

songs.”
118. | understand that the Petition partially characterizes Wolff as follows:

The remote controller may be used to create “play lists,” as described at 8:7-
34. When the remote controller is synchronized with the personalized
server, the playlist is updated in the server. Periodically, the media objects
indicated by the playlist can be accessed and cached by the appropriate
network access appliance. This is done “by examining stored play lists.”

Therefore, the NAA will receive the playlist from the personalized server,

examine it and obtain media objects not already stored in its cache.

‘052 Petition, p. 31 (emphasis added).
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119. On pages 31-32, the ‘952 Petition asserts that the NAA of Wolff

“receivesaplaylist . ..” asfollows (emphasis added):

Wolff discloses a system including a PDA 130 that may be used to create
playlists. The playlists may be uploaded to a personalized server 110. See,
eg., FIG. 1, 4:37-64, 7.62-8:34. A network access appliance (NAA) is an
electronic device such as a stereo that can play songs, and includes cache
memory for storing media objects identified by resource identifiers such as
URLs. See, eg., 3:18-60, 4:29-36. The NAA accesses the personalized
server and receives playlists. See, e.g., 8:31-33 (“ When the NAA has cached
the media objects (by examining stored play lists)...”). The playlists are

assigned to each NAA to permit the NAA to receive the lists.

9.3. TheNAA doesnot receivethe examined “play list” of Wolff as
alleged by the Petition

120. | do not agree with the * 952 Petition’ s characterization that Wolff
disclosesa“play list” that is “received” on the NAA. Specifically, the portions of

the * 952 Petition underlined above mischaracterize Wolff’ s disclosure.

121. The*'952 Petition fails to point to any teaching in Wolff that the
“NAA will receive the playlist from the personalized server” or that the “NAA
accesses the personalized server and receives playlists.” Rather, the passages cited
by the ‘952 Petition merely indicate that the NAA examines play lists that are

stored on the personalized server (110) for the purpose of caching media objects.
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122. First, Wolff indicates that the “stored” play lists that are examined are
stored on the personalized server (110). Wolff provides that “[w]hen the remote
controller 130 is synchronized with the personalized server 110, all the thumbnail
images and the corresponding resource identifiers are loaded onto the remote
controller 130. .. [T]he NAA 120, 125, 128 periodically accesses the personalized
server 110 and update [sic] the local cache in the NAA with the appropriate media

objects based on the resource identifiers stored in the personalized server 110.”

Wolff, 4:54-62 (emphasis added). Similarly, in the passage cited by the ‘952

Petition, Wolff provides that “the play list is updated in the personalized server

110. . .” when the remote controller (130) and the personalized server (110) are
synchronized. Wolff, 8:23-26 (emphasis added). As such, when Wolff indicates
that “the NAA has cached the media objects (by examining stored play lists),” a
person having ordinary skill in the art would understand that the “ stored” play lists
that are examined are those that are stored in the personalized server (110), and not

the NAA itself.

123. Second, thereis no indication in Wolff that its play list that is stored
in the personalized server (110) istransferred to or received by the NAA, for the
purpose of examination or otherwise. Contrary to the ‘952 Petition’ s assertions,
the process of “examining” a stored play list to allow indicated media objects to

“eventually be accessed and cached by the appropriate NAA” does not involve or
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require receipt of the stored play list itself. In fact, Wolff provides that the NAA
“periodically accesses the personalized server 110 and update [sic] the local cache

in the NAA with the appropriate media objects based on the resource identifiers

stored in the personalized server 110.” Thus, the “examining stored play lists’
passage cited by the ‘952 Petition merely indicates that the URL s are used to cache

the media objects—not that a playlist is received.

124. Accordingly, the cited passages of Wolff regarding “examining” a
stored “play list” do not even suggest much less require that the “play list” stored
on the personalized server (110) be received on the NAA, for playback or
otherwise. Neither the Petition nor the ‘952 Bove Report provide any explanation
for the assertion that examining a play list on the personalized server (110) must

entail the NAA (130) receiving aplay list.

9.4. Wolff does not disclose “receiving a playlist” within the meaning
of the *952 Patent

125. The NAA of Woalff, alleged by the * 952 Petition and the Board to
represent the electronic device recited by clam 9 of the ‘952 Patent, does not

receive “alist referencing mediaitems arranged to be played in a sequence.”

126. Asdiscussed above, claim 9 of the 952 Patent requires that three
distinct pieces of information are received or obtained by the electronic devicein

order to play the mediaitems indicated by aplaylist assigned thereto: i) aplaylist
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identifying a plurality of mediaitems; ii) information enabling the electronic
device to obtain the mediaitems; and iii) the mediaitems themselves. The ‘952
Patent also makes clear that while a playlist can be appended, for example, with
locations of the mediaitems (e.g., URLS) to enable the device to obtain the songs,

alist of URLs does not, in and of itself, constitute a playlist.

127. Though Wolff discloses that the “play list” generated on the controller
(130) includes thumbnail images that represent the media object and are associated
with resource identifiers, Wolff does not disclose that the thumbnail images used to
identify the media objects are sent from the controller (130) to the NAA. Rather,
Wolff only discloses sending the URLs from the controller (130) to the NAA to

enable the NAA to locate and retrieve the song.

128. For example, Wolff provides that when the user wishes for amedia
object to be played by the NAA, adesired thumbnail image is selected and a play
button is pressed on the remote controller such that “the remote controller 200

sends a signal containing the resource identifier out to the NAA.” Wolff, 7:67-8:1

(emphasis added). With regard to multiple media objects, “the remote controller

130 sends multiple URLs in onerequest. . . .” Wolff, 3:61-63. “[T]he NAA

receives the resource identifier(s)” (5:36-42), “locate[s] the requested media object,
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using the resource identifier, in a network server (e.g., network server 105 of FIG.

1)” (5:50-52), and then plays the media object (6:6-8).

129. That is, the remote controller ssimply sends the “resource identifier”
(e.g., URL) “to request the NAA 120, 125, 128 to play the media object associated
with the resource identifier. The NAA 120, 125, 128 then retrieves the media
object from the network (e.g., Internet) or from a NAA local cache.” Wolff, 3:52-

58.

130. Though claim 16 of Wolff indicates that “the controller sends one
play list to the appliance to request the one play list be played by the appliance,” it
Is apparent that, based on the totality of the teachings of Wolff, this language was
used as short hand to refer to the media objects ultimately played by the appliance.
For example, one skilled in the art would appreciate that the songs indicated by the
play list are received and played, but aplay list itself (i.e., alist referencing media

items arranged to be played in a sequence) is not received by the NAA.

131. Thereisnoindication in Wolff that a“play list” as defined by Wolff
isever received by the NAA from the controller (130). Based on the totality of the
teachings of Wolff, the only reasonable conclusion is that which is received by the
NAA is one or more URLsor audio files. Throughout the specification, Wolff is

consistent in describing that the only items that are actually received by the NAA
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from the controller are URL s (see 5:36-42) or the media objects themselves (see
3:63-65), rather than any list identifying songs to be played in a sequence. For

example, Wolff provides that “[w]hen the user activates a play function, such as,
for example, pressing a play button on a remote controller, the remote controller

sends one or moreresource identifiers. ... At block 135, the NAA receives the

resource identifier(s) . ..”). 5:36-42. Seealso Abstract (“A controller may select

an identifier associated with a media object to send arequest to play the media

object. The controller may send the request by transmitting the identifier stored in

the controller. An appliance receives the request from the controller.”).

132. A person of ordinary skill in the art at the time of the 952 Patent
would therefore understand that the NAA does not receive a playlist within the
meaning of claim 9 of the ‘952 Patent.

95. MultipleURLsarenot a playlist

133. Though Wolff discloses in one embodiment that the remote controller
(130) “sends multiple URLs in one request and the NAA . . . plays each in order,”
Wolff 3:61-67, the multiple URLs sent to the NAA does not “identify a plurality of
songs,” as required by the claims. Rather, the URL merely provides location
information. As discussed above, supra 7.1.3, aperson of ordinary skill in the art
would understand that a list solely consisting of URLsisnot aplaylist. Indeed, as

indicated supra in §[70, one of ordinary skill in the art would appreciate that a
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playlist need not include URLs and alist of URLsisnot aplaylist. Assuch, the
multiple URLSs sent from the remote controller to the NAA in Wolff would not be
understood by a person of ordinary skill in the art to represent receiving a playlist

assigned to the NAA.

*k*

All of the statements made in this declaration of my own knowledge are true
and all statements made on information and belied are believed to be true. These
statements were made with knowledge that willful false statements and the like so

made are punishable by fine or imprisonment, or both, under section 1001 of Title

|64~

lvan Zatkovich

18 of the United States Code.

Dated; June 13,2014 Signature:
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EXHIBIT1

CURRICULUM VITAE AND TESTIMONIAL HISTORY

Ivan Zatkovich

301 W. Platt Sreet, #365 & Tampa, FL 33606 & (813) 601-8142 & ivanzat@ecompconsultants.com

Ivan Zatkovich has over 28 years experience in computer science, computer networks,
digital circuit design, and software engineering. Mr. Zatkovich isthe principal consultant
with eComp Consultants, a technology consulting firm specializing in intellectua
property consulting for telecommunications, computer related technology, eCommerce
and Network Communication protocol. Mr. Zatkovich has over 10 years experience
providing expert testimony for patent litigation and software contract disputes in
Telecommunications and computer technology, providing expert reports, depositions, and
trial testimony.

Mr. Zatkovich has designed and developed Network Communications systems,

Telecommunication applications, and high speed computer peripherals and streaming

media, as well as, Geolocation, Graphical Information Systems (GIS), Geographic CAD

and mapping systems. He has aso participated in 1ISO and ANSI standard committees

for disk and video devices. Ivan has testified on cases involving, Remote control of Video signal controllers,
channel switching for Video on Demand, and Media Streaming network technology.

Director / Project 13 years Managed 6 to 35 member teams. Software development, systems
M anager Integration, critical path management, PMP/CMM methodologies.

I nternet, 12 years Commercia and high volume content websites, streaming media, web
ecommer ce, marketing and personalization, search engine optimization, Storefront,
Streaming media fulfillment systems, B2B/B2C portals, ERP/supply chain. (Warner

Brothers, Caldwell Banker, AAA Travel, Pro Marine)

Telecommunications | 11 years Computer Telephony Integration (CTI) since 1984. Call Center, IVR,
ACD, VolP, and Unified Messaging (Verizon, Bell Canada, PTT
Netherlands, and Mercury Communications).

Communications & | 7years Developed early Ethernet signal collision detection, High speed parallel

Signal processing and serial communication drivers, analog to digital signal processing for
peripheral and device control. (Digital Equipment Corporation,
Tanning Technology).

Expert Witness 11 years Expert testimony and damage assessment for ecommerce litigation,

internet & software copyright, telecommunications. Over 24 cases
providing expert reports, depositions, & trial testimony.

Education:

B. S. Computer Science 1980 University of Pittsburgh
Minor in E.E. digital circuit design

Master’s study and thesisin Computer Networks 1981 University of Pittsburgh

Results published in Byte Magazine
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Sample Cases:

GeoTag, Incv. Frontier Communications Corp. et al.

Jurisdiction:
Client:

Nature of Case:
Nature of Engagement:

U.S. District Court, Eastern District of Texas

Macy’s, Genesco, AGCO Corp., The Rockport Company, LLC., Hennes &
Mauritz LP (H&M), Gander Mountain Company, Godiva Chocolatier, DSW,
National Interlock Systems

Patent Litigation

Testifying Expert regarding e-Commerce, Geo location, store locator
based technology. Provided Non Infringement Reports for multiple
defendants.

ABC v. ENC, CISCO, et.al.

Jurisdiction:

Client:

Nature of Case:

Nature of Engagement:

Represented by:

U.S. District Court, Southern District of Texas

ABC

Patent Litigation

Remote control & communication for Video Streaming, Video & TV signal
controllers. Provide Infringement reports and invalidity rebuttal reports
and deposition.

Dunlap Codding and Smyser Kaplan & Veselka

Zamora Radio LLC v. Last.fm, Pandora, CBS Radio, et.al.

Jurisdiction:

Client:

Nature of Case:

Nature of Engagement:

Represented by:

U.S. District Court, SOUTHERN DISTRICT OF FLORIDA

Zamora Radio

Patent Litigation

Testifying expert on streaming players and on-demand media control vs.
broadcast (forward only) media control.

Ward & Olivo

VTran Mediav. Cox Communication, et.al.

Jurisdiction:

Client:

Nature of Case:

Nature of Engagement:

U.S. District Court, Eastern District of Pennsylvania

VTran

Patent Litigation

Expertise in Video on Demand, DVR, Cable box interfaces, Channel
determination, signal control. Provide report on patent non-Infringement
and Invalidity.

eBay (Skype) v. IDT Communications

Client:
Nature of case:
Nature of engagement:

Representing:

IDT as defendant in complaint and plaintiff in counterclaim

Voice Over IP, Patent Litigation

Testifying expert for Network address resolution, data routing, and VoIP
session initiation.

Holland & Hart followed by Girardi|Keese

TGIPv. AT&T, IDT, et.al.

Jurisdiction:

Client:

Nature of Case:

Nature of Engagement:

Represented by:

U.S. District Court, Eastern Texas

IDT Corporation

Patent Litigation

Expertise in Cell phone provisioning and activation, Wireless transaction
communication. Provided report on non-Infringement and Invalidity.
Deposition.

Finnegan, Henderson, Farabow, Garrett & Dunner, L.L.P.
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Professional Experience:

2013 - Present

2000 - Present

2007- 2008

2002 — 2007

Fund Leader New York, NY

Vaud Advisors - Social Media Technology Fund
Direct research and assessment of social media companies for venture capital investment.

Principal Consultant
eComp Consultants Tampa, FL

Provide consulting on design and devel opment of software product development, and ecommerce
technology. Provide technology consulting and expert support for telecommunications, internet,
and ecommerce applications in the areas of

e Patent portfolio evaluation, market valuation, identification of potential prior
art, and licensing opportunities.

e Independent consulting for Alcatel-Lucent (AT&T Bell Labs) to review,
recommend, and rate Alcatel’ s extensive Patent portfolio specificaly in the area
of telecommunications and web-based ecommerce.

e Patent litigation consulting for telecommunications and internet technology
patents.

e Software contract and due diligence consulting for disputes involving custom
software projects.

e Internet publishing and copyright consulting for web content management and
licensing.
e Commercial websites, search engine, and web marketing strategies.

Sample clients include: Alcatel-Lucent, LogicLink, NWI Corp, Jones Day, Finnegan
Henderson, Fish & Richardson, Cozen O’ Connors, Morrison Foerster

Global Web Markets Manager
Smith & Nephew Inc. Clearwater, FL

Smith & Nephew is a global manufacturer of medical, wound, orthopedic, and surgical supplies.
Smith & Nephew has facilities in 33 countries and maintains 35 websites for different product
areas and country marketing.

e Design the S& N Corporate web architecture for al intranet, extranet, and Internet
Sites.
o Direct a staff of web professionalsin developing and managing 35 individual S&N

web sites maintained in the US and 14 countries for both S& N clients and interna
users.

¢ Manage and maintain the 650 domains currently owned by Smith & Nephew
o Optimize search engine ranking and website meta tagging.

o Develop corporate technology and IT standards and policiesincluding:
Create Web hosting agreements and I T service contracts (SLAS)

Define Web development standards

Research page ranking, redirection, and domain optimization strategies.

eBusiness Director
Eva-Tonelnc Clearwater, FL

EvaTone is a $45M commercial multimedia company specializing in ecommerce and marketing
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1999 to 2002

1996 —1999

solutions, media and content customization, order processing and fulfillment, print & web
publishing, CD & DVD manufacturing.

e Set dtrategic direction of client service offerings in ecommerce and Content
Management.
e Designed and Implement High Volume web publishing system.
e  Projects proposed and delivered include:
0 McGraw-Hill — Enterprise Content Management and automated Web publishing

system.
0 ProMarine USA — B2B storefront, complex part search, order processing and
fulfillment.

0 Resource Rabbit — Sales collateral manager. This system retrieves user
preferences and client profile information to generate customized electronic
presentations and brochures.

0 AAA Travel — CRM sdles collateral system, instant customized brochures,
print-on-demand.

eBusiness Engagement M anager
Tanning Technology and | MRGlobal

Tanning Technology is an international systems integrator speciaizing in network infrastructure
and channel integration for financial markets and the insurance industry. Proposed and managed
eBusiness and Internet infrastructure projects focused on client and user personalization, data
mining, and web marketing practices.

Client web engagements proposed and managed:

e Eckerd Pharmacy — Developed eBusiness and web marketing for personalized client web
content.

e GEICO — Developed a personalized policyholder web service that uses clients' account
history and demographics to customize product literature for cross-sell & up-sdll
opportunities.

e Hartford Insurance — Integrated 3 tier online claims processing & subrogation with
legacy systems

e Citicorp Bank — Designed mortgage and loan payment system; managed sale of loan
contracts

e Smith Barney — Developed remote access network infrastructure & wireless PDA
financial system

e Medwerks — Created medical insurance clearinghouse, MDs centrally process insurance
payments

Director of Network & Customer Support
Utility Partners, Inc. Tampa, FL

Utility Partners developed and customized utility company software for scheduling service
appointments, assigning and routing mobile workforce (field technicians), and dispatching and
coordinating resources during power outages.

e Managed client engagement leads for development of client customizations and
standardization of product features.

e  Setup client support department to manage UP's growing client and product
base. This department:

0 Provided Network and IT management for over 800 customer users

0 Created a24x7 Helpdesk for Utility dispatch centersand I T departments

0 Developed system and network monitors for real-time client system monitoring
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1987-1996

1980 —1987

0 Received trouble calls & provided live client support for the following
applications:
=  MobileUP —Mobile Workforce Dispatcher
= TroubleUP — Power outage manager
=  Smartnom — Web Gas Auction System for private gas
auctions
= CAS- Customer Appointment and Call Center application

Project Manager: Telecom Software
GTE Data Services (currently Verizon) Tampa, FL

GTE was an $8B Telecommunications company and formed the Commercial Services division to
customize their telephone business software to sell to other telephone companies internationally.

Managed large product implementations for Telecom billing, service order, and Switch
management.
Developed Service manager, an early videotext hypermedia application for online
ordering of Telecom equipment and services.
Specific projects managed:
0 Mercury Communication — setup Service Bureau to hill their new
intelligent network services.
0 PTT Netherlands — managed $5M inter-carrier billing project for PTT
Netherlands
0 Beéll Canada— developed Pricing Plan & Table Management system
0 Deutsche Telekom — designed and developed a German billing
prototype system.
0 Received GTE personal best award.

Softwar e Engineer / Technical Lead
Digital Equipment Corp. Maynard, MA

As Technical Lead, led the development of manufacturing automation and control software.
Projects Included:

e Supply Chain, CAD/CAM — Designed system to retrieve parts information from
circuit board CAD design. Developed a parts ordering system based on
expected volumes.

e Pick & place automation — Automatically program IC insertion machines.
Develop system to determine IC insertion order, generate machine instructions,
and download program to machine.

As Software Engineer for embedded controllers and video subsystems, designed and
developed PDP-11 operating system and device drivers.

Enhanced high-speed DecNet drivers for Synch, Asynch, and Parallel communications.
Designed/developed disk firmware and drivers for floppy & Winchester disks.
Developed Hypermedia and Windows Manager for PRO-350 microcomputer.

Developed and enhanced video controller firmware and layered graphics system for
PRO-350.

Developed Computer Telephony Integration (CTI) product for telephone answering
machines.

Technical Tools& Environments:

e Unix, Windows, NT, Microsoft .NET, C#, C/C++, VB, Assembler
e Java, Javascript, JSP, IBM Websphere, Microsoft Commerce engine, Blue Martini
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e SQL, Oracle, Foxpro, DB2, Crystal Reports, Active-Reports, MQ Series, Tuxedo, Documentum, Interwoven
Certifications & Publications:

e Industry Speaker: Internet Publishing standards (Momentum conference)

e  Department of Justice: Proposal for internet forensics technology

e |BM Websphere — Certified ecommerce Solutions Expert

e Byte Magazine — Published Network Design articles

e  Sync Magazine — Published Programming Techniques and Tutorials

e |EEE SigGraph — Presented |CGS Computer Graphic Standards for |EEE SigGraph conference.
e CMM & PMP — Project management methodologies

e |SO and ANSI — On International 1SO and National ANSI Committees for Disk and Media format
standards

Testimonial History:

Within the past five years, | have testified and/or provided expert services in the following matters (the underlined
party identifies which party | was retained by):

* Bid For Position v. AOL, Goagle, Microsoft, MIV' A, et.al. 2:07-cv-582 JBF/TEM (E.D. VA 2010)
(settled 2008)

Expert for Defendant MIVA on Patent Invalidity for Internet Search Engine technology. Provided
expert invalidity report regarding the auctioning of keywords in paid searches.

* Imboff Associates v America’s Criminal Defense (S.D. CA) (settled 2009)

Expert for Defendant ACD for accused Internet Search Engine mis-direction (fraud). Provided
expert consulting and identified the unintentional actions of the defendant which caused the search
mis-direction.

* Zamora v. CBS Radio et.al. 09-20940-CIV-MORENO (S.D. FL 2010) (settled 2010)

Last.fm, Ltd., CBS Radio, Inc., CBS Corp., Slacker, Inc., Pandora Media, Inc., Rhapsody America 1.1.C,
Realnetworkes, Inc., DKCM, Inc., AOL, I.L.C, Accuradio, I.LC, Yahoo! Inc. and Soundpedia, Inc.

Expert for Plaintiff on Patent Infringement for Internet Radio Technology. Provided expert report
and deposition regarding the use of streaming media and Web Radio players.

* Nuance v. Tellme (a Microsoft subsidiary) C.A. No. 06-105-slr (S.D. Del 2009) (settled 2010)
Expert for Defendant on Speech Recognition software. Provided expert report and deposition on
non-infringement and invalidity for speech recognition used in automated phone directories.

* TGIP, Inc. v. ATST Corp, IDT., 512 F. Supp. 2d 727 (E.D. Tex. 2007) (settled 2007).

Expert for Defendant on non-infringement. Patent and prior art dispute concerning call processing
center and service provisioning in which I analyzed telephone network, call processing center, and
call routing patents; developed detailed non-infringement chart; and rebutted plaintiff’s expert.

* Swapalease, Inc. v. Sublease Excchange.com, Inc., 1:07 CV 00045-SSB (S.D. Ohio 2007) (Pending)
Expert for Plaintiff on infringement. Patent and prior art dispute concerning commercial auto lease
web site. Expert infringement report, testified at Markman Hearing.

* Ronald A. Katz v. DHL Express, 2:2007 CV 02192 (N.D. Cal.)
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Patent infringement dispute concerning call processing center and call routing patents. Developed
non-infringement reports and deposed.

* Ronald A. Katz v. Cox Commmunications, 2:2007 CV 02299 (N.D. Cal.)

Patent infringement dispute concerning call processing center and call routing patents. Developed
non-infringement reports and deposed.

* Ronald A. Katzg v. Barthlink, 2:2007 CV 02325 (N.D. Cal.). Patent infringement dispute concerning
call processing center and call routing patents. Developed non-infringement reports and deposed.

* Ronald A. Katz v. Fifth Third Bank, 2:2007 CV 04960 (N.D. Cal.)
Patent infringement dispute concerning call processing center and call routing patents. Developed
non-infringement reports and deposed.

* Ronald A. Katz v. Huntington National Bank, 2:2007 CV 04960 (N.D. Cal.)
Patent infringement dispute concerning call processing center and call routing patents. Developed
non-infringement reports and deposed.

* Ronald A. Katz v. Echostar, 2:2007 CV 06222 (N.D. Cal.) (pending)
Patent infringement dispute concerning call processing center and call routing patents. Developed
non-infringement reports and deposed.

* ABC v. ENC, CISCO, WebEx communications, et.al., H-06-1032 (S.D. TX.)
Patent infringement dispute concerning computer remote control, remote command processing, and
remote communication. Developed non-infringement and invalidity rebuttal reports and deposed.

* Logiclink v. Keylink, CV07-1056-DOCMLGx) (C.D. Cal.)
Patent infringement dispute concerning eCommerce for Kiosks for Hotel Business centers.
Developed infringement report and invalidity rebuttal report. Trial Testimony.

* ¢eBay v. IDT corp, IDT 4:08-cv-4015-HFB (W.D. Ark) (settled 2010)
Patent infringement. Perform analysis of Voice Over IP providers and prior art candidates; provide
non-infringement (suit) and infringement (counter suit) expert reports.

* 12 Technologies, Inc. v. Oracle Corporation, 6:09-CV-194-LED (E.D. Tex)
Patent infringement, Testifying expert for Supply Chain Management software, Manufacturing
Automation, and Sales projection system software. Provide infringement and Invalidity rebuttal.

* LslandIP Inc. v. Dentsche Bank Corporation, 1:09-cv-04673-VM (8.D. NY)
Patent infringement, Testifying expert for Financial Transaction, Omnibus account consolidation and
settlement for Banks and Broker Dealers. Provide infringement and Invalidity rebuttal reports.

* 3M Future Africa (PTY) LTD p. The Standard Bank of South Africa LTD, MTN Group Limited and MTIN
Mobile Money SA (PTY) LTD, Case #: Patent 2002/2337 (South African High Court)

Patent infringement, testifying expert for Online Payments Security. Provide infringement, validity
and trial support.

* Coben v. US, 07-154-C (U.S. District Court of Federal Claims )

Copyright infringement testifying expert for Cohen. US Government FEMA distributed copy
righted documents without Cohen's knowledge or approval. Provide expert report, damages and
deposition.
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* SFEA v. 1-800-Flowers, et.al, 6:2009-cv-00340-LED (E.D. Tex)

* SEA v. Barnes & Noble, et.al, 6:2011-cv-00399-LED (E.D. Tex)

1-800-Flowers.com, Inc., The Plow & Hearth, Inc., including D/ B/ A Wind & Weather, Inc.
The Popeorn Factory, Inc., Winetasting Network, Inc., The Children's Group, Ine.,

Problem Solvers, Inc., Barnes & Noble, Inc., Barnesandnoble.com 1.1.C, Blockbuster, Inc.,
BUILD-A-BEAR WORKSHOP, INC., CDW Corporation

GameStop, Corp., GameStop, Inc., GameStop.com, Inc., Gander Mountain Company,
Overton's, Inc., | & R Electronics, Inc., Newegg, Inc., Newegg.com, Inc.

Northern Tool & Equipment Company, Inc., Northern Tool and Equipment Catalog Co.
Office Depot, Inc., Omaba Steaks International, Inc., OmabaSteaks.com, Inc.

The Timberland Company, Tupperware Brands Corporation, Tupperware.com, Inc.

Patent infringement, for Computerized Sales Force Automation System. Testifying expert for joint
invalidity (9 defendants) and non-infringement (5 defendants).

* Bloom v. Intuative, 06 CV 6301 (S.D. NY)
Software contract dispute, testifying expert concerning Document Management and Publishing for
Pharmaceuticals and Regulatory agencies. Comparison of product features and software reuse.

* Dallal v. New York Times, 1:2003-cv-10065 (S.D. NY) (settled 2008)
Testifying Expert, Deposition, for Web Copyright. Provided expertise in standard media publishing
practices, content licensing, and web content customization.

o LATimes v. Software AG, 2:2007-cv-01289-SVW-JW] (C.D. Cal.) (settled 2008)
Testifying Expert in Network & Database Software licensing dispute. Prepared expert report and
deposition on software licensing practices.

* Bear Creek Technologies v. 1 erigon Services Corp., 1:11-cv-00880-TSE -JFA (E.D. Virginia)(pending)
Testifying Expert, provided infringement and invalidity of VoIP related patents.

* Cequint v. Apple, 1:2011-cv-01224 (Wilmington) (pending)

Testifying Expert. Performed code review of Cequint’s City ID Software product to determine if
and how they are practicing the key limitations of the patents-in-suit focused on Caller ID, CND
Messages, City, State lookups, WAP interfaces, Database synchronicity (automatic update of
database), Display of incoming caller information and Call Answer and set-up code..

o Teltron Corporation v. Stanley Security Solutions dJ b/ a Stanley Healtheare Solutions, 6:2011-cv-01448 (M.D. Florida)
Testifying Expert regarding network systems for displaying data relating to emergency call systems.

* Microsoft v 5R Processors, LTD. and Thomas Drafke, 3:12-cv-00263-slc, (W.D. Wisconsin)
Testifying Expert. Evaluate the Microsoft Windows Professional XP OEM Licensing Agreement
and Microsoft Refurbished PC Licensing Guidelines and opine on 5R adherence.

» Walker Digital, 1.1.C v. Fandango, Inc., et al.,1:11-cv-00313-SLR (Delaware)

Facebook Inc., Fandango, Inc., Expedia, Inc., Amazon.com, Inc., American Airlines, Inc., eBay Inc., and
Zappos.com, Inc.

Testifying Expert regarding e-commerce, shopping carts, e-marketing, and the promotion of
financial products such as credit and debit cards for retail, business-to-business (“B2B”), and
financial industries. Provided Infringement (Amazon, Expedia, Zappos) Reports and Invalidity
Rebuttal Report.

* Trialeard v. P.S.KW. & Associates, 3:11-cv-05693-FLW-T]B (New]ersey)
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Testifying Expert for patent re-exam concerning eCommerce technology based on a method of
dispensing, tracking, and managing pharmaceutical products by communicatively linking prescribers
and pharmacies to a central computing system

* Catalina Marketing Corporation v. Coupons, Inc., JAMS Reference No. 11000654507 (San Francisco)
Testifying Expert to analyze the following Coupons systems, Microsite System & Brandcaster™
System and determine if either system is an “Infringing Capable System”. Provided Expert Report
and Mediation Trial support.

* AKH Co., Inc. v. The Reinalt-Thomas Corp. & Southern California Discount Tire Co., Inc., SACV10-1626 CJC
Testifying Expert regarding trademark infringement & cybersquatting. Provided Expert Report and
deposition.

* Soverain v. Euromarket Design, et al. 6:12-cv-00145-LED (E.D. Texas) (pending)
Testifying Expert regarding e-commerce systems/online shopping catts technology.

* -l YNXX Corporation v. InnerW orkings, Inc., et al. 1:10-CV-2535 (M.D. PA)

InnerWorkings, Standard Register, Cirgit.com and R.R. Donnelley & Sons Co.

Testifying Expert regarding supply chain, custom print jobs, matching job requirements to vendors
technology. Provided Infringement, Invalidity and Non Infringement Rebuttal Reports and deposition.

* Joao Bock Transaction Services v. US Ameribank, et al,. 8:11-cv-00887-MSS-TGW (Tampa)
US Ameribank, Everbank and BankFirst
Testifying Expert regarding secure transactions on electronic financial accounts.

* Lodsys v. Brother Intl Group et al., 2:11-cv-90(JRG) (E.D. Texas)

Brother Intl Corp, Canon U.S A., Inc., Hewlett-Packard Company, Hulu, I.LC, Lenovo (United States) Inc.
Lexcmark International, Inc., Motorola Mobility, Inc., Novell, Inc., Samsung Electronics Co., LTD.,
Samsung Electronics America, Inc., Samsung Telecommunications America, LLC, Trend Micro Incorporated
Testifying Expert regarding interactive media enabling CRM technology. Provided Invalidity
Rebuttal Reports and deposition testimony.

* Progressive v. State Farm, et al. CBM2012-00003, CBM2013-00004

State Farm Insurance, Hartford Insurance, Liberty Mutual Insurance, Safeco Insurance, Obio Casnalty Insurance,
Open Seas Solutions, Octo Telematics

Testifying Expert regarding e-Commerce and vehicle telematics systems. Provided Patent Re-exam
Declarations.

* Black Hills Medja, LLC v. Samsung, et al. [ITC case] (pending)

Samsung, LG, Panasonic, Toshiba, Sharp

Testifying Expert regarding Google Latitude running on smartphones and smart phones running
software which can direct the streaming of content between, for example, a laptop and a TV or Blu-
ray player. Providing device analysis and code review, Infringement Reports and Rebuttal Reports.

* Rembrandt Social Media, 1P v. Facebook, Inc. and ADDTHIS, Inc., 1:13cv158 (TSE/'TR]) (Vitginia)
Testifying Expert regarding social media user content and 3™ party interaction -the diary page and
"Like" feature. Provided Non Infringement Report and deposition.

* GeoTag, Inc v. Frontier Communications Corp. et al. [Multiple cases] (pending)
Magy’s, Genesco, AGCO Corp., The Rockport Company, LLC., Hennes & Mauritz LP (H>M), Gander
Mountain Company, Godiva Chocolatier, DSW, National Interlock Systems
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Testifying Expert regarding e-Commerce, Geo location, store locator based technology. Provided
Non Infringement Reports for multiple defendants.

* Careerlairs.com v. United Business Media, I1C, et al., 11-20329-CIV-KING (S.D. Florida)
Testifying Expert regarding videoconferencing, virtual career fairs technology.

* Transanction LLC v. eBay Patent 7343339 3:2009cv03705 (N.D. CA)
Expert regarding computerized electronic auction payment systems.

o Ameranth v. Sixc Continents Hotels
Testifying Expert regarding Internet Advertising & Website Technology. Expert Report and deposition.

* Carolina Power & Light Company v. Aspect Software 5:08-cv-00449-BO (E.D. NC)
Testifying Expert in telecommunications technology.

* Dominion v. Aspect Software, 3:08-cv-00737-REP (Virginia)

Testifying Expert in telecommunications and IVR call processing. Provided expert declaration and testimony.

* ComplementSoft v. SAS Institute, 12-C-7372 (N.D. IL)
Expert regarding software development tools, database manipulation, SAS programming.

* Moriez v. Google, 10-cv-01240-RSL (Seattle)
Expert regarding use of deep search methodology. Claim Contruction suppott.

* Media Rights Technologies v. Capital One, et al., 1:13cv476-AJT/TR] (Vitginia)
Expert regarding secure internet Banking System technology USPatent# 7316033.
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CE Declaration of conformity

This product is in conformity with prevailing EU guidelines. A valuation of conformity has been carried
out, as stipulated in EU guidelines.

Company: TerraTec Electronic GmbH - Herrenpfad 38 - D-41334 Nettetal - Germany
Product: MP3-CD-Player m3po

According to Low-Voltage Guideline 73/23/EU The following norm has been observed:

EN 60 065: 1993

According to Electromagnetic Sociability Guideline 89/336/EU, the following norms have been observed:
EN 55 013: 1990 - EN 55 020-1: 1995

(incorporating EN 55 013: 1991 + 1995)

The company holds the following documentation available on request:
e Manual

e Testing documents

e Other technical documentation

Nettetal, 26.04.2000

Y224

TerraTec® ProMedia, SoundSystem Gold, SoundSystem Maestro, SoundSystem Base1, AudioSystem
EWS®64, SoundSystem DMX, phono PreAMp, XLerate, Base2PCl, TerraTec 128iPCl, TerraTV+, m3po,
WaveSystem, MIDI Smart and MIDI Master Pro are trademarks of TerraTec® Electronic GmbH Nettetal.

Any soft and hardware referred to in this manual is generally also registered trademarks of their respec-
tive owners. They are governed by the usual laws.

O©TerraTec® Electronic GmbH, 1994-2000. All rights reserved (18.05.00).

All texts and diagrams were created with the greatest care. TerraTec Electronic GmbH and its authors can
not be held responsible for incorrect information and its consequences. Technical information in this
document may be subject to change without prior notice.

All texts in this documentation are protected by copyright laws. All rights are reserved. No part of this
document may be reproduced as photocopies, microfilm or any other procedure or as computer language
/ document without the author’s permission. The rights of reproduction in presentation and media are
also reserved.
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BOX CONTENTS.

First, you might want to check the contents of your box. In doing so, you should come across
the following items:

e The Player,

e aremote control unit with batteries,

e apower chord,

e acinch-chord,

e one MP3 demo CD,

e screws for installing the optional hard disk,
e this manual,

e amenu overview

e and finally, a registration card.

m3po 5
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SETUP, MAINTENANCE AND SAFETY DIRECTIONS.

e The player needs to be placed on a level and dry surface to avoid fire, damage, or electrical
shocks.

e Keep it away from radiators and hi-fi equipment. This will avoid excessive heat building up.
In particular, do not place any devices with no feet and nothing containing liquids like bot-
tles or plant pots on your m3po.

e When connecting to an AC outlet, ensure that the correct voltage is supplied to the m3po.

e If you don’t use the m3po for a longer period of time, you disconnect it. To avoid short cir-
cuits, never pull on the cable, pull on the plug instead. You should also disconnect the
m3po during thunderstorms.

o If you open the case to install a hard disk, you must disconnect it first! In addition, please
follow the instructions in this manual to the letter.

e If the player is exposed to strong temperature fluctuations, leave it for about one hour
without connecting it, as condensation could have built up inside the case, which could
compromise its functionality.

Important: the m3po incorporates a class 1 laser product which oper-
ates with invisible, potentially hazardous laser beams.

e C(lean the m3po-Player with a dry or slightly damp, non-fuzzy cloth. Chemical cleaning
products may damage the surface and should not be used.

Tip! After installing the hard disk, check the case for any small ani-
mals or rodents (Mice, moths, etc.).

6 m3po
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The battery.

Inside the case, we have installed the following battery type:

Description: CR2032
Type: Lithium
Primary: Yes
Quantity: 1
Weight: 3g

Install new batteries only after consulting our technicians and make sure you insert it correctly
('+' facing upwards).

Never subject the battery to fire or high temperature. It could leak or even explode. When dis-
posing of the battery, please do so in an appropriate manner.

The power supply.

The power supply runs on 40W with a voltage of 110 to 230 Volt at 50 to 60 Hertz. The unit is
fused internally at 250 V/3,15A. Do not attempt to change the fuse yourself, instead consult
our technicians).

Summary: Simply apply ‘common sense' when using the m3po. Deliberate damage is not cov-
ered by our warranty. Thank you.

m3po 7
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WELCOME.

Great that you have chosen TerraTec's new m3po. This player belongs to a new era of Hi-fi
components. You have probably used a CD Player before and most of the basic functions will
be familiar to you. TerraTec's m3po, however, takes this concept one step further and incorpo-
rates the possibilities of modern Computer and Internet possibilities into a desirable and typi-
cal piece of Hi-fi kit.

In this manual, we would like to introduce you to this device as informatively and entertain-
ingly as possible. Again, most of the basic functions will already be familiar to you. The in-
depth concept of the m3po and its true capabilities, however, will be described by us in this
manual. In addition, you will hear about some of the Internet’s possibilities, as well as tips and
tricks of how to archive your music in the MP3 format.

We hope you enjoy this manual

... Your TerraTec Team!

Quick guide to the manual.

In order to make this manual as efficient as possible, we have highlighted certain contents in
different ways.

A short summary of several paragraphs or explicitly important pas-
sages will be framed.

e Display messages on the m3po-Player, are printedin a different font.

e Filenames, which appear in the display of your m3po-Player are printed in a differ-
ent font.

e Internet Links are printedin a different font.

;-)" indicates a joke. Haha.

8 m3po
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UNPACK AND GO! THE QUICK-START TOUR.

Here we have a quick-guide for experienced users, who have used a
CD Player in the past. As the SELECT Wheel has a multitude of func-
tions, we presume a certain standard setting for this tour (page 28).

Having unpacked and connected your m3po, the player is ready to go. Power and cinch-chords
are to be connected in the usual way. If you want to continue to use your existing CD Player,
you may use any input but the phone socket to connect the m3po.

Switch on the m3po-Player and take a look at the display. The machine takes a few seconds to
search for internal drives (more on this later).

The message "No CD in drive" will appear. Press EJECT and insert a CD (for the purpose of this
tour, please use the supplied demo CD) in the usual way with the label facing upwards. Close
the drawer by pressing EJECT for the second time. At this point it should be mentioned, that if
your m3po has already a hard disk installed, it will display the main path of the internal HD.
However, this should not stop you from pressing EJECT for the second time.

The machine will display "Scanni ng for fil es" and the m3po starts searching for MP3
files. Turn the SELECT Wheel clockwise until you find "Wl comre nBpo".

Press SELECT, that’s all. The m3po now plays the chosen title.

m3po 9
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What’s next?

While m3po does its duty, we’ll take a look at what else we can find on the CD. Press SELECT
and keep turning — you will find three different symbols in the display window:

e Note - The note indicates a MP3 title. Press SELECT and you can start playing that title at
once (or, in "DJ Mode", pre-select that title. More on this later).

e Table - the small table (horizontal lines) represents the playlist. The playlist is a pre-
selected sequence of titles you wish the m3po to play. More on this on page 44.

e Arrow - the arrow pointing downwards indicates a file (or directory) in which you can find
titles, playlists or more files.

Chose the file "www. cal | asong. de" and then another file (you won’t find any titles or play-
lists here), which you think might be interesting. You do this exactly the same way as before:
simply chose and select.

Now you will see a number of titles in the display (unless, of course you have accidentally cho-
sen the "Intro" file ... there you will find only one title). Play any one of the songs by pressing
SELECT. "Welcome m3po" will stop and the new song commences. Pretty quick, no?

Bottom right of the display will show NXT. This abbreviation stands for "next" and indicates
the next title. Now press the display button (soft button, bottom left to the wheel). The next
title will now be played. This button always carries out, whatever function is displayed on the
bottom right-hand corner.

Stopping playback requires your pushing one button: the STOP button. Surprised? Hope not.

Finally, we climb the ladder back up to the top level of the CD. To do so, press UP twice. If
everything has worked, then you will be presented with the same data as when you first in-
serted the CD.

Now you can explore the m3po on your own, The general functions should be clear by now.
More detailed information, however, is what this manual is all about. And it starts overleaf.

Enjoy.
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SETUP AND CONNECTION.

This chapter is dedicated to the m3po-Players necessary preparations
prior to operating it.

e Carefully remove the m3po-Player from its packaging and place it on a dry and level sur-
face — ideally on a hi-fi rack.

e Connect the supplied cinch-cable to the AUDIO OUT socket of the m3po-Player and the
other end to a vacant input on your hi-fi amplifier. You can use the CD, TAPE or AUX socket.
The PHONO socket is a definite nono, as this operates on a different input sensitivity. You
also need to consider the color coding of the plugs: Red goes to the right input, white (or
black) to the left.

If necessary, consult your amplifiers manual on alternative connecting options.

What else can | connect the m3po to?

Your m3po can also be connected to a pair of active speakers (with integrated pre-amps). Even
the connection to the line in of a compatible computer soundcard is a possibility, but not really
ingenious (the m3po has not been designed with this application in mind).

Remember: The m3po-Player cannot be digitally connected to other devices.
e Plug the power chord into a power outlet.

e Insert the supplied batteries into the remote control unit.

m3po 11
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You will also find a headphone socket. This is located under the POWER button on the front
panel. The volume can be adjusted in the m3po menu "Volume (Phones). (page 30).

Your m3po is now ready. Following is a description of the various functions and how to access
them. You could follow the tour at the beginning of this manual (page 9) if you have not done
this already and if you are already familiar with the basic functions of the player.

The m3po can be integrated into a 19" rack module, the optional
“rackit!". You can order it over the Internet.

12 m3po
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WHAT IS THE M3PO AND WHAT CAN IT DO?

Your new m3po-Player is very similar to a standard CD player. However, there are a number of
differences, as the m3po is fundamentally more versatile and more powerful. Don’t worry, this
does not make it any more complicated.

The m3po is capable of playing standard (Audio) CDs. The operation is akin to a CD player:
Insert CD, chose title, press PLAY. In addition to this, it can read and play MP3 data. These can
be located on a CD-ROM, or an optional hard disk. The m3po cannot record.

Why MP3?

MP3 is currently the most common format for music on the Internet. Its main advantage is the
small size of its audio files, as described in the following example: If you record a standard
audio CD on your home PC, then this will use about 650 Megabyte (MB) of hard disk space.
Converting this into MP3 files, you are presented with only 1/11 of its original size, roughly
60MB. If the files contain nothing but speech (i.e. language courses), the size of the file can be
reduced to 1/25 of its original size, without losing too much of its sound quality. This is quite
useful, as you can see:
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CD-Audio MP3 128kBit/s MP3 56kBit/s

You will find more information on MP3 in the chapter "Useful informa-
tion on MP3" on page 46.

You can burn your MP3 files onto CD-R in your computer and it is exactly this feature which
distinguishes the m3po from other MP3 players: The CD is much more efficient and cheaper
than conventional MP3 players, which use flash ROM chips to store data.
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Housekeeping.

Back to your player: Your new m3po plays audio and data Ds. As the CD-R stores eleven times
more music than conventional audio CDs, you will need to find a way to keep everything in
order and not get lost in this audio jungle. If you own a PC, then you will know the file struc-
ture on your hard disk: Programs are located in files, documents, like letters etc in other
places. So it makes sense to apply the same approach to filing your MP3-files (classical, Hard-
core Gabba or Zappa).

=-{_ Frank Zappa

{:l Freak Out!

=1 Sheik Yerbouti

{:l Ship Arriving Too Late To Save & Drowning Witch
{:l Them Or Us

{:I Y'ou Can't Do That On Stage Anymore Vol 4
{:I Y'ou Can't Do That On Stage Anymore Vol 5
{:I “ou Can't Do That On Stage Anymore Vol B
=-{_] Hirzpiele

("] Bibi Blocksberg

{:l Herr der Ringe

{:l Mada Brahma - Die wWel izt Klang

{:I The three investigators

=1 House

{:l armand van Helden

{:l Blank and Jones

{:l Faithlesz

{:I groovePark

{:I Malin and K.ane

=0 Klassik

ﬁ Herr Rossi sucht das Gllick
{:l Glenn Gould
{:l Johann Sebastian Bach
& John wiliams
{:l Ludwig wan Bethowven
{:l kichael Myman
=" Fock

{:l Kuschelrock

{:l Gueen

{:l Raling Stones

{:l Slayer

Files which are located on a CD-ROM, will be displayed as such: a small arrow in the display
indicates these files. And here we have the main difference between the m3po and a CD
player: You ' move' through the directory and chose the titles by name and not by number -
for this you only need to use the wheel and the ' UP' (back)button.
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Anything else?

Yes, the m3po can do even more. It can search for titles, it allows you to compile your own
playlists, display information about any title (data rates or ID tags), pre-select titles while a
different one is playing and vary the playback speed without — like a record player* — changing
the pitch. All these functions can be accessed via the display and controlled with the buttons
on the front panel or the remote control unit.

Following is a description of all the buttons, and functions "hidden behind the display". You
could follow the tour at the beginning of this manual (page 9) if you have not done this al-
ready.

* For the ones too young to remember: A record is a spinning disc made from black vinyl,
which by the end of the 2oth century were only used by "' DJs' ... ;-)

If you would like to find out more about this cultural heritage, have a look at the following
website:

http://fabdp. f h-pot sdam de/ | ehre/ st udpro/ st ef fen/record/ head/ head. ht m

Please note, that this site has been constructed independently of us and were are not respon-
sible for its contents. Thank you.
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USING THE M3PO.

The m3po-Player can be operated easily and intuitively via its front panel or its remote control
unit. Apart from the display, the most important element is the SELECT wheel, which doubles
up as a button. The UP button takes you to a higher level within the operating menu, MENU
calls up the menu and its various settings and STOP will not be explained at all. You might take
offence ;-). The same applies to the EJECT and POWER buttons.

THE LC DisPLAY.

The Display on the m3po is like a communication port to the player. Here you find all the in-
formation to operate the unit, as well as information on the chosen titles (ID Tags). The display
shows file names and folders, which are located on the CD (you can find more information on
folders in "What is the m3po and what can it do?" on page 13).

While navigating around the CD or hard disk or while a title is being played, The display will
indicate the current playback mode. The "Play mode" and "Repeat & Shuffle" mode can be
combined freely. The abbreviations stand for the following:

1. Letter ... for play mode 2. Letter... for Shuffle&Repeat
A_ All titles _N Normal

F_ All titles in one folder R Repeat

0_ Only 1 title playing _S Shuffle

P_ Playing playlist

I_ Introscan

D_ DJ*

For example: "AN" stands for playback of all titles in sequence. "PS" stands for playback of
the playlist in shuffle mode, or random play.

* The "D) Mode" is always the normal mode. Repeat and shuffle are of course pointless in this
mode.
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You will find three different symbols in the display window:

e Note - The note indicates an MP3 title. Press SELECT and you can start playing that title at
once (or, in "DJ Mode", pre-select that title. More in this later).

e Table - the small table (horizontal lines) represents the playlist. The playlist to program a
sequence of titles you want the m3po to play. More on this on page 44.

e Arrow - the arrow pointing downwards indicates a file (or index) in which you can find ti-
tles, playlists or more files.

Finally, the display window opens up the functions of the menu, which can be called up by
pressing MENU. All menu functions are described in detail on page 19.
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THE SELECT WHEEL / ENTER BUTTON.

The SELECT wheel is the main navigation tool of the m3po. Dialing clockwise takes your
deeper into the menu, counterclockwise takes you back up. Pressing the wheel, will carry out
that function, enters a submenu, changes folders or plays a pre-selected title. In the latter case
the display changes its mode and now shows the ID Tags, if available. To carry on navigating,
you will need to press the wheel again.

THE UP BUTTON.

Once you have navigated into a folder (for example Bach in the cl assi cal folder), you can
move up by one level by pressing the UP button. For example: Press once to return to cl as-
si cal , twice to go back to the start. If you press the UP button again, you will go back to
choosing CD or hard disk, provided there is one installed.

THE DISPLAY BUTTON (SOFT BUTTON).

Under the wheel to the left, you will find the display button, whose functions depend on the
settings on the m3po. Usually, the display will present you with whatever function the button
is currently offering. This could be choosing the next title (NXT), the escape function (ESC).

Abbreviation Function

ADD Add title to your playlist ("My Playlist").

BCK Back to "Edit Playlist".

DEL Delete pre-selected songs in the D mode.

Ent er Enter (or confirm entry, e.g. define a folder name).

Enter Password |Enter password to unlock "Party Lock".

ESC Escape (quit menu or operation of a function).

NXT Next (play next title).

oPT Other options for "Edit Playlist".

Sear ch Starting search or continuing search.

XXX% Displaying change of speed in % (operated using the wheel). The func-

tion of the soft buttons corresponds to NXT.

THE MENU BUTTON.

m3po offers a multitude of menu settings. You gain access to the menu by pressing the MENU
button. If you don’t carry out any functions at this point for a few seconds, the display switches
back to displaying the song title. All menu functions will be described in detail in the chapter
“The menu functions" on page 19.
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THE STOP BUTTON.

All right: Pressing STOP will stop the playback of the current title. The STOP button is just that
—a PAUSE function is only available via the remote control unit.

THE EJECT BUTTON.

Just like conventional CD players, this will open and close the CD tray. After a short time, the
drawer closes automatically in order not to catch any unnecessary dust or to double up as a
can holder. By the way, the unauthorized opening of the drawer can be prevented using the
Party Lock function (page 29).

Emergency Exit.

If the CD is damaged and the m3po "hangs", switch the player off. Hold down the EJECT button
and switch the player back on. The drawer opens and you can take out the CD.

Tip: This function is also available in "Party Lock" (page 29).

POWER.

Switches the machine off and on. Using the "AutoPlay" function in the More menu can start
playback immediately after switching on (or after a power cut). More information on page 28.
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THE MENU FUNCTIONS.

Pressing the MENU button will open all the menu functions. Following is detailed information
on the in-depth functions of the m3po.

Please remember, that some functions will only be displayed, if there is an optional hard disk
installed.

PLAY MODE.

In play mode, you determine, which titles are to be played. An Introscan is also possible. The
following options are available:

Al'l songs Plays all songs in sequence.

Al in folder Plays all songs in one folder.

One song only Plays only one song.

My Playlist Plays the playlist in sequence once.

I ntroscan Like "All Songs", but plays only the first few seconds of each song.
The introscan time can be determined in the MORE menu (page 28).

DJ Like "All Songs" but you can select one or more titles, which are to be
played at the end of the current song using the wheel. More informa-
tion on this is coming up.

Pressing . . back takes you back to the main menu.

D) Mode.

The D) Mode is, as you may have guessed, one of THE party tools of the m3po. In D) mode,
you can pre-select titles, which will then be played in the sequence you selected them, basi-
cally, it is a mini-playlist (up to 10 titles), i.e. in case you need to go and get some more drinks,
or are involved in a chit-chat you wish would never end.

The operation is quick and easy:

e Switch play mode to D) and the wheel to SELECT (important, as you need to choose the
titles).

e Choose a title using the wheel. If no song is playing at that time, this song (the (first song)
will be played immediately.

o Every other title you select, will be listed for playback and marked with a "+". Playback of
the selected song starts automatically after the current one.
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e The displays shows in the bottom line, how many songs are still outstanding. For every
added title, you will see a horizontal bar exactly between the two timing points. For more
than 5 titles, 3 dots will be shown.

e Spending some time at the bar, won’t be a problem now — don’t forget to engage the Party
Lock (see page 29). ;-)

The D) mode also allows you to skip to the next title when pressing the soft button NXT. Turn-
ing the wheel (i.e. to add another title to the list), reveals another function, DEL (delete),
where all following titles will be deleted and the current one will not be interrupted.

Tip: To go straight to the playback display, press MENU twice.

Mixing playback modes.

As you have seen in the chapter "Using the m3po", the play mode and the repeat&shuffle
mode can be combined freely. This makes it possible to repeat songs from only one folder, or
to play songs from one playlist in shuffle mode. To keep you up-to-date, which mode is cur-
rently in operation, the display will show a simple combination of letters, which will tell you
what is going on. You can read more on "The LC Display" on page 16.
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REPEAT & SHUFFLE.

In this menu, you determine how to play your songs:

Nor mal Plays the selected songs in sequence.
Repeat Repeats all selected songs.
Shuffle

Plays all selected songs in random sequence.

Mixing playback modes.

As you have seen in the chapter "Using the m3po", the play mode and the repeat&shuffle

mode can be combined freely. This makes it possible to repeat songs from only one folder, or
to play songs from one playlist in shuffle mode. To keep you up-to-date, which mode is cur-

rently in operation, the display will show a simple combination of letters, which will tell you
what is going on. You can read more on "The LC Display" on page 16.

WHEEL MODE.

The SELECT wheel cannot only be used for navigational purposes. While a song is playing, you

can operate the following functions just by using the wheel:

Ski p

Turn right: The next song starts playing.
Turn left: The previous song starts playing.
Press: Switches to select mode.

Note: When changing titles during playback, a short click or pop may be
audible. This is normal.

Sear ch

Turn right: Fast Forward.
Turn left: Rewind.
Press: Switches to select mode.

Note: MP3 files cannot be wound back further than the beginning.

Sel ect

Turn right: Display the next song title.
Turn left: Displays the previous song title.

Press: The selected title will be played.

Speed

Turn right: Increases playback speed in %.
Turn left: Decreases playback speed in %.
Press: Reset the playback speed to 100%.

Note: Switching to speed mode may cause a short click or pop. This is
normal.

Pressing

22

.. back

takes you back to the main menu.
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PLAYLISTS.

The m3po offers numerous options for compiling, saving and playing of playlists. Playlists are

pre-selected songs, which are played automatically by the m3po. The playlist mode allows you

to access all editing functions for playlists.

Call up "Playlist.. " in the menu and you will be presented with the following options:

Edit Playlist

Displays all titles in the current playlist. You can scroll using the
SELECT wheel. Pressing the wheel selects every entry. Whether no,
or several titles have been chosen, the soft button now offers ac-
cess to the options menu (OPT), which will be described later.

Start Playlist

Plays the playlist.

Clear Playlist

Deletes the currently selected playlist.

Save ny Pl ayli st

Saves the current playlist as M3U playlist to the hard disk. This
message will only appear, if there is a hard disk installed.

Add to nmy Playlist

Switches to the playback window and adds to the playlist.

Pl aylists on CD

Lists all playlists found on CD and HD.

Options menu (even if no tracks are present)

Add entry

Switches to the playback window and adds a title to the playlist by
pressing the soft button (ADD) to the current playlist. The wheel
functions exactly like in the select mode: turn to choose the song,
then press to play it.

Load Pl ayli st

Switches to select mode, but only displays playlists. Pressing the
wheel loads the contents of the current playlist into the Edit Play-
list Menu.

m3po
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Options Menu (no or one title marked)

Play entry Plays the chosen song and switches to playback mode. Pressing
the soft button (BCK) takes you back to the ' Edit Playlist' menu.

Add entry Switches to the playback window and adds a title to the playlist by
pressing the soft button (ADD) to the current playlist. The wheel
functions exactly like in the select mode: turn to choose the song,
then press to play it.

Del ete entry Deletes title from the playlist.

Move entry Turning the wheel, this moves a title up or down within the playlist.
Pressing the wheel slots the song into its new position.

New Pl ayli st Deletes all titles from the playlist without asking for your confirma-
tion.

Load Pl ayli st Switches to select mode, but only displays playlists. Pressing the
wheel loads the contents of the current playlist into the Edit Play-
list menu.

Save Playli st Allows naming your playlist and saves the edited playlist.

Options Menu (more than one title marked )

Unmark entries Unmarks entries.

Del ete entries Deletes all marked entries without asking for your confirmation.

Save entries as Allows input of file name or playlist and saves the marked titles as
a new playlist.

Pressing . . back will take you back to the main menu.

Note: Any unsaved playlists will be lost when switching off the m3po.
Please make sure you save your entries first.
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As mentioned before, you can save your own playlists to the hard disk, provided there is one
installed. Adding a filename and saving the pre-determined folder works like this:

e Turning the wheel changes the symbols, pressing it enters the symbol and switches to the
next symbol. If you have made a mistake, you can always delete the previous symbol by
pressing the STOP button.

e "UP" works like the SHIFT button on your computer keyboard. It lets you switch to capital
letters.

e When you are finished, you can enter the name by pressing the soft button (Ent er).

e Pressing the wheel saves the playlist (in the .M3U format, see page 44) to the folder,
which you have chosen in the Sel ect Destination menu function in the HDD
Functi ons -menu. If you have not chosen a specific folder, the playlist will be saved in
the main root of your hard disk. Pressing the soft button (ESC) cancels the operation.

You can find further information on playlists in the chapter "Playlists" on page 44.
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HD FUNCTIONS.

If you have installed a hard disk (HD) in your machine, then you also have access to all func-
tions for organizing your hard disk. More information on installing the hard disk is available on
page 34.

Make Directory Creates a new folder —in the current folder.

Rermove File/Dir Deletes the selected file (song or playlist) or the selected folder
from the hard disk.

Sel ect Destination |Here you choose the hard disk destination of your songs or play-
lists.

Free space on HDD |Indicates how much available disk space you have.

For mat HDD Formats the hard disk. Necessary immediately after

installing it.

Pressing. . back takes you back to the main menu.

Using Make Directory allows you to create new folders on the hard disk yourself in order
to copy songs into it.

e Turning the wheel changes the symbols, pressing it enters the symbol and switches to the
next symbol. If you have made a mistake, you can always delete the previous symbol by
pressing the STOP button.

e ' UP' works like the SHIFT button on your computer keyboard. It lets you switch to capital
letters.

e When you have finished, you can enter the name by pressing the soft button (Ent er).

e Entering symbols using exclusively the remote control is also possible. You can read all
about it on page 32.

The Sel ect Destination function will assist you with everything that has anything to
do with creating folders and saving them to your hard disk. First you need to select an existing
folder, or the main root and select the function by turning the SELECT wheel. The chosen folder
will appear in the display. Now you can save or copy into this folder .MP3 files or playlists.
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SEARCH FILE.

This is a search function. Using the wheel, you can enter a file name (or part of).

e Turning the wheel changes the symbols, pressing it enters the symbol and switches to the
next symbol. If you have made a mistake, you can always delete the previous symbol by
pressing the STOP button.

e When you have finished, you can enter the name by pressing the soft button (Ent er).

e The search engine will then browse the hard disk and the CD. Please note, that only .MP3
file names can be found- searching for ID tags or playlists would simply take too long.

e Searching using exclusively the remote control is also possible. You can read all about it
on page 32.

Note: You can use this function during playback of another title. How-
ever, this may take a little longer. This is perfectly normal.

Sounb.

This menu allows simple adjustments to the sound of .MP3 files. You have bass and treble
controls. Note: these adjustments only work for .MP3 files, the sound of audio CDs cannot be
adjusted and will not be affected.

Pressing . . back takes you back to the main menu.
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THE MORE MENU.

Here you have various different functions. They are in detail:

Sleep timer..

The sleep timer stops playback automatically after a certain period of
time (10-120 minutes) and switches the CD transport and the HDD to a
near silent standby mode. In order to prevent the machine from switch-
ing off while using it (i.e. to enter a playlist), pressing any button will
add one minute to the timer.

Aut oPl ay. .

Starts playback automatically when switching on. You can choose be-
tween

First Song — plays the first song on the CD or HDD
Shuffle Song — Randomly chooses a song from the CD or HDD

Party Lock. .

Protects the m3po from unauthorized access.
Lock CD Eject — prevents opening the CD drawer.
Lock HD — prevents writing onto the HDD.

Lock CD & HD - prevents opening the CD drawer and writing onto the
HDD.

Lock complete — disables all access to the m3po.
Unlock complete — enables all access to the m3po.
Set Password - lets you choose a password.

You can read more on the Party Lock later.

Split node..

Allows for a better display of very long file names or ID tags. You can
read more on scrolling later.

Sort HD Directories

Organizes songs, playlists and folders in alphabetical order. Depending
on the number of entries, this may take a little while.

Create HD i ndex

Creates an index of all titles for faster access.

| DE Speed

Determines the speed of your IDE Interface (for CD and HDD) and, as
such, the speed of copy and read operations. You can choose between
the following:

Slow - Slow data transfer. Most secure mode
Normal — secure mode

Fast — fast data transfer. Depending on the medium, this mode might
produce errors.

Endl ess Sel ect

Searching through a folder using the SELECT wheel switches back to the
first one. So there is no need for endless scrolling.

Show | D Tags

Switches display of ID tags on and off (see page 45).

Introscan Tine

Changes the intro time (s. Page 20 ff.).

Reset nBpo

Resets all settings in all menus back to standard settings.

Scrol ling

Switches the scrolling feature for titles with very long file (or folder, see
page 29) names on and off. (Scrolling: 2s pause, from right to left, 2s
pause and back).

Time and Date

Displays date, time and the machine’s serial number.

Set Tinme and Date

Set date and time.

MPEG | nfo

Displays resolution and Bit rate of the current .MP3 file being played.

About nBpo

Displays manufacturer’s info about the m3po.

Pressing . . back takes you back to the main menu.
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Party Lock.

The Party Lock function protects the m3po from unauthorized access, for example, when you
are busy enjoying your own party as discussed above, there are several access restriction
functions available. The only way to override this is to enter a password chosen by yourself.

To set a password, dial to "“Set Password".

e Turning the wheel changes the symbols, pressing it enters the symbol and switches to
the next symbol. If you have made a mistake, you can always delete the previous sym-
bol by pressing the STOP button.

e Once you have finished, you can set the password by the soft button (Ent er) and
confirm it using the SELECT wheel.

The password can only be changed, when all functions of the m3po have been unlocked. Im-
portant: Never forget the password! Once your m3po is locked, it stays locked — even after
turning off the power and switching it back on. However, if it does happen, (i.e. after severe
amnesia) you will need to contact our technical support team. Please have your serial number
and the average of your street number;-) ready, whenever you contact us.

INFO: The Emergency Exit (page 19) is still available, when party-
locked.

Split mode.

Sometimes, your song names and / or folder names can be very long. To list those lucidly, the
m3po offers a split mode. This will trigger an automatic shift in the display line, when certain
common symbols appear in the name. These are:

e “-“(dash)

e -7 (space, dash, space)

“ " (underline)

“ --- “ (space, triple dash, space)

(" (closed bracket)
e [" (closed corner brackets)

Finally, you can set the shift point to 20 symbols per line (>20 Chars). If the scrolling function
has been activated, the names will be displayed without the shift break

Scrolling will not be activated, if this function has been turned off in the MORE menu.
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MUTE.

The Mute function mutes the m3po. The chosen titles are still being played back inaudibly,
though. (One could also refer to it as ...... "being played virtually" ;-)).

VoLumE (PHONES).

Here you can adjust the volume of the headphones. Please note, that a value of higher than 10
causes distortion in many songs. This volume control does not affect the main output stage.

Pressing . . back takes you back to the playback window.

Note: All settings — except for the settings in the playlist you change
in all the menus, are kept after switching the player off. This means,

you won’t need to re-activate the D) mode, if you like to use it regu-
larly.

You can reset the m3po completely using the Reset nBpo-feature inthe Mor e-menu.
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THE REMOTE CONTROL.

Many important functions of the m3po can be accessed via its remote control. Please ensure
that the space between the remote control and the machine is not obstructed. Infrared rays are
light rays, which, according to today’s scientific knowledge, do not pass through solid bodies.

37)

The following graphic describes the functions in detail.

mute switch
. next Title
MPEG info Play
Forward wind
last Title Pause
Faster
Rewind Normal speed (100%)
Sl
ower Stop
Call up menu
Scroll up Scroll right
enter
Scroll d
Scroll left croft down
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Symbol entry using the remote control.

The entry of symbols for the search function or for creating new folders is also possible - if a
little bit tricky. This is how you do it:

e Select asymbolusingthearrow | eft andarrow ri ght buttons.

e The arrow up button switches between normal letters and capitol letters. This function
is only available for creating new folders. The search function (Sear ch) does not require
this function.

e Enter entersasymbol and moves cursor to the next position.
e The arrow down deletes a symbol and goes back to the previous one.
e Once you have finished, confirm the name by pressing Pl ay (!).

e When creating a new folder, you will be required to confirm for a second time by pressing
Pl ay again. Every other button cancels the operation. The second confirmation will not be
required when operating the SEARCH function.
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Decimal codes.

Friends of alternative remote controls will be looking for the decimal codes in order to program
their own remote controls. For handheld devices utilizing Palm OS and IR interface can down-

load the necessary software:

PalmRemote:
http://hp.vector. co.jp/authors/VA005810/renocon/ prenocce. ht m

OmniRemote:

http://ww. paci fi cneot ek. com

Please note that these websites have been compiled independently from us and that we can-

not accept responsibility for their contents. Thank you.

dec code el enment signature Function
112 Info info Show MP3 Info on display
111 Mut e mut e Mites the conpl ete playback vol ume
(headphones, |ineout, CD and MP3 pl ayback)
82 Previ ous synbol Skip to previous track
113 Pl ay synbol Start playback of track(s)
83 Next synbol Skip to next track
97 Rew nd synbol Search in playing track (rew nd)
79 Pause synbol Pause pl ayback
106 For war d synbol Search in playing track (forward)
80 Speed - Speed - decreases pl ayback speed of MP3 Pl ayback
86 Speed nor mal nor mal resets the speed of MP3 Playback to 100%
107 Speed + Speed + i ncreases pl ayback speed of MP3 Pl ayback
108 St op synbol Stop pl ayback
109 Up synbol sanme function |like ,up' button, see (2.)
110 Menu menu sane function like ,menu' button, see (2.)
81 Left synbol sane function like turning the wheel left, see (1.)
85 Ent er enter sane function like ,enter' button, see (2.)
70 Ri ght synbol sane function like turning the wheel left, see (1.)
87 Down down down for navigation in nenu, or enter in related
wheel node
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FITTING A HARD DISK.

The m3po can be equipped with an optionally available hard disk. The installation process is
relatively simple, PC buffs will probably have already skipped this page. Please pay extra at-
tention to the safety precautions.

Important: Disconnect the machine from the mains outlet and your hi-
fi before opening the case!

Quick-guide for PC buffs.
e Use anormal (preferably quiet!) IDE drive, SCSI won’t work.
e Size doesn’t matter.

e The drive should be configured to SLAVE. AUTO or CABLE SELECT is not possible. Some
hard disks, however, can cause problems when slaving to a CD drive. In this case, the hard
disk must be set to MASTER and the internal CD-ROM to SLAVE.

e You can format it using your PC or the m3po. The format is FAT16/32-compatible.

e Have fun.

Which hard disk should | choose?

The m3po can accommodate standard 3,5" ATAPI IDE drives. There are currently no size re-
strictions, but at the time of writing this manual, we could only test drives of up to 35Gb.

SCSI drives are not compatible with the m3po.

You should choose the quietest hard disk you can find. For research on this matter, you can
consult computer magazines in addition to the manufacturer’s information. Note: Investingin a
proper and well-specified drive will pay off in the long-term.
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STEP-BY-STEP.

e Touch the surface of the case and disconnect the unit from the mains outlet. This way, you
prevent damage to the components due to your own static load.

e Open the lid with a crosshead screwdriver.

e Remove the hard disk from its packaging and take a closer look at its connections. A hard
disk can be configured in two modes, MASTER (primary unit) and SLAVE (secondary unit).
This is a legacy of its PC application, as a PC can run several hard disks. The m3po has al-
ready a CD drive installed (primary unit), and the hard disk should be configured accord-
ingly:

The circle shows the jumper section of the hard disk. Next to it, you should find a little dia-
gram depicting the SLAVE settings. Usually, only one jumper needs to be moved. That’s all.

Set the hard disk to SLAVE or MASTER mode.

Note: Some hard disks, however, can cause problem when slaving to a CD drive. In this case,
the hard disk must be set to MASTER and the internal CD-ROM to SLAVE. Use the same steps
on the CD drive — move the plastic pin on the CD drive from MASTER to SLAVE.

If you get stuck with our step-by-step guide, consult the hard disk’s
manual, or ask the vendor for help. Note for experienced users: The
m3po does not support the AUTO-setting.
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Connect the ribbon cable to the hard disk. Important: The red lead of the cable must be
connected to the side marked with "1". But usually, the layout of the plug prevents you
from connecting it incorrectly.

Connect the multicolored cable to the hard disk. The yellow end of the cable must face the
far end of the hard disk. But usually, the layout of the plug prevents you from connecting it
incorrectly.

Affix the hard disk to the fixing points using the screws supplied with your m3po.

Affix the hard disk with two screws.
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A correctly installed hard disk.

e C(lose the case of your m3po. Make sure you do not leave anything inside, which doesn’t
belong there.

e Finally, reconnect the m3po to the mains outlet and switch it back on.

e Read the following page.
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WHAT HAPPENS NEXT?

To be able to use the hard disk, you need to prepare it for operation. In PC terms: You will
need to format it.

After switching on, dial up the menu and go to HDD Functi ons. .

Select For mat HDD and confirm this. The hard disk will be formatted. Any data, which might
have been stored on the HDD will be permanently erased.

After formatting the HDD, you can now access the hard disk as well as the CD drive. The hard
disk appears on the main root directory together with the CD drive and can be accessed using
the SELECT wheel and the UP button.

The HDD Functi ons menu described above contains several more functions. You can, for
example create, or delete, folders and — most importantly — copy from CD to HDD. The Fr ee
space on HDD feature indicates the available disc space in Megabyte (MB). A common
128kBit/s-rate will accommodate about two weeks of non-stop music on a 20Gb hard disk.

Note: All HDD functions stop playback automatically.

Tip: The file system of a hard disk formatted inside the m3po is FAT32 compatible. This allows
you to store .MP3 Data on your hard disk with compatible software (Windows and Linux; Mac-
intosh with additional software) and access it in your m3po.
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COPYING FILES.

Copying data from CD to HDD is simple. Choose the title in the usual way and press down the
SELECT wheel for about two seconds. The file will then be copied to the hard disk’s main root .

The same applies to copying complete folders. However, do not open the folder by pressing
the wheel so that the folder’s contents is displayed.

It is also possible to copy a file or a complete folder from CD into another folder on your HDD.

e Use the wheel to navigate as usual until you reach the folder, which you want to copy into.
Do not open the folder (see above)

e Find the Sel ect Destination. —function and confirm this by pressing the SELECT
wheel.

e Select the title on the CD and press down the SELECT wheel for about two seconds. The
track will now be copied to the destination of your choice.

It is not possible to copy a playlist, as the titles on the lists are not necessarily on the disc, and
more importantly, in the same location. Has a playlist and all its titles been saved to one
folder, then the entire folder and its playlists will be copied to HDD.
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SOFTWARE UPDATES.

The functions of your m3po may conveniently be updated from time to time. As with many
other hard and software products, upgrades are provided by TerraTec Electronic GmbH over
the Internet — usually free of charge. Alternatively, we can send you the upgrade on CD-ROM
subject to a minimal charge

Our web-address is: ht t p: / / www. n8po. net

INSTALLING UPDATES.

Upgrading the m3po is very simple thanks to an improved monitor function (version 2.0 and
later). If you have downloaded the upgrade from the Internet, you will find the file

MBPOOSxxx. EXE (where x stands for the version number), which can be run under Win-
dows. After running the program, you will find a number of files with the .BIN extension. Copy
these files to CD and ensure, that they are directly on the root directory, and not hidden away
in folders! It is possible to burn other data onto the CD (i.e. more songs) and use the one CD
for a multi-session.

Note for users of other operating systems (i.e. Linux): The .EXE file should show up in your zip
files and can be unpacked manually

Depending on which m3po OS version you are updating from, just follow the steps:

Updating from version 1.xx .

e Insert the CD in the m3po.

e After the automatic scanning process, press the menu button and
e Select the MORE menu.

e Select "Update with CD.." .

e The display will now indicate, that it has found an update (Update was found). If you do
not wish to update at this point, press the soft button (ESC). Otherwise...

e ...press down the wheel.

e After a few seconds, the message ‘Update finished" will appear.

e Switch the m3po off and wait for about 2-3 seconds.

® Press down the STOP button when switching back on.

e After initialization, the new '"M3PO Advanced Monitor' will appear.

® Press the MENU button and

e select 'Update from CD'.

e The display will now indicate, that it has found an update (Update was found).
e Press down the wheel.

e After a few seconds, the message "Update finished" will appear.

The m3po will now resume normal operation. The update has been installed successfully.

Note: Menu settings will be lost after auto-reset (see page 28,"' The More Menu.' )
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Updating from version 2.xx .

Insert the CD in the m3po.

e Switch the m3po off and wait for about 2-3 seconds.

® Press down the STOP button when switching back on.

e After initialization, the new "M3PO Advanced Monitor" will appear.
® Press the MENU button and

e select "Update from CD".

e The display will now indicate, that it has found an update (Update was found). If you do
not wish to update at this point, press the soft button (ESC). Otherwise...

e ...press down the wheel.
e After a few seconds, the message "Update finished" will appear.
The m3po will now resume normal operation. The update has been installed successfully.

Note: Menu settings will be lost after auto-reset (see page 28, ' The More Menu.' )

Tip for the pro's: From version 2.0 and later, you can also upgrade
from HD ("Update from HD").
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Downgrading a new operating system to version 1.xx .

Just in case you still prefer the old operating system, you could perform a downgrade. For this
purpose, the old files MBPO. BI N need to be renamed to MSPO_MON. BI N. Burn a CD with the
file in the usual way and ...

...insert the CD in the m3po.

Switch the m3po off and wait for about 2-3 seconds.

Press down the STOP button when switching back on.

After initialization, the new 'M3PO Advanced Monitor' will appear.
Press the MENU button and

select "Update from CD".

The display will now indicate , that it has found an update (Update was found). If you do
not wish to update (or downgrade) at this point, press the soft button (ESC). Otherwise...

... press down the wheel.

After a few seconds, the message "Update finished" will appear.

The m3po will now resume normal operation. The update has been installed successfully.

Note: Menu settings will be lost after auto-reset (see page 28, "The More Menu.")
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Updating "M3PO Advanced Monitor" from version 2.xx .

¢ Insert the CD in the m3po.

e Switch the m3po off and wait for about 2-3 seconds.

® Press down the STOP button when switching back on.

e After initialization, the new "M3PO Advanced Monitor" will appear.
® Press the MENU button and

e select "Update from CD".

* The display will now indicate , that it has found an update (Update was found). If you do
not wish to update at this point, press the soft button (ESC). Otherwise...

e .. pressdown the wheel.
e After a few seconds, the message "Update finished" will appear.
The m3po will now resume normal operation. The update has been installed successfully.

Note: Menu settings will be lost after auto-reset (see page 28, "The More Menu.")

Caution: A power cut during the software installation process may
cause damage to the operating system (EEPROM). Never perform a
software update during thunderstorms or in areas with high fluctua-
tions in the mains voltage.

m3po 43
BHM Ex. 2007



PLAYLISTS.

The m3po offers great possibilities to compile, save and playback of playlists. Playlists consist
of pre-programmed titles which are played back by the m3po. You can read more on this in the
chapter "Menu functions" on page 19. If there is a hard disk installed in the m3po, these lists
can be saved to disc and played back.

The playlists used by the m3po are .M3U compatible, which has been made a common stan-
dard by the Winamp Player. This allows you to compile playlists inside your PC and burn these
to CD together with your .MP3 data.

WINAMP PLAYLIS

Upliftment From
»iBaba)- In Jah City

thing
hirt (£appa-Bozzio-0O'H

= (1o
P TEE

When copying playlists ...

When copying playlists from CD to HD, please note that it is not possible to copy a complete
playlist, as the titles on the lists are not necessarily on the disc, and more importantly , in the
same location. If a playlist and all its titles have been saved to one folder, then the entire
folder and its playlists will be copied to HD.

You can read more on this subject on page 39.
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WHAT ARE ID TAGS?

ID Tags are additional information contained within the .MP3 file. A small part in the header of
the .MP3 file is reserved for the track name (which need not be identical to the file name), art-
ist and album. In addition, you could store information on the year of release and music style.
This data, however, is not displayed in the playback mode, but is available on pressing the info
button on the remote control (or when accessing the "MPEG Info" function in the MORE
menu).

MPEG file info box + ID3 tag editor x|

|E:'\H e Rozsi sucht daz Gluick. mp3

. e MPEG info
NN Herm Bozsi sucht das Gllick, Size: 1356000 bytes

: . Length: 97 seconds
Artizh |Frann::-:| Godi MPEG 1.0 laper 2

11 2khbit, 3720 frames
441 00hz Jaint Steren

Alburn |S ignor Boszi-Onginal Music...

- | | Private: Mo
rear |'IE|?E Genre |I:u|t J CRCs: Mo
Comment |Gestatten, Fossi . T
Original: ez

S ave | Cancel | FlemwelD3| Emphasis: Mone

ID Tag in Winamp Player.

The display of ID Tags can be disabled in the MORE menu. See page 28.
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USEFUL INFORMATION ON MP3.

Her we have compiled some general information on MP3, its origin and software to convert
your own music and, most important, what is allowed and what is not?

WHAT IS MP3?

MP3 is an abbreviation for MPEG Layer 3, which in turn contains another abbreviation: MPEG =
Motion Picture Experts Group, which is governed by a group of competent experts from film
production industry. MPEG is basically a storage format for audio and video data, which has
been in constant development for years. The basics for today’s popular third layer of the
MPEG2.5 audio specification has been developed in the late eighties by the Frauenhofer Insti-
tut flir integrierte Schaltungen (Frauenhofer IIS - Germany).

Its main advantage is the small size of its audio files, as described in the following example: If
you record a standard audio CD on your home PC, then this will use about 650 Megabyte (MB)
of hard disk space. Converting this into MP3 files, you are presented with only 1/11 of its origi-
nal size, roughly 60MB. If the files contain nothing but speech (i.e. language courses), the size
of the file can be reduced to 1/25 of its original size, without losing too much of its sound
quality. This is quite useful, as you can see:

o) ) WP
6% (2% (9%
D (B (o
W) ) &)
(0% (0% (0%
1:1 11:1 4 - <z 25:1
CD-Audio MP3 128kBit/s MP3 56kBit/s
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How come?

"Layer 3" is a clever combination of data compression and data reduction. This means that
digital data is being compressed (The PC calls this ' packing' , for example when converting to
the .ZIP format). In the process, the data will be scanned for repeat data. To save space, this
data will only be saved once and tagged with information, where it needs to re-appear. This
can account for massive reduction in storage space and means that the data will be identical to
the original, once ' unpacked' (i.e. decompressed).

In order to achieve a decrease of 1:11 or more, another process will be required - data reduc-
tion. You may have guessed by its name, that some data will actually be cancelled in this proc-
ess. As the most important aspect is what you are left with, we will take a quick look at the
actual process:

The applied data reduction is based on algorithms, which cancel out inaudible data. For exam-
ple, the brain can hardly hear very quiet sounds, which occur immediately after (a few milli-
seconds) after a loud signal. If the sounds are outside the frequency spectrum of the human
hearing, it becomes literally impossible.

Canceling this data in the recording process leads to another significant reduction in data. This
data has now been permanently erased from the original file. This shouldn’t be too much of a
problem. Reducing data to one eleventh of its original size (128kBit/s) in this manner, does
lead to an audible difference to CD, but the quality should not really be the issue here. .MP3
was never developed in competition to CD, but to offer an alternative option of storing your
audio data. And .MP3 is a great alternative, which is a great benefit to the user.
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Legal or not?
The issue of legality will be on many people’s mind. What is legal and what is not?

There is a, possibly, quite legitimate objection from the music industry against the use of this
technology: The Internet is being used to distribute copyright-protected art forms (music in
this case). This cannot be questioned, as, given enough time, you can find loads of information
on the Internet, which really doesn’t belong there.

At this point, we would like to ask you to handle this issue responsibly, because it is not only
the industry, which can be damaged from the Internet, but also the artists themselves, espe-
cially those ones, who have no alternative of marketing their product.

The private use of this technology with legally purchased material, has not been a problem so
far — enough for us to develop and supply machines, which make the most of this new medium.
So how do you use your player that no-one goes empty-handed? The best way, of course, is to
have direct access to your vast amount of music on an HD. Therefore, you need to have pur-
chased the music legally, usually on CD. You can save these CDs to HD, convert them to .MP3
files and use them in your m3po player — as you have always done with conventional CDs for
private use. At this point, we would like to draw a comparison with copying to tape (for your
car stereo), or minidisk — everything OK.

However, it is generally not allowed to copy complete CDs for public (non-private) use.

In connection with this, the Internet should not be branded a nest of illegal activities. The web
is already the information source No. 1 and as a result, your first point of contact for purchas-
ing .MP3 software, or simply for learning more about the .MP3 format. Also, more and more
record labels appear in the web and offer hundreds of thousands of songs form newcomers, as
well as more established artists like: Alanis Morissette, Tori Amos, David Bowie, Beastie Boys,
Billy Idol, Peter Townshend, Dionne Warwick, George Clinton, Die Toten Hosen — the list is
exhaustive. And this is only the beginning of a new format, which had been dreamt of by many
artists (and predicted by not so many...) for years.
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How does it all work?

So how do you create an .MP3 file and how do you get it into your player? An important ques-
tion, and we would like to answer it right here.

As described above, the .MP3 format differs greatly from the data you find on an audio CD.
.MP3 files are data-reduced, which means that they are manipulated by computer software.
This shrinking process is called encoding. This is very time-consuming, as the data is being
scanned for repeat data, which can be filtered out. The encoding process itself can be done by
yourself, given the right software — The only other thing you’ll need is a fast PC or lots of time.

The most common practice these days is the reading of audio files and the subsequent en-
coding in the .MP3 format. First, the CD’s content will be saved to disc. Providing you are using
a high-quality CD drive, the copy will be identical to the original — even though minor errors
can occur, they are usually inaudible .

Once the data is on HD, you can start the encoding process. Here you can usually choose the
amount of data compression you want to apply to the data. This compression (next to data
reduction) is measured in kilobits per second (kBit/s), for example 96kBit/s. The smaller the
value, the smaller the size of the .MP3 file. But also the bigger the deterioration in sound
quality. Music in stereo CD quality requires a value of no smaller than 112-128kBit/s. Speech
(mono) is usually being compressed to a value of 32-56kBit/s . The following table will show
you a few applications:

13 kBit/s Reduction
Telephone 8 96:1
Better than short wave radio 16 48:1

Good general quality 32 24:1
Radio quality (stereo) 56...64 26...24:1
Near CD quality (stereo) 96 16:1

CD quality (stereo) 112..160 14..8:1

The m3po processes bit rates of up to 320kBit per second.

The coded data can be burned to CD and played back by your m3po. As simple as that.
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INTERNET LINKS.

The fastest way to find more information on .MP3 and music, is to search the Internet. The
following addresses should offer you a starting point:

Provider ‘ Description ‘ http://
TerraTec Your manufacturer. Www. t errat ec. net

TerraTec The m3po Homepage. www, nBpo. net

Fraunhofer | Where it all began. ww. i i s. fhg. de/ amm

Institut techinf/layer3/index. htm
50 m3po
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http://www.terratec.net/
http://www.m3po.net/
http://www.iis.fhg.de/amm/techinf/layer3/
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SIREN™
Jukebox

Product registration

To register on-line with Sonic Foundry, please follow the steps outlined in the registration
wizards upon installation of this product.

Registering your product will provide technical support, notification of product updates, and
special promotions exclusive only to Siren registered users.

Sonic Foundry product registration helps protect against software copyright infringement
and allows us to provide support exclusive to registered users.

If you do not have access to the Internet, registration assistance (in English) is available.
Please contact our Customer Service Department, 24 hours per day, seven days per week.

Telephone

® 1-800-577-6642 (toll-free) in the US, Canada, and the Virgin Islands.

¢ +800-000-76642 (toll-free) in Australia, Denmark, France, Germany, Italy, Sweden,
UK, Netherlands, and Japan.

® +608-256-3133, extension 2300 in all other countries.

E-mail

customerservice@sonicfoundry.com

Fax
1-608-250-1745

SIREN™ JUKEBOX
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Technical Support
1-608-256-5555 Monday through Friday between 7am and 10pm (CST).
Fax: 608-250-1745

E-mail: support@sonicfoundry.com

Sonic Foundry, Inc.
754 Williamson Street
Madison, W1 53703

Sonic Foundry Europe

PO Box 2903
2601 CX Delft
Netherlands

The information contained in this manual is subject to change without notice and does not
represent a commitment on the part of Sonic Foundry. The software described in this
manual is provided under the terms of a license agreement or non-disclosure agreement. The
software license agreement specifies the terms and conditions for its lawful use. No part of
this manual may be reproduced or transmitted in any form or by any means for any purpose
other than the purchaser’s personal use, without written permission from Sonic Foundry,
Inc.

Sonic Foundry and Siren are trademarks of Sonic Foundry, Inc. All other products
mentioned in this manual are trademarks or registered trademarks of their respective

holders.
© 2000 Sonic Foundry, Inc.

SIREN™ JUKEBOX
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CHAPTER

Overview

1

Introduction

Sonic Foundry’s SIREN™ Jukebox allows you to play audio CDs and music files of various
formats from your computer. SIREN Jukebox will record music from your personal CD
collection to your computer for playback, as well as allow you to create custom CDs and
download music to portable players.

With SIREN Jukebox, you can organize create and organize a personal music library, making
it easy to locate a specific song, even in an extensive collection. SIREN Jukebox will also
sort, group, and filter your music library to create custom playlists for any occasions.

This manual describes the basic features of SIREN Jukebox, and provides the procedures
needed to take full advantage of the program.

SIREN Jukebox Highlights

Siren will help build and manage your music collection by:

¢ Playing CDs and music files.

* Recording music from CDs to the computer for playback.

® Organizing music into playlists.

® Storing extensive database information for your music library.
* Helping you download music from the Internet.

* Creating custom CDs from your music library.

¢ Downloading music to portable players.

CHP.1 OVERVIEW
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System Requirements

The system’s components affect Siren’s performance. What follows is a list of the minimum, com-
mon, and recommended system requirements.

Minimum System Requirements

200 MHz processor

VGA display

32 MB RAM

DirectX Media 6.0 or later

Common System Requirements

Microsoft ® Windows™ 98, 2000, or NT 4.0

CD-ROM drive

Supported CD-Writer (for CD writing features)

Supported portable player (for portable player features; not available for Windows NT or
Windows 2000 systems)

20 MB hard-disk space for program installation

Windows-compatible sound card

Internet Explorer™ 4.0 or later to view the online help

1024x768 pixel screen area

Recommended System Requirements
® 4 GB of hard drive space (This allows for storage of over 100 CDs).
Ve

Note: When recording at CD quality, one
minute of recorded music uses 1 Mb of storage
space.

N\

® 24-bit color display (for viewing spectrum and scope analysis)
e 64 MB RAM

Registration

Registering a SIREN Jukebox Download

Users who own a full version of Siren 1.0 and download Siren 1.5 from the Sonic Foundry
web site, need only to uninstall the previous version and install the updated application.
The Siren 1.0 serial number or product unlock key will unlock a full version of Siren 1.5.

OVERVIEW CHP. 1
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Once Siren is unlocked, choose Register Siren from the Help menu and follow the dialog

instructions to register the program. While registering is not mandatory, it allows Sonic
Foundry to provide you with technical support, application updates, and special promotions.

Registering a Sonic Foundry SIREN Jukebox CD

Sonic Foundry's new browserless registration process allows owners to immediately begin
taking full advantage of Siren’s powerful array of features. The system will automatically
detect if Siren is being installed from an authentic Sonic Foundry CD, and if so, unlock all
of the program’s features without requiring any user input.

Once Siren is unlocked, choose Register Siren from the Help menu and follow the dialog
instructions to register the program. While registering is not mandatory, it allows Sonic
Foundry to provide you with technical support, application updates, and special promotions.

If the application was not purchased, users may elect to purchase a full version of Siren, or
use Siren XPress.

Purchasing a Full Version of SIREN Jukebox

If Siren was not purchased, a registration dialog is displayed the first time the program is
launched. From this dialog, users may elect to enter a serial number for a full version of
Siren, or use Siren XPress.

Purchasing SIREN Jukebox Online

To purchase Siren online:

1. Select the I would like to use Siren XPress radio button and click [Zfmh_]. Siren XPress is
launched.

2. From the Help menu, choose Instant Upgrade. The Purchase Upgrade dialog is displayed.
3. Select the | want to purchase online radio button and click . The system attempts to

launch its browser and connect to the Sonic Foundry Web site.

4. Follow the instructions to purchase the upgrade. When the transaction is completed a
Product Unlock Key is e-mailed to the user.

5. Enter the Product Unlock Key and click [_Fasn_]. The full version of Siren is unlocked.

Purchasing SIREN Jukebox Over the Phone

To purchase Siren over the phone:

. Siren XPress is

1. Select the | would like to use Siren XPress radio button and click [ Fen
launched.

2. From the Help menu, choose Instant Upgrade. The Purchase Upgrade dialog is displayed.

CHP. 1 OVERVIEW
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4.

Select the | want to purchase over the phone radio button and click [CEE2]. The Purchase
Upgrade via Phone dialog is displayed.

Write down the provided Computer ID number and contact the Sonic Foundry Customer
Service Department at:

® 1-800-577-6642 in the U.S., Canada, and the Virgin Islands

® +800-000-76642 in Austria, Denmark, France, Germany, Italy, Sweden, UK,
Netherlands, and Japan

® +608-256-3133 extension 2300 in all other countries

- When the transaction is complete, enter the Product Unlock Key and click [ 1]. The

full version of Siren is unlocked.
L

Note: Note: The Computer ID is a number
that serves to identify the computer for
licensing purposes only, and contains no
specific information about you, your
computer, or any files or other data on your
system. Sonic Foundry is aware of your
privacy concerns and strives to collect only as
much data as is required to make your Internet
and/or product use experience as efficient and
satisfying as possible.

Using SIREN Jukebox XPress

Users not wishing to purchase a full version of Siren may use Siren XPress, a limited version
of the application, free of charge. To avoid confusion, features included only in the full
version of Siren are identified with the following icon: ggm

OVERVIEW CHP. 1
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Music Files

Music files are any audio file Siren will playback from the computer. Siren supports the
following audio file formats:

File Type Extension Description

Wave (Microsoft) *.wav Standard audio format used on Windows-based computers.

MPEG Layer 3 *.mp3 Popular audio compression format. In addition to playing .mp3
files, Siren can create .mp3 files from music recorded off audio
CDs, and from .wav files. .Mp3 files are the only files that can be
downloaded to portable players.

Windows Media *.wma Microsoft file compression format that provides security features

Audio to prevent unauthorized duplication. In addition to playing .wma

files, Siren can also create .wma files from music recorded off

audio CDs, as well as from .wav and .mp?3 files.

Main Window

Siren’s main window and panels are depicted below. Each of the labeled panels can be
toggled on/off by choosing the appropriate panel in the View menu. For more information, see
SIREN Jukebox Panels on page 15.
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Minot Switchman Vantage Canada 4:36 ThuFeb 17 06:53:20
s tocks, men Witow Weep For Me Dos 226 ThuFeb 17 06:5320
D1 Greenthumb Cypress Hit 4:24 TuoFeb 15074345 _,.
- ] New Playist ot el Anatad i FIR Trea Cak 18 0742 a5l
3] Cunont Playlist SR | 3
" Wi Plaghiat BB, Addto Playist; SendtnPotable .
Heverb - Biight Hat Time S «{Custom) -
i =

2208 D]

Note: For detailed information regarding the
main window, refer to online help.
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Using Online Help

Siren includes online help, which contains detailed information about all program
components and functions. Internet Explorer 4.0 or higher (included on the Siren CD-
ROM) must be installed on the system to view online help.

Accessing Help
Online help is displayed using the keyboard or the Help menu.

Main Help Window

The main help window is displayed by choosing Contents and Index from the Help menu or

by pressing the [F1] key. The main help window contains three tabs which are used to locate
the desired information.

.';, Welcome la Sanic Foundiy’s Siren

l Gorteri  ¥ex | searon | Index Tab

Toolbar &7 &« & @
Hde Back  Pint  Qpbons | Typsinthe keyprordto fexd
Gortorts ydsx  Search * "
Introduction L Qu ck Find oo -
::'::SE"‘ wav Fes
Playng
Siren Vindow AB~ EEGHILMNP R. wma Fies
v Playing
{2] Keyboerd Shortcuts :n;n Siren S h Tab
Troubleshooting A Ao Lbvery earc a
Add to Plarytist
Adding New Categor  Sonterts | Search
Acio Ading Song nformal Type in the keymord o find:
Somc Foundry's ACID 1s 2 loop-
based music creation tool. With
loop amanging and editing, ACID it Toples.
gives musicians unprecedented
El:.ggte“ts creatwve flexibility Lnformation Select Toplc to display:
J_:_]ﬁ ane
. =
DResplay

The Contents tab provides a categorized listing of available help topics. Click a book ( ),
and a topic page (@) to display a topic.

The Index tab provides a complete listing of the help topics available. Use the scroll bar to
scroll through the list or enter a word in the text box to quickly locate related topics. Select

the topic and click [ psper ].

The Search tab allows users to enter a keyword and display all pertinent topics in online help.
Enter a keyword in the text box and click [[i&asg]. Select a topic from the list and click
[0y |. The selected topic is displayed in the information pane.

OVERVIEW CHP.1
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Help on the Web

Additional help is available on the Sonic Foundry web site. To quickly connect to the Sonic
Foundry web site, choose Sonic Foundry on the Web followed by the appropriate help subject
from Help menu. Siren launches an internal browser and attempts to connect to the
appropriate page on the Sonic Foundry web site, via your Internet Service Provider (ISP).
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Setting Up
2 SIREN Jukebox

SIREN Jukebox Settings

Prior to using Siren, users must configure various operating settings to allow them to take
full advantage of Siren’s features.

Before using Siren for the first time, users should:

¢ Customize the Siren window; displaying, sizing, and arranging panels to make the screen
as comfortable and intuitive as possible. For more information, see Customizing the SIREN
Jukebox Screen on page 9.

¢ Specify the music library folders using the Configuration Wizard. For more information, see
Configuration Wizard on page 10.

* Verify that the computer is configured to play CDs automatically. For more information,
see CD Autoplay on page 47.

¢ Search the computer for music to begin building a music library.

Customizing the SIREN Jukebox Screen

Users can move and resize the majority of Siren’s panels. Panels can also be toggled on/off by
choosing the appropriate panel from the View menu. For more information, see SIREN
Jukebox Panels on page 15.

CHP. 2 SETTING UP SIREN JUKEBOX
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Configuration Wizard

The Configuration Wizard is automatically launched the first time Siren is run, and allows users
to configure their Siren preferences.

,

L
Note: The Configuration Wizard can also be
launched by choosing Configuration Wizard

from the Options menu.
L

-

Completing the Configuration Wizard

To use the Configuration Wizard:

1. Choose Configuration Wizard from the Options menu. The Welcome to the Configuration
Wizard dialog is displayed.

This Canfiguration Wizard is designed to quickly help you get
up and running with Sonic Foundry SIREN Jukebos,

Thess settings can be changed or fine tuned at a later time by
choasing Prefetences from the Gptians menu, of you can ne
this wizard again by sslecting it from the Options menu.

The ollawing configuration settings must be specified in oider
to use some of the key features in Sonic Foundry Siren.

x> Canc l

2. Click [[ZF51. The Please Enter Your Email Address dialog is displayed.

SETTING UP SIREN JUKEBOX CHP. 2
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Please Enter Your Email Addiess

Sonic Foundry SIREN Jukebox can automatically grab artist,
album, genre, and track data for the audio CD3 that will be
tecorded in your music library.

CDDB (Compact Disc Database} is a hugs onfine collection of
fles that contains this information for most audio CDs.

‘You must have an Intemet connection and a valid emai
address to accass this database.

Email address {required for CODB access}:

I~ Anorgmous

< Back Next> Cancal

3. Enter an appropriate e-mail address in the field and click [ZE5). The Enter Your Music
Files Folder dialog is displayed.
L

Note: Users not wishing to provide an e-mail
address can simply select the Anonymous
checkbox.

Sonic Foundry SIREN Jukebas can record sangs from you
personal CD collection and stare them in an oulput foldet on
your hard drive.

Please specify the location of this folder,

M files foldex:
Browse.

Free space in foldar 6.0 Gigabytes

4. Accept the default folder location or click [Be5] and select the system folder in which

Siren will store music files.

5. Click [CE#5]. The Search Computer for Music dialog is displayed.

CHP. 2 SETTING UP SIREN JUKEBOX
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Search Computer for Music | %]

‘You may alieady have a collection of music files on your
computer that Sonic Foundiy Siren can play. Do you want te
locate these filss and automatically add them to pour Music
Library?
* Yed
No

Look for musicin: A jgcal hard diives v

< Back Next > Cancel

6. If necessary, specify a drive to search from the Look for music in drop-down list and click
. Siren searches the selected hard drive(s) and indicates the number of music files
found.

,

Note: Users not wishing to search for music
should select the No radio button.

Y

For more information, see Searching for Music on a Hard Drive on page 13.

. The Set Default Player dialog is displayed.

’ . X

smmmﬁwsmzn Jukebox as your default player

(recommended] will sutomatically play your selecton when you
dmblifg_ﬁgléu_r dawnioad a music file.
o

If you have sutonsert notification enabled (this 1 the Windows
default seltig)/Soric. Foundy SIREN Jukeboxwi stat”
the first iackiwhien’yiou insert an-audio CD into the drive.

I
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8. Select the checkbox(es) corresponding to the file type(s) for which Siren will serve as the
default player.

9. Click [_Fr_]. Siren’s preferences are configured. Individual settings may be edited by

choosing Preferences from the Options menu.

Searching for Music on a Hard Drive

Siren will scan the specified drive(s) for .wav, .mp3, and .wma files, then either physically
move the files to the music files folder or simply add links to each song.

To search the computer for music:

1. Choose Search Computer for Music from the Options menu. The Search Computer for Music
dialog is displayed.

Search Computes for Music | 78 X|
ook for music in: Browse...

Add the following types of music files to my music fbrany:
v Windows Media Audio (.wma)
¥ MPEG Layer 3 Audio (mp3}
Mictosoft Waye Audio (.wav)
Known Plaplists (m3u & .pls}

Move located music files into my music fles folder

2. Specify the drive(s) to be searched in the Look for music in drop-down list.
3. Select the checkbox(es) corresponding to the file format(s) to be added.

4. To physically move files to the music library folder, select the Move located music files into
my music files folder checkbox.

When this checkbox is cleared, music files remain in their system location, and Siren
simply creates links to the Manage My Music Library view.

7] to begin searching. Once Siren has completed the search, it indicates the
¢ files found.

J. The music search is completed and Siren’s main window is displayed.

Searching for Music in a Network, Removable Drive, or Folder

To search a network, removable drive, or folder for music:

CHP. 2 SETTING UP SIREN JUKEBOX
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. Select the Navigator panel’s Explore My Files icon.

. Use the tree view to select the drive or folder to be searched.

. Right-click and choose Search For Music from the shortcut menu.
. The Search Computer for Music dialog is displayed.

. Select the checkbox(es) corresponding to the file format(s) to be added.

O 01 A W N -~

- To physically move files to the music library, select the Move located music files into my
music files folder checkbox.

When this checkbox is cleared, music files remain in their system location, and Siren
simply creates links to the Manage My Music Library view.

7 Click to begin searching. Once Siren has completed the search, it indicates the

number of music files found.

8. Click [[Z% . The music search is completed and Siren’s main window is displayed.

Compact Mode

Siren allows users to place the application in compact mode and use skins to give the Siren a
new look. Though skins typically include only a portion of available Siren controls (often
only the Transport bar) they are convenient for placing on the desktop and providing limited
Siren control while working in another application.

Toggling Compact Mode On/Off

Users can toggle between Siren’s compact and normal modes by:

¢ Clicking in the Transport toolbar
¢ Choosing Compact/Skin Mode from the View menu

* Pressing [Ctr]+M on the keyboard

Selecting a Skin

Siren features a number of built-in skins. To use a skin, simply select it from the Skins menu.
Siren is automatically placed in compact mode and the new skin is displayed.

Getting More Skins

Users can download additional Siren skins, as well as the resources needed to create custom
skins. To download new skins, or the Sonic Foundry Skin Grafter’s Kit, choose Get Skins
from the Skins menu. Siren launches the internal browser and attempts to connects to the
page of the Sonic Foundry web site dedicated to Siren skin support.

SETTING UP SIREN JUKEBOX CHP. 2
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SIREN Jukebox
Panels

SIREN Jukebox Panels

Siren features a number of panels designed to help manage music collections, customize
audio attributes, and enhance the jukebox experience.

Displaying Panels

To toggle a panel display on/off, select the appropriate panel from the View menu.

Navigator

The Navigator panel displays several icons designed to assist users in acquiring
and managing personal music libraries.

My Music

The Manage My Music Library icon displays the contents of a personal music
library, views and playlists, in the Explorer panel.

Audio CD

The Play or Record Music CDs icon lists the contents of the audio CD in the
system’s current CD drive.

Explore

The Explore My Files icon launches an Explorer within Siren, allowing users to
navigate the system without exiting the application.

Get Music

The Search for Music on the Internet icon launches Siren’s internal browser and
displays links to several Internet music resource sites.

CHP. 3
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Create Music

The Create Music with ACID icon launches any Sonic Foundry ACID product installed on the
system. If an ACID product is not located on the system, Siren launches an internal browser
and attempts to connect to the area of the Sonic Foundry web site dedicated to ACID.

Transport
KM= % Eject
Play In Order/Random
Play Once
Next Song/Previous Song
Stop
Compact Pause
Mode Play

Record

The Transport panel contains buttons corresponding to Siren’s music playback control. For
more information regarding the Transport panel, refer to online help.

Spectrum
FulScreenblode »  SPectrum is one of Siren’s two visual displays. The Spectrum panel is capable
Random of displaying real-time visualizations based on FFT (Fast Fourier Transform)
Corona analysis of songs.
Smoke
Bubbler Selecting the Spectrum Display
Shack
Perbow Sk To select the Spectrum panel display, right click on the panel and choose the
® Oradi desired display from the shortcut menu.

Full Screen Mode

Selecting full screen mode expands the Spectrum display to fill the screen at a user-specified
resolution.

Graphic EQ

The Graphic EQ panel divides the audio spectrum in sixteen bands, and allows users to
customize their listening experience by boosting or cutting specific frequencies.

SIREN JUKEBOX PANELS CHP.3
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Setting the Graphic EQ
ractic £0 - (Custom) . Toadjust a band, left-click on the fader thumb, and using
% the mouse, drag it up or down. If Band Tension is disabled,
individual bands can be adjusted independent of the
0 . . . .
surrounding faders. If Band Tension is enabled, adjusting a
® fader affects all adjacent faders.

Enabling Graphic EQ

Selecting the Graphic EQ checkbox applies equalization to the current audio. Clearing the
checkbox bypasses the current EQ settings.

Graphic EQ Shortcut Menu
v Graphic EQL: (Cust Clicking the title bar of the Graphic EQ panel displays the
8 g"““’"’ Graphic EQ shortcut menu. Using this shortcut menu, users
o e can quickly:
P

5 n:; *Select an EQ preset

+ Bard Tension *Reset all EQ bands

v Enable ¢ Toggle Band Tension on/off

eEnable/disable the Graphic EQ

Reverb

Reverb simulates the acoustics of various venues and situations. It can also be used to create

interesting effects by placing sounds in spaces, real and otherwise, where they are normally
not heard.

v Reverb - Small Hall
Mix

Size

Brightness

Configuring Reverb
Configuring Siren’s Reverb involves three individual parameters:

® Mix determines the amount of processed sound in the output. When Mix is set to 100%,
only the reverberated signal is heard. For more realistic reverb effects, reduce the mix
level.

® Size determines the time lapse between the initial audio and the onset of reverberation.
This, in turn, determines the illusion of the size of the acoustic space. Longer times are
associated with larger spaces, therefore, increasing the Size values simulates a larger room.

CHP. 3 SIREN JUKEBOX PANELS
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* Brightness determines the reverb decay time. In a dampened room, walls absorb sound
quickly, whereas in a bright room, such as a gymnasium, walls reflect more sound.
Reverberation in a bright room lasts substantially longer than in a damp room, therefore,
increasing the Brightness level simulates a larger, brighter venue.

<

Fovet- Coston) Like Graphic EQ, Reverb values are set by left-clicking on

" the appropriate slider thumb and dragging it to the left
or right:

Sre

Brghiness *Moving the thumb to the right increases the value.

*Moving the thumb to the left decreases the value.

Users are encouraged to experiment freely with the Reverb parameters to create custom
effects.

Enabling Reverb

Selecting the Reverb checkbox applies reverberation to the current audio. Clearing the
checkbox bypasses the current reverb settings.

Reverb Shortcut Menu

- Clicking the title bar of the Reverb panel displays the

Reverb shortcut menu. Using this shortcut menu, users
can quickly:

®Select a Reverb preset
®Reset all Reverb parameters
®Enable/disable the Reverb

Time Stretch

v Tine St ch-Nomdl - Time Stretch alters the length of a song without changing its
pitch. It is important to realize that this feature is most

Time effective for applying light to medium time compression or
expansion. Attempting to severely alter the length of a song
typically results in a distracting distortion of the audio
signal.

Setting Time Stretch

To set Time Stretch, left click on the slider thumb and drag it left or right:

* Moving the thumb to the right speeds the song up, thereby decreasing its length.
* Moving the thumb to the left slows the song down, thereby increasing its length.
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Time Stretch - (Custom} v

Time

Notice that the Time Stretch value is depicted as a percentage of the song’s original speed.
/"

Note: Double-clicking the Time Stretch slider

thumb returns the song to its original length

and tempo.

Enabling Time Stretch

Selecting the Time Stretch checkbox applies the current setting to the audio. Clearing the
checkbox bypasses the current time stretch settings.

Time Stretch Shortcut Menu

v Tastoch-Cot 1 - Clicking the title bar of the Time Stretch panel displays the
Double Time Time Stretch shortcut menu. Using this shortcut menu, users
roo can quickly:
Reset ®Double the length of a song
v Enable *Halve the length of a song

*Restore a song to its original length and tempo
eEnable/disable Time Stretch

Scope
FulscesnMode »  SCOPe, Siren’s other visual effect, displays real-time visualizations based on
e Random waveform analysis of songs.
Mars
Neon Flowers Selecting the Scope Display
TieDye To select the Scope display, right click on the panel and choose the desired
lion display from the shortcut menu.
-
Disco Plaid

Full Screen Mode

Choosing full screen mode expands the Scope display to fill the screen at a user-specified size
resolution.
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Song Info
The Song Info panel lists the artist, album, and genre of the current song.
Adtist: TomWaits Alburm: lMuIeVanahohs ' o Gerve: |Pop ' - ~]
Status Bar

The Status Bar is a scrolling display that provides playback information, based on whether
Siren is in Playback or Recording mode.

Playback Status Bar
During playback, the Status Bar displays:

* The current song’s title, artist, album, sample rate, bit-depth, channels, and bit rate
¢ The next song’s title, artist, and album

Recording Status Bar
During recording, the Status Bar displays:

The name of the song being recorded, its track number, and sample rate

Size of the song (in MB)
Drive location of the music library
Space remaining on drive

Volume

The Volume panel, which contains a volume fader and level meters, allows users to determine
and monitor Siren’s playback volume.

Setting Volume
To set Siren’s volume, left-click the fader thumb and drag it up or down:

® Moving the thumb up increases playback volume.
* Moving the thumb down decreases playback volume.

Volume Shortcut

Right-clicking the Volume panel displays the Volume shortcut menu. Using this menu, users
can:

® Reset volume level clips

SIREN JUKEBOX PANELS CHP. 3
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® Enable/disable volume meter labeling
¢ Determine labeling increments

¢ Enable/disable the hold peak and hold valley features

For additional information on any of Siren’s panels, refer to online help.
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4 Music

Organizing Music

Music in the Manage My Music Library view can be categorized, sorted, and filtered. Siren
organizes songs based on information provided with the song, including artist, album, and
genre. If information is not available for a song, Siren places it in an Unknown folder in each
category.

In addition to predefined organization included in the Manage My Music Library view, Siren
can create custom playlists. For more information, see Custom Playlists on page 29.

CD Information

If Siren is able to retrieve information about a CD, either from the CD itself or a local
database, this information is displayed.

Configuring CD Information Preferences

Prior to using the Siren’s CD information features, users must configure the music database
preferences.

To set the music database preferences:
1. Choose Preferences from the Options menu. The Preferences dialog is displayed.

2. Select the CD Info tab.
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Pieferences KiE3
General Recording CDInlo CDSet” o Secui |

v Get CD Info from COPLAYER.INt if availabls
r%et‘CD Info from CD-TEXT if present on audio CDs

:Automalically gat CD Info from the Intemet
Email address (requited for CODB accass

Addiess Desc” - Get Sites

Default Site

oK c Apply

3. Select the checkbox(es) corresponding to the desired CD information option(s) and click
&b _|. Siren is configured to retrieve CD information automatically when a CD is
inserted and the Play or Record Music CDs icon is clicked.

Compact Disc Database

In addition to the previously discussed option, Siren can retrieve CD information over the

Internet from the Compact Disc Database (CDDB).

Configuring CDDB

Users typically configure CDDB in the Configuration Wizard that is launched the first time
Siren is run. However, CDDB configuration can be edited at any time.

To edit the CDDB configuration:

1. Choose Preferences from the Options menu. The Preferences dialog is displayed.

2. Select the CD Info tab.

3. If desired, select the Automatically get CD Info from the Internet checkbox.
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General Recording CD Info | CD Settings | Secuity
{Mentain a local database of audio €O informatior]

Get.CD Info'from COPLAYER.INI if avaiable
Get CD Info from CD-TEXT i present on audio CDs

Automatically get CO Info from the Intemet
mail address ¢ uired for CODB accsss :

Ad ess Descii *

Get Sites

Default Ste l

(25

4. Enter a valid e-mail address in the Email address field and click [_& _]. CDDB is

configured.

Note: Users not wishing to sub an e-mail
address can simply select the Anonymous

checkbox.

Using CDDB

To access song information using CDDB:

1. Verify that the computer is connected to the Internet.

2. Place a CD in the CD drive and click the Play or Record Music CDs icon in the Explorer
panel. If Siren is configured to automatically retrieve CDDB information, it is accessed

and displayed. For more information, see Configuring CDDB on page 24.
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If Siren is not configured to automatically retrieve CDDB information, click @@, or
choose CD Info, followed by Get from the File menu.

Vol

Note: Once Siren retrieves information from
CDDB, it is saved to a local database.

Problems with CDDB Connections

Occasionally, users may experience problems connecting to CDDB. When experiencing
problems connecting to CDDB:

1. Choose Preferences from the Options menu. The Preferences dialog is displayed.

2. Select the CD Info tab.

3. Click [[G=si . A list of available CDDB sites is displayed.

4. Select assite and click & _]. Siren will connect to the new CDDB site when
prompted.

Submitting CDDB Information

Given the number of CDs released each year, it is inevitable that users will eventually
encounter a CD without CDDB information. When this happens, users can submit
information to CDDB, which is added to the database and made available for future users.

To submit CD information to CDDB:

1. Insert a CD for which CDDB has no information and click the Play or Record Music CDs
icon.

2. Manually enter the CD information. For more information, see Adding CD Information
Manually on page 27.

3. Click | %

'], or choose CD Info, followed by Submit from the File menu. Siren attempts to
connect to CDDB, and if successful, submits the user-provided information.

If CDDB submission is unsuccessful, the user will receive an e-mail notification.
Anonymous users, however, will not receive notification of submission problems.

Adding/Editing Song Information

Typically, Siren retrieves song information from a CD or local database and displays the
information in Siren’s Explorer panel. When this information is unavailable, Siren displays
generic song information. For example, when an audio CD containing no song information
is inserted, or a CDDB connection cannot be made, Siren simply lists the tracks numerically.
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Adding CD Information Manually

If Siren is unable to retrieve song information for a CD, information should be manually
entered before the song is recorded to the computer. Siren copies this information while
recording the audio.

To add CD information:

1. Place a CD in the CD drive. Siren alerts the user that CD information cannot be located
and lists the songs numerically.

2. Enter the appropriate information in the Album, Artist, and Genre fields.

3. Select a song.

4. Right-click on the selected song and choose Rename from the shortcut menu. An edit
field is displayed in place of the current song title.

5. Enter the new title and press [Enter]. Siren stores the information in a local database, and
retrieves it whenever the CD is inserted. In addition, this information remains with the
songs after they are recorded to the computer.

6. Repeat steps 3 through 5 until all desired songs are named.

Editing Song Information in Views and Playlists

'To manually add or edit song information, do one of the following:

® Select the song and edit the artist, album, or genre information in the Song Info panel.

~ ABum;[Mue Vanabons

® Select the song and click the area below the category column to be edited. Siren enters
edit mode. Enter the correct information followed by:

. to move one cell down

. +| Enter| to move one cell up

® [Tal] to move one cell to the right

® [Shift] +[Tad to move one cell to the right
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Name Aatist
J] Biosphere Trance international
4 Bizane U God
&) Black Leather Allthe Pretty Horses
J) Bieeding Simon V.
4 BoomBoom Babaloo
4] Boys_Life Fite Engine Red
J) Bralle My Lan
4 Bing the Noise anthiax and PE
Bryan Fety - Slave Ta Lave
d] BuinBaby, Bumn SKINNeR 13
J] Burring Down The House The Cardigans & Tom Jones
J] Buzz Fledderon Tom Waits
d] Callin The Shots Planet Asia
JJ] Camouflage Of Righteousness Little Steven
4

Album .
http://www.stargrass.com
Golden Arms Redemption

One Night

Leam.. Forget ..Re-Lean

SKiNNeR

Mule Variations
Callin The Shots 12"
Boin Again Savage

Gente

Hip-Hop

metal/rap

Rock
Other
Pop
Hip-Hop
Pop

* Select the song and choose Properties from the File menu. When the Properties dialog is

displayed, select the Song Info tab. Edit the song information and click [[_o&_].

“a P [ I 1. ?
General Song Info
Name:  Ballad of Ronnie
Btist: Flybussen
Abum:  AtLeast We're Not French
Genre:  expefimental v
GK C

Note: When artist, album, or genre

information is edited, the song is resorted in the
Manage My Music Library views. If the artist,
album, or genre information does not have an

existing category, Siren creates a new view

containing the song.
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Auto Rename Files Command

Users are able to rename linked music files based on the information retrieved from the local
music database. This feature changes a song’s filename to include available song
information, thereby making it more easily identifiable to users. When the Auto Rename
Files feature is used, Siren uses the following renaming format: artist-album-track-title.extension.
Using Auto Rename Files

To use the Auto Rename Files feature:

1. Select a song in the Manage My Music Library view.

2. Choose Auto Rename Files from the Edit menu. The file is renamed according to Siren’s
renaming format.

3. Click or press F5 to refresh the Manage My Music Library view.

,

Note: The Auto Rename Files command can
be used on several files simultaneously.

MP3 Files and ID3 Tags

ID3 Tags allow additional information, musical and otherwise, to be saved as part of an .mp3
file.

Saving an ID3 Tag

To save an ID3 tag with an .mp3 file:

1. Add or edit song information as desired. For more information, see Editing Song Information
in Views and Playlists on page 27.

2. From the Edit menu, choose Update ID3 Tags. The appropriate ID3 Tags are added or
edited.

When the song’s properties are viewed, the updated ID3 Tags are included in the
Properties dialog.

Custom Playlists

Siren allows users to create custom playlists from the music library. Playlists enable users to
store links to music located in a number of different views. Using this simple idea, users can
create playlists for parties, work, reading, etc., and since playlists use links to songs rather
than copies, a song can be included in multiple playlists without depleting hard drive space.
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Creating a Playlist

To create a playlist:

1. From the Manage My Music Library view, click the New Playlist button, or choose New

Playlist from the Edit menu. Siren creates a new playlist with a default name and displays

it beneath the My Playlists icon.

Library Manages

-3y My Music
@ AllMusic
@ By Album
O By Atist
@r By Genre
(r By Attist/By Album
@» By Genre/By Artist
(> By Bitrate/By Genre
I New View
(> By Last Played/By Length

& & My Plalists

easy afternoons
) jigay time

cool stuff

%] new stuff

) this rocks, man
simpsons

<8} Current Plaglist

2. Name the playlist and press [Enter].

Note: Change a playlist name by right-
clicking on it and choosing Rename from the

shortcut menu.

3. Add songs to the playlist using any of the following methods:

® Drag and drop songs from the music library to a playlist
¢ Select a song and choose Add to Playlist from the Edit menu
® Select a song and click Add to Playlist at the bottom of the Explorer panel

.

Vol

Note: When Add to Playlist is selected, Siren
prompts the user to specify the playlist to which

the song will be added.

N\

An Alternate Method of Creating a Playlist

To create a playlist:
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1. Select the song(s) to be added to the new playlist.

2. Choose Add to Playlist from the Edit menu, or click Add to Playlist at the bottom of the
Explorer panel.

3. Name the playlist.

Adding a Playlist

Once placed in a playlist, songs can be arranged using drag and drop.

Importing Playlists
To import a playlist:

1. Choose Search Computer for Music from the Options menu. The Search Computer for Music
dialog is displayed.

2. Select the Known Playlists checkbox and click . Siren searches the computer for
previously created playlists (.m3u or .pls) and adds them to the music library.

Exporting Playlists
To export a playlist:

1. Click the Manage My Music Library icon, or choose Manage My Music Library from the
View menu.

2. Select a playlist for export.

3. Right-click the mouse and choose Export Playlist from the menu. The Export Playlist dialog
is displayed.

4. Specify a location and name for the .m3u file and click [Tss 1.

Locking Views and Playlists

Once a view or playlist is created and configured to the user’s satisfaction, it can be locked to
prevent accidental deletion. To lock a view or play, right-click on it in the Explorer panel and
select Locked from the shortcut menu. A checkmark is displayed adjacent to the Locked
command and subsequent right-clicking on the locked view or playlist displays an
unavailable Delete option. To unlock a view or playlist, thereby allowing it to be deleted,
right-click on it and reselect Locked from the shortcut menu.

r

Note: A locked view or playlist can be
renamed.
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Clean Database

Siren’s Clean Database command, as one might expect, allows users to clear their music
database of deleted and duplicate file entries.
To clean the database:

1. Choose Clean Database from the Edit menu. The Clean Up Database dialog is displayed.

?T X
Peiform the following clesning functions:
Flias i - G e
elete duplicate fles found on yout system
Ask belore delsting itams
| Llean l Cancel l

2. Select the checkbox(es) corresponding to the desired option(s) and click [_ges_].

Clean Database Functions

Remove Entries to Deleted Files

Siren searches the music database for files that have been deleted from the computer and
removes their database entries.

Delete Duplicate Files Found On Your System

Siren searches the music database for duplicate files and deletes them, retaining a single
database entry for each file.

Ask Before Deleting ltems

Sirens prompts the user prior to deleting files or database entries.

Advanced Music Management

Siren features a number of database tools designed to allow users gain superior control over
their music libraries and listening habits. These include the Field Chooser, Sort Bar, Group Bar,
and Filter Bar.
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Field Chooser
EETere | The Field Chooser allows users to determine the database categories
Nane used to display, sort, group, and filter their music libraries.
Album
Genro Displaying the Field Chooser
Birate
. To display the Field Chooser, click @ in the database toolbar, or
e e right-click in the head row and choose Field Chooser from the
leon shortcut menu.
LasPla d
Flle Size Explorer Panel Fields
¥o!ume a
oar
Comm All fields listed in the Field Chooser can be displayed in the Explorer

panel. By default, Siren displays only the name, artist, album, and
genre information for a song.

Adding Fields to the Explorer Panel

To demonstrate adding fields to the Explorer panel:

1. Display any view or playlist.

2. Display the Field Chooser.

3. Click and hold the left mouse button on the desired field in the Field Chooser.
4

. Drag the field from the Field Chooser and drop it into the Explorer panel’s head row. When
the field is properly positioned, two small, red arrows appear above and below the head

TOW.
t = & =5
N ame B m. ate Afﬁst
Nazi Gitlfiend Bggy Pop
Hurt NIN + Bowie
The passenger lgagy Pop

After the field is dropped, a new field column is added to the head row and all songs in
the list display a value, if applicable.
Removing Fields from the Explorer Panel

To remove a field from the Explorer panel, right-click on the field to be removed, and choose
Remove This Column from the shortcut menu.
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Note: The fields displayed in the Explorer
panel have no effect on sorts, groupings, or
filters applied to the music library.

Editable and Non-Editable Fields

Select fields are populated with information retrieved directly from the music file, the CD,
or a local database, and this information may be permanent, or subject to editing. Other

fields rely on user input for their information. For more information, see Editing Song
Information in Views and Playlists on page 27.

The following table lists all available fields, and identifies each as either editable, or non-

editable.

Field
Added
Album
Artist
Bitrate

Comment
File Path

File Size

File Type

Genre
Icon

Last Played

Length
Name

Play Command

Played
Track

Volume Name

Year

Sort Bar

Status
Non-editable
Editable
Editable
Non-editable
Editable
Non-editable
Non-editable
Non-editable
Editable
Non-editable
Non-editable
Non-editable
Editable
Non-editable
Non-editable
Editable
Editable
Editable

The Sort Bar, which can be used from any Manage My Music Library view, allows all songs in
the music library to be listed, or sorted, by field(s). This feature is useful for ordering and
displaying the music library alphabetically (by artist, album, or song name), chronologically,

by date added, number of times played, or by any other available field.
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Displaying the Sort Bar

To display the Sort Bar, click [ #] in the database toolbar, or right-click in the database
toolbar and choose Show Sort Bar from the shortcut menu.

Creating a Sort
To demonstrate creating a sort:
1. Display the All Music view and the Sort Bar.

2. Drag a field (Artist in the case of this demonstration) from the Field Chooser or head row
and drop it in the Sort Bar. When the field is properly positioned, two small, red arrows
appear in the Sort Bar.

Arbist

The field is added to the Sort Bar with a small, up-pointing arrow, and all music library
artists are listed from A to Z.

o by Autist
ed Adtist -
Man Who Sold The World Wed Jan 12 09:10 34 2000 10 354 David Bowie
Under Pressure Tue Jan 11 09.54.44 2000 9 4:01 David Bowie & Que
Punk Rock Gl Thu Feb 03 08:44:01 2000 3 2:37 Dead Milkmen
Deadbolt-Macombos_Revenge ‘WedJan 12 09:10:34 2000 3:02 Deadbolt

3. Click the Artist field button in the Sort Bar. The arrow turns down and the sort reverses
directions; listing all library artists from Z to A.

Travelin' Prayer FnJdan 21 10:36:38 2000 1 4:16 Parton, Dolly
Train, Train FnJdan 21 10:38:13 2000 1 2:50 Parton, Dolly

Pink Moon Mon Jan 17 03:07-31 2000 8 2:04 Nick Drake

Hip Hop Hooray Mon Jan 17 09:09:05 2000 7 4:27 Naughty by Nature

Ve

Note: Clicking a field bar in the head row
automatically adds it to the Sort Bar.
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Multiple Field Sorts

Sorts may be comprised of several fields. Using the previous procedure, users can add
additional sort fields. Continuing with the previous example, adding the Name field to the
Sort Bar will list each artist’s songs alphabetically with the initial sort.

Fields in the Sort Bar can be arranged by dragging and dropping, with the left-most field
being the primary sort.
Removing Fields from a Sort

To remove a field from the Sort Bar, right-click on the field and choose Remove This Sort from
the shortcut menu.

To remove all fields from the Sort Bar, right-click on a field and choose Remove All Sorts from
the shortcut menu.
Saving a Sort

To save a sort as a new view:

1. Click [E] in the database toolbar, or right-click in the database toolbar and choose Make
New View from the shortcut menu. A new view with a default name is created.

2. Enter a name for the new view and press [Enter].

Group Bar

The Group Bar, which can be used in any Manage My Music Library view, groups all songs in the
music library by field(s). This feature is useful for creating simple or complex groups of songs.
For example, grouping by genre allows the user to quickly identify all free jazz songs in the
music library. A multi-level grouping will allow users to easily identify song groupings as
elaborate as all 1997 death-metal .mp3 files with 128kbs bitrates added to the music library
on January 11, 2000.

Displaying the Group Bar

To display the Group Bar, click in the database toolbar, or right-click in the database
toolbar and choose Show Group Bar from the shortcut menu.

Creating a Grouping

To demonstrate creating a group:

1. Display the All Music view and the Group Bar.

2. Drag the Bitrate field from the Field Chooser or head row and drop it into the Group Bar. All
songs in the music library are grouped and displayed by bitrate.
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Bitrate

Name Added Atist Album
Bitrate: 32 {1 tems)
Bitrate: 56 {6 ttems])
Bitrate: 64 {7 items
Bitate: 98 (57 tems
Bitrate: 112 Kbps  iteme
Bitrate: 128 Kbps 205 Rems}
+ Bitrate: 60 s 18items
+ Bitiate: 192 Kbps 9 items
+ Bitrate: 256 Kbps (1 tems)

* + o+

3. Drag the Genre field from the Field Chooser or head row and drop it in the Group Bar. All
songs are sorted by bitrate, and sub-sorted by genre.

Bitrate Genre

Nama Added Artist Al
+ Bitrate; 32 {1 tems)
+ Bitrate: 56 Kbps,  iterns)
+ Bitrate: _ {2 tems
+ Bitiate 96 Kbps (57 tems
+ Bitrate: 112 Kbps 3 items
Bitrate: 128 Kbps (205 items)
+ Bitrate: 160 Kbps 8 items)
- Bitiate: 92 Rems)
+ Genra: | op(3iems
+ Gemre: Acoustic  Rems
Gerve; Unknown 5items
+ Bitrate: 256 Kbps = Rems

Using this procedure, users can add additional fields. Fields in the Group Bar can be
arranged by dragging and dropping, with the left-most field being the primary grouping.

Removing Fields from a Grouping

To remove a field from the Group Bar, right-click on the field and choose Remove This Grouping
from the shortcut menu.

To remove all fields from the Group Bar, right-click on a field and choose Remove All Groupings
from the shortcut menu.

Saving a Grouping

To save a grouping as a new view, click [&] in the database toolbar, or right-click in the
database toolbar and choose Make New View from the shortcut menu. A new view, with a
name based on the grouping field order, is created and displayed.
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Filter Bar

The Filter Bar, which can be used in any Manage My Music Library view, allows users to select,
or filter, songs fitting user-specified criteria. Whereas the Group Bar allows users to group
songs by field, the Filter Bar is more flexible, enabling users to apply comparative values or
ranges to determine which song meet their criteria, regardless of how specific. For example,
all songs between four and five minutes in length. Using Siren’s filter capabilities, users can
quickly isolate all library songs recorded between 1970 and 1980 that are longer than ten
minutes, have the word booty in the title, and have been played more than 25 times, but
haven'’t been played since January 1, 2000.

Displaying the Filter Bar

To display the Filter Bar, click in the database toolbar, or right-click in the database
toolbar and choose Show Filter Bar from the shortcut menu.

Creating a Filter
To demonstrate creating a filter:
1. Display the All Music view and the Filter Bar.

2. Drag the Played field from the Field Chooser or head row and drop it in the Filter Bar. The
Played field is added to the Filter Bar with a corresponding drop-down list and edit field.

Played I equals E_"

3. Specify less than in the drop-down list.

4. Enter 5 in the edit field.
5. Press [Enter], click in the database toolbar, or right-click in the Filter Bar and choose

Apply Filter from the shortcut menu. The filter is applied and only songs from the music
library that have been played 5 times or less are listed.

ThuJan 06 15:21:31 2000

Amphibian Thu Jan 06 15:21:31 2000 2 4:36 Bjork
Full Crescent Crusade Thu Jan 06 15:21:31 2000 3 559 Antarctica
Luna / Dear Diary ThuJan 06 15:21:31 2000 3 4:06 Various Artists

Adding a Second Filter
To add a second filter:
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1. Drag the Bitrate field from the Field Chooser or head row and drop it in the Filter Bar. The
Bitrate field is added under the Played filter with a corresponding drop-down list and edit
field.

2. Specify equals from the drop-down list.
3. Enter 128 kbs in the edit field.

4. Press [Enter], click in the database toolbar, or right-click in the Filter Bar and choose
Apply Filter from the shortcut menu. The second filter is applied and only songs from the
music library that have been played less than 5 times or less, and have bitrates of 128kbs

are listed.
P! less than :_H5
Bitrate equals >]l12Bkbs
Name Added Bitr -
Lawyers, Guns and Money Wed Jan 12 09:10:34 2000 5 12B Kbps
Rollins Band - Four Sticks Wed Jan 12 09:10:34 2000 12B Kbps
David Bowie - China Gir! Wed Jan 12 03:10:34 2000 1 128 Kbps
The End Of Life In America, An Wed Jan 12 03:10:34 2000 5 128 Kbps
— 4
Note: Fields in the Filter Bar cannot be re-
arranged.
o

Added and Last Played Field Values

Siren allows all views and playlists to be filtered using two different date fields, Added and
Last Played. Since there are countless ways to create a date value, Siren’s database features
have been designed with maximum flexibility. What follows is a partial list of valid date

values:
yesterday today tomorrow
last week next week x days ago
x weeks ago x months ago X years ago
x hours ago month last year month x years ago
day last week day x weeks ago month date
month date year month (abbr.) date year

Removing Fields from a Filter

To remove a field from the Filter Bar, right-click on the field and choose Remove This Filter
from the shortcut menu.
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To remove all fields from the Filter Bar, right-click on a field and choose Remove Al Filters
from the shortcut menu.

Refreshing a View

After a filter is removed, the view can be updated, or refreshed, by clicking the Refresh
button, located between the Show Filter Bar and Apply Filter buttons.

g

2] =5 {——Apply Filter
L——— Refresh

Display Filter Bar

Saving a Filter

To save a filter as a new playlist:

1. Click |E| in the database toolbar, or right-click in the database toolbar and choose Make
New View from the shortcut menu. A new playlist, with a default name, is created and
displayed in the Manage My Music Library view.

2. Enter a name for the new playlist and press [Enter].

Combining Sorts, Groups, and Filters

As described previously, sorts, groups, and filters can be used independently of each other.
However, Siren’s music organization power can be further exploited by using these functions
in conjunction with each other. For example, users can quickly configure Siren to group
songs by bitrate and genre, sort by length and file type, and filter by date added and number

of times played. Combining these features allows users to find the perfect song for any
situation.

Vs

Note: When database features are combined,

they are always applied in Group-Sort-Filter
order.
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CHAPTER

Playing and
Recording Music

Playing Music Files with SIREN Jukebox

Once music is added to the music library, it can be played-back from any My Music view or
custom playlist. In addition, Siren will play most .wav, .mp3, and .wma files from the
computer or a network drive.

The Current Playlist

Regardless of whether it is playing from a CD, a music view, a custom playlist, or a network
location, Siren always performs playback using the songs and sequence displayed in the
Current Playlist. Siren generates a Current Playlist each time the user selects a song for playback
from any of Siren’s available sources. To view a Current Playlist:

1. Click the Manage My Music Library icon in the Navigator panel.
2. Select the All Music icon.

3. Select any song in the All Music view and initiate playback.

) My Music : e

: g By Album (i SeanMaMa 307 Thu Fek 17 06:53:20 2000

.+ {O® ByAdist Mary Lou Lord 2:55 Thu Feb 17 06:53:20 2000 4
. {fI» By Genre The Unhappy Song John Doe 3:00 Thu Feb 17 06:53:20 2000
L (b By Artist/By Album H{ Willow Weep For Me Dos 2:26 Thu Feb 17 06:53:20 2000
" (Im By Gerve/By Artist A Weekend With Onni Luftmensch 3:04 ThuFeb 17 06:53:20 2000
{fr By Bitrate/By Genre Unbreakable You Nuzzle 3:11 ThuFeb 17 06:53:20 2000
i - (@ NewView Flybussen 258 Thu Feb 17 06:53:20 2000
E]-@ My Playlists Iggy Pop 1:19 ThuFeb 17 06:53:20 2000
;b 4] easy aftemoons Minot Switchman Vantage Canada 4:36 ThuFeb 17 06:53:20 2000
4] jigay tme Sangria Cloud Car 2:54 Tue Feb 15 07:43:45 2000

coo! stuff - “An T r 1 AraTan e anna hd
-4 new stuff : ¥ %I

4. Select the Current Playlist icon, which is located at the bottom on the Explorer tree.
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Libraty Manager
i @r By Artist/By Album -
I (@ By Gerve/By Artist
! (@ By Bitrate/By Genre
! b New View
é:- ) My Playiists
! L&) easy afterncons
> nggy time
X) cool stuff
1) new stuff
2] this iocks, man
4] simpsons
';i New Plaglist

i ‘@] flnrerﬂi’laylrﬂ

e fuloleledntelelsteg

B w @y

Name..

; Marilyn Manson - The Last Tour OnEa...
"Marilyn Manson & Rasputina - Transylv...

Slow To The Cote

-“Princess and the Pon

Martian Saints

' The Unhappy Song

Willow Weep For Me
. AWeekend With Onni
Unbreakable You

" Thiee ‘Way Bobaloo

§

Descii ‘on -~
C:\My Music\Marilyn Manson - The Last Tour On Earth (Bonus CD) - (1
C:\My Music\Matilyn Manson & Rasputina - Transylvanian Concubine.
C:\My Music\Sean_Na_Na-Slow_To_The_Core.mp3
C:\M Music\PrincessandthePon m 3

C:\My Music\MartianS aints.mp3

C:\My Music\TheUnhappySong.mp3

C:\My Music\WillowweepForMe.mp3

C:\My Music\Rad180.mp3

C:\My Music\Nuzzle-Unbreakable_You.mp3

C:\My Music\T heTroubleWithPublicPlaces.mp3

C-AMu MicieAlann Aann - ~randin mn?

Ny

Notice that the current song is highlighted, and the preceding and following songs are
indicated. For more information, see Play in Order versus Play Randomized on page 43.

Instant Current Playlists

Siren generates a Current Playlist whenever the user specifies a folder, CD, view, or even a

single song for playback.

Folders and CDs

When a network folder, computer folder, or CD is selected for playback, its contents
automatically become the Current Playlist. The playback sequence can be as originally
arranged, or randomized. For more information, see Play in Order versus Play Randomized on

page 43.
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Music Library

Current Playlists generated from the music library are more involved than those generated
from folders and CDs. The following table describes Siren’s Current Playlist generation based
on user action and the source of the music files. Again, the playback sequence can be as
originally arranged in the music library view, or randomized. For more information, see Play in
Order versus Play Randomized on page 43.

User Action Resulting Current Playlist

Select a view from the Explorer panel tree Entire content of view is placed in Current
Playlist.
Playback begins with the first song in the
view.

Select a single song Entire content of view is placed in Current
Playlist.

Playback begins with the selected song.

Select a group of songs Only selected songs are placed in Current
Playlist.

Playback begins with the first song
selected.

Select song from multi-category view Only songs located in selected branch are
placed in Current Playlist.

Playback begins with selected song.

Play in Order versus Play Randomized

When playing music from any source, users can specify whether the Current Playlist is
generated using the original order, or with a random order, by clicking the playback toggle
button in the Transport panel.

o When [ is displayed, songs are played-back in the listed order
e When is displayed, song are played-back in a random order
Play Once versus Continuous Play

Like the previous feature, users are able to specify whether Current Playlist playback occurs
once, or is looped infinitely by clicking the appropriate toggle button in the Transport panel.

e When is displayed, playback is halted once the CD or playlist is complete
e When is displayed, playback continues infinitely (looped)

Playing Music from a My Music View

To play music from a Manage My Music Library view:
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1. Display the contents of the music library by clicking on the Manage My Music Library icon
in the Navigator panel, or by choosing Manage My Music Library from the View menu.

2. Click the All Music view. Siren lists all songs in the music library.

o EL L I e
y Muse .
@ AbMutc amo Added A
D By Abum Condy logy Poo 119 ThuFeb 170653202000  f
D> By At Unbreakablo You Nuzde 311 ThuFeb 17 06:52:20 2000
(@ By Gerve AWeekend With Ore Luitmensch 304 ThuFeb 17 06:53:20 2000
(@ By Ast/By Album Slow To The Cote SeanNaNa 514 Thu Feb 17 06:53:20 2000
@ By Gorvo/By Ast Princets and tho Pony SeenNaNa 307 ThuFeb 17 06:53.20 2000
(» By Birote/By Gerve Minot Swichman Ventage Cansda 438 ThuFeb 17 06:5320 2000
(T NewView Thioe-way Babaloo Fibussen 116 Tue Feb 15 07:43.45 2000
(B ByLast Plaged/By Length  The Omen DMX w/Marbn Manson 456 Tue Feb 1507:43:45 2000
- B My Plagints Senpia Cloud Cor 254 Tue Feb 15 07.42 45 2000
oaty sftomoons Intane In The Membrane Cypress HA 332 Tue Feb 15 074345 2000
u] gy tema Real Thing Cypross HALL Pead Jam 330 Tue Feb 15 074345 2000
d] cool stut Home-made Thengs Cloud Car 213 TuoFeb 1507.4345 2000
I’:‘*’;‘:" o Nowheso to Run CiystelMethod, 022y Ozbow.. 453 Tuo Feb 15 07.43.45 2000
Dt Groersthumb Cypress Hil 424 Tuo Feb 15 07:43.45 2000
5 m o Cypress Hl - Tequla Suvre (Exphc] 443 Tua Feb 15 07:43.45 2008
,&] Current Plagkst Cyprerss Hil - Scooby Doo 333 TuaFeb 15 07:43.45 2000 —I:I
L) »

3. Click  on the Transport panel. Siren generates a Current Playlist, begins playing the first
song, and continues through the entire view. To begin playback with an alternate track,
double-click the track, or highlight it and click .

Playing Music from Other Views

To playback music from another of Siren’s views:

1. Display the contents of the music library by clicking on the Manage My Music Library icon
in the Navigator panel, or by choosing Manage My Music Library from the View menu.

2. Select the desired view. All music from the view is sorted and displayed in appropriate
branches.

1 (@ By Genve/By Artist
¢ (p: By Biuste/By Gerve 1 Aytiet"anthva and PE {T-Rema)
v U New View {51 Arist: apollo 44D (2 Rems]
@ By Lost Played/By Length  F¥T'Arkz: Apolloddl (1 e5s)
- B My Plagists ATASE Astoneu, WIS 2 0678}
easy altemoons ATAGEA The Biivel {1 koms)
ﬁ»] o time A% Adht Bobalot 5 Botih)
'-’J cool stlf 4 bk Bahaus (T e
i ;‘:‘u 31 Adht B Purisher (1 {3453 3
ris racks, men 3 Aubet: Blg Pmishes ENGIBaG (1 Reves)
] e P e B
i) Coment Plaist L8

Kl By

3. Click the desired branch. Siren displays all songs in the branch.
Vel

Note: Depending upon the complexity of the

view, it may be necessary to click through

several layers of branches before locating song
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listings.

-

4. Select a song and click » on the Transport panel, or double-click it to begin playback.
Siren generates a Current Playlist and plays only the songs located in the specified branch.

Playing Music from a Custom Playlist

As discussed previously, Siren will instantly generate a Current Playlist to allow users to
immediately begin listening to music from the music library, a CD, or a network folder/drive.
In addition, Siren also allows users to create custom playlists to satisfy individual tastes or
requirements. To playback music from a playlist:

1. Display the music library by clicking the Manage My Music Library icon in the Navigator
panel or by choosing Manage My Music Library from the View menu.

2. Double-click the My Playlists icon in the Library Manager to display all playlists.
3. Select the desired playlist. The playlist’s songs are listed.

4. Click & on the Transport panel. Siren begins playing the first song in the list and
continues through the playlist. To begin playback with an alternate track, double-click
the track, or select it and click & .

For more information, see Custom Playlists on page 29.

Using the Play Command Field

The Play Command field allows users to initiate playback from a view or playlist with a single
mouse click. To use the Play Command field:

1. Display any view or playlist.
2. Display the Field Chooser. For more information, see Field Chooser on page 33.

3. Drag the Play Command field from the Field Chooser, and drop it into the Explorer panel’s
head row. A Play Command column () is added to the Explorer panel.

4. Left-click in the Play Command column. Playback begins with the adjacent song and
continues through the view or playlist.

Ve

Note: The Play Command field is displayed by
default in the Gurrent Playlist.
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Playing Music from the Computer or a Drive Location

While music is typically played from the music library or a CD, Siren can also play music
from a folder on the computer, or from a network drive. In addition, links to these files can
be created in the Manage My Music Library view for easy accessibility.

P
Note: Secured .wma files cannot be played
from a network drive. However, .wav and

.mp3 files can be played or copied from a

network location.

.

To play music from the computer or a network drive:

1. Click the Explore My Files icon in the Navigator panel to view all drives and folders in the
Explorer panel.

2. Navigate to the file containing the music to be played.

3. Click ». Siren creates a Current Playlist and begins playback with the first song in the list.

To begin playback with a different track, double-click the track, or highlight it and click
B.

Adding Music From the Computer or Network to My Music

To add files to the Manage My Music Library view from folders on the computer or a network
drive, do one of the following:

¢ Choose Search Computer for Music from the Options menu.

¢ Click the Explore My Files icon, right-click on the desired folder, and choose Search for
Music from the shortcut menu.

If music located on a network drive is linked to a Manage My Music Library view, it is available
only when the computer is connected to that drive.

Identifying Network Music

As stated previously, music located on a network drive is only available when the computer
is connected to the network. Attempting to play music from a network when the computer
is disconnected produces an error message. To avoid error messages when the computer is

disconnected from the network, simply apply a filter using the File Path field, and specify only

songs located at the system’s hard drive address (typically C:). For more information, see Filter
Bar on page 38.
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Playing CDs

Siren will play audio CDs from the computer’s CD-ROM drive. Use Siren’s Transport panel or
the Transport menu to control CD playback.

CD Autoplay

If Siren and the system are configured to play CDs automatically, Siren initiates CD
playback when a CD is inserted.

Configuring Siren Autoplay
To configure Siren’s CD Autoplay feature:

1. Choose Configuration Wizard from the Options menu. The Welcome to the Configuration
Wizard dialog is displayed.

2. Click until the Set Default Player dialog is displayed.
3. Select the Set as the default player when audio CD is inserted checkbox and click [_Frsh_].

Set Default Player ‘

Setting Sonic Foundxy SIREN Jukebox as your default player

(recomnendad] omalically play your selection when you
downlaad amusic fils,
If pou have autcinsest notification enabled this is the Windows

defautt satting}, SonnFoundr%qIREN Jukebox will start playing
the first rack when you inseit’an audio CD into the drive.

Set as the default for WA files
V' Set as the default player o7 MP3 fles
Set as the default player for WAY

VQEet as the default player when audio CD is inserted

< Back Finish €

The user is alerted that the configuration is complete.

g
@ The Configuration Wizard s, -

=

4. Click [0, Siren’s Autoplay feature is configured.
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L
Note: If Siven still does not automatically play
CD:s, and the system is running Windows 9x,
the system’s Autoplay feature must be
configured.

.

Configuring System Autoplay (Windows 9x only)

To configure the system to automatically play CDs:

1. Choose Settings, then Control Panel from the menu.
2. Double-click the System icon.

3. Select the Device Manager tab.

4. Click the appropriate [ to display the system’s CD-ROM drive(s).
5. Select the desired CD-ROM drive and click [ Pioveties |.
6. Select the Settings tab.

7. Select the Auto insert notification checkbox and click [Z8kJ. The system’s Autoplay
feature is configured.

Playing CDs Without Autoplay

If the system is not configured to play CDs automatically, or to play a CD currently in the
CD-ROM drive:

1. Click the Play or Record Music CDs icon in Siren’s Navigator panel. The Explorer panel

displays the available tracks and Siren attempts to retrieve and display CD information
from local databases, or from the CD itself.

If this information is not available, the songs are listed numerically. Users may attempt to
retrieve CD information from the Internet using CDDB. For more information, see
Compact Disc Database on page 24.

2. Click » on the Transport panel. Siren makes the CDs content the Current Playlist, and plays
the entire CD, starting with the first track. To begin playback with an alternate track,
double-click the track, or highlight it and click &.
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Siren is able to record songs from a CD, place the files in a user-specified location, and create
links to those files in the Manage My Music Library view. In addition, users can listen to music
from the music library while recording CDs to the computer. However, it is not possible to
listen to a CD while recording it to the computer. In addition, while tracks can be recorded
from a previously created custom CD, these tracks cannot be written to another CD.

Selecting the Music Files View

As mentioned previously, users must specify the system folder for music storage. To specify

the music files folder:

1. From the Options menu, choose Preferences. The Preferences dialog is displayed.

2. Select the General tab.

Preferences

Genetal Recaiding CD Info CD Settings  Securiy |
v {Use sound card lo play back audio from CDg
v Use {ntemnal Browser
¥ Download music files directly to music files foldes

Music files folder;
C:\My Music\

Free storage space in folder 766G bytes

Music fibrasp and playfist database folder;
C:A\My Music\

Fres storiage space in folder: 7.6:Gigabytes

EE3|

Browss...

Brgwss... !

3. Enter the path to the folder in the Music files folder field and click

location is updated.

Specifying the Record Format

K&&]. The folder

Users are able to record tracks to the computer in .mp3 or .wma format. To specify the record

format:

1. Choose Preferences from the Options menu. The Preferences dialog is displayed.

2. Select the Recording tab.

3. Specify the record format from the Record to Library format drop-down list.

CHP.5
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Gienersl Recarding CD Info ] CD Settings  Secuiity |

Record to Library format: IMPEG Layer 3 Audio (MP3) :_I
Biuate Record to Library format:  MPEG Layer 3 Audio (MP3) -
96 Kbps 'S b £ ;
160 Kbps MPEG Layer 3 Audio (MP3]
192 Kbps .
256 Kbps 70500 103 MB per CD
320 Kbps 56.0CD's 137 MB per CD
MP3 Quaity: Medium
I~ MP3YBR Qualty: 1 qan

cot

Siren displays the available recording bitrates.

4. Select the recording bitrate. For more information, see Recording Bitrates on page 50.

Bitrate uali Level Limit Di ace

96 Kbps 187.4CD's 41 MB per CD
160 Kbps 113.0CD's 68 MB per CD
192 Kbps 93.7CD's 82 MB per CD
256 Kbps . 70.5CD's 109 MB per CD
320 Kbps 56.0CD's 137 MB per CD

5. If encoding to .mp3, use the MP3 Quality slider to select the recording quality.

e Setting to Fastest Encode (far left) records files as quickly as possible.
® Setting to Highest Quality (far right) records files with the highest possible audio quality.

MP3 Quality: Medium

6. If desired, select the MP3VBR Quality checkbox and use the corresponding slider to set the
encoding sensitivity value. For more information, see MP3VBR Quality on page 51.

7. Click [__## _]. The configuration is saved.

Recording Bitrates

Available recording bitrates vary based on the recording format. The Windows Media Audio
(.wma) format offers 64, 96, 128, and 160kbps. Conversely, selecting the MPEG Layer 3

Audio (.mp3) format allows the user to specify from the following bitrates: 96, 128, 160,
192, 256 or 320kbps.
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Siren XPress users are limited to 64 and 96kbps bitrate in the .wma format, and twenty .mp3
encodes.

MP3VBR Quality

Variable bitrate (VBR) is an encoding method available only when recording to .mp3. The
bitrate is automatically adjusted during recording, resulting in higher quality audio and
smaller file sizes.

Recording from CD to the Computer

To record music from CD to the computer:
1. Place an audio CD in the system’s CD-ROM drive.

2. Click the Play or Record Music CDs icon in the Navigator panel. The CD’s tracks and
database information are displayed.

-

Note: If the system has multiple CD drives,
users must specify the appropriate drive to

display the track listing and database

information.

.

3. If the track information is not displayed, access CDDB or add this information manually.
For more information, see CD Information on page 23.

,r

Note: If track information is not displayed or
added, Siren records all songs as unknown and
numbers them sequentially.

N\

4. Select the track(s) to be recorded and click Record to Library from the Explorer menu
command bar, or choose Record to Library from the File menu.
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Atut' Robes Dend Ao oght Gerver Unknown L
D EIDE CO AOM 50X 11D} - o % .
Tibek s L

1 02 Fool 00045955 3 “wamp

B 0)lcon 00.0326.15 37 34

@35, 43

Siren records the song(s) to the music files folder and a progress meter is displayed in the
Status panel. To halt recording, click Cancel.

293¢
to

Monitoring the Recording Process

To monitor the recording progress, specify Recording List from the Explorer toolbar drop-
down list.

E-IDE CD-ROM 5011 (D)

00 20 41.23 : 43,32

00:41:51.57 00:05:1353 528MB
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CHAPTER
Creating CDs
Once music is in the music library, users can create custom CDs using a supported CD writer.

Custom CDs can be constructed using personal CD tracks along with .wav, .mp3, and .wma
files recorded or downloaded from the Internet.

,

Note: .Wma files may only be written to a
custom CD if the file includes a flag permitting
the file to be written to CD.

.
In accordance with copyright law, users may create a personal copy of copyrighted material.
This allows users to record music from personal CDs to the computer, and use that music to
create a custom CD of that music. However, users may not copy a custom CD or record its
music to another computer.
Configuring SIREN Jukebox to Write Custom CDs

To configure Siren to write custom CDs:

1. Choose Preferences from the Options menu. The Preferences dialog is displayed.

2. Select the CD Settings tab.
3. Specify the connected CD-R drive from the Write to CD drive drop-down list.
4. Set an appropriate Write to CD speed for the drive and click [[C88_].

Creating Custom CDs
To create a custom CD:

1. Verify that Siren is properly configured to create CDs. For more information, see
Configuring SIREN Jukebox to Write Custom CDs on page 53.
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2. Verify that the supported CD writer (CD-R or CD-RW) is connected to the computer.
3. In the Explorer panel, select the song(s) to be written to the CD.

4. Click Write to CD in the Explorer panel’s command bar or choose Write to CD from the File
menu. The Create CD dialog is displayed.

Create CD K E3

Add the audio to the CD in the CD recorder.

Clase the disc so it can be used in an audio
W CD plaper. (Na more tracks may be added to

the disc after closing.)
Cancel
Time needed for audio: 59 minute(s] 25 second(s) ————]
Time available on disc: 74 minute(s) 50 secondis}

The Create CD dialog contains two very important values.

® The Time needed for audio value indicates the total time of the selected song(s).
® The Time available on disc value indicates the space remaining on the CD.

Ve

Note: The user will be alerted if the selected

song(s) require more space than the amount
remaining on the CD.

N

di%udo . Siren begins writing the selected music to the CD and the Create CD
dialog displays the progress and time remaining.

) 7T X%

Addthe audic  the CD in the CD recorder. L_____—l

Close the disc so it can be used in an audio
N CD player. [No mote tracks may be added to

the disc after dlosing.)
Wi of
g brack 1 of 15
4% Cancel
E stimated me’left: 15 Minutes 29 Seconds ‘Wiite Bulfer.
- re

Note: Sonic Foundry recommends allowing
Siren to complete this operation. Clicking
Cancel, may render the CD unusable.

CUSTOM CDS CHP. 6

BHM Ex. 2007



(55
6. When Siren finishes adding the selected song(s), it displays a message declaring that the

operation was successful. Click [[Z8_].

If any error messages are displayed during CD writing, refer to Siren’s online help.

Use this method to write additional songs to the CD. The CD can be removed from the
drive and inserted in the future to continue adding songs, because the CD remains at the
current position and each song appends to it. When the custom CD is complete or full, it
must be closed. For more information, see Closing the CD Session on page S6.
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Closing the CD Session

Once all desired songs are written to a custom CD, the CD session must be closed. Closing a

CD allows it to be played in consumer CD players. Once a CD is closed, new songs can no
longer be added.

To close a CD session:

1. If it is not currently displayed, open the Create CD dialog by choosing Close CD Session
from the File menu.

2. Click bec )] Siren begins closing the CD and the Create CD dialog displays the progress

and time remaining.

Create CD E7]iX]

Add the audio to the €D in the CD recorder,

Close the disc so it can be used in an audio
CD player. (No more kracks may be added to
the disc after closing.)

Closing Session

- TR Carcel

Estimated tme left: 1 Minute 45 Seconde

3. When Siren completes the closing process, it displays a message declaring that the

If any error messages are displayed during CD writing, refer to Siren’s online help.
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Downloading
7 Music to a
Portable Player

Sending Music to a Portable Player

Siren is able to download .mp3 files to a portable player, as well as manage files once they are
placed in the player’s memory. However, Siren’s portable player features are available only
for Windows 95 and 98 operating systems.

Siren downloads music to portable players in one of two ways:

® Songs are selected from the Explorer panel, and downloaded using the Send to Portable
Player command. For more information, see Selecting Songs from the Explover Window on page
57.

® Songs are selected and downloaded while managing the player. For more information, see
Downloading Music while Managing the Portable Player on page 59.

,

Note: Windows and dialogs pictured in this
chapter are examples only. Screens and options
vary based on the player.

.

Selecting Songs from the Explorer Window

To select songs for download from the Explorer panel:

1. Verify that the portable player is properly connected to the computer as described in the
player’s documentation.

2. In the Explorer panel, select the .mp3 file(s) to be downloaded to the portable player.

CHP.7
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3. Click Send to Portable Player in the Explorer panel’s command bar, or choose Send to
Portable Player from the File menu. The Portable Player Manager dialog is displayed.

Pontable Player Manager ¥ B3

Portable Player(s)

Diamond Multimedia & RioPort com Rio PMP500

|

¥ Automatically detect when Rios are connected.

_ G |

2 file(s] totaling 10.16MB have been selected to send.

All connected portable players are displayed in the Portable Player Manager dialog,
however, if the player is turned off, its icon is inactive (crossed-out).

,

Note: If the player has a battery save feature,
and is idle for an extended period of time, it
may display as inactive even if properly
connected and previously on.

.

4. Click [ appropriate to the desired portable player. The content of the player’s internal
memory, and any removable memory cards, is displayed.

x

Portable Player(s)

~ ** Diamond Multmedia & RioPort com Rio PMP300
Irternal Flash kemor (22,7408 Free/32. 7 7B Tctal)

?
Send...
K Diamond Multmedia & RioPort.com Rio PMP500 {eitialize i
Close
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5. Select the memory, or folder, to which the selected music will be added. For more
information, see Folders on page 59.

6. Click s The Portable Player Manager dialog displays the download progress of each
song.

Pantable Player Manager

R NEER R (e

Sending ‘Cypress Hill] - Dr Gresnthumb.mp3'.. {1 of 2)

Ve

Note: Sonic Foundry recommends allowing
Siren to complete this operation. Clicking
Cancel may leave the portable player in an
unknown state.

N,

Once all selected songs are downloaded, the Portable Player Manager dialog closes and
Siren’s main screen is displayed. To manage songs in the player’s memory, choose Manage
Portable Player from the File menu. For more information, see Managing the Portable Player
on page 61.

Folders
Select portable player models support folders. If the connected player supports this feature,

the button is active in the Portable Player Manager dialog. For more information
about folders, refer to online help.

Downloading Music while Managing the Portable Player

To download music while managing the portable player:

1. Choose Manage Portable Player from the File menu. The Portable Player Manager dialog is
displayed.

2. Click [__s=d_]. The Open dialog is displayed.
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3. Select the system folder containing the song(s) to be downloaded.
4. Select the song(s) to download.

L

Note: To select multiple songs, use [ctri]-click.

.

Look jn:  §z)l My Music v ;@_l _@_l -d(_'

innagoddadavvidajam.mp3
James_Combs-One_Hand_Clapping mp3
James_Combs-You_Just_Brng_The_Diugs.mp3

Joe_Stiummer_and_the_Mescaleros_-_Rock_Ar___the_X-Ray_Style-1-Tony_Ad.
joycel mp3

¢ . | i
File pame: lagy_Pop 02 Nazt gilfnend RNS mp3
Files of type:  MPEG-3 Audio Files( mp3) - Cancel 1%

5.Click e . The Portable Player Manager dialog displays the download progress of each

song.
P
e
(1] T

Sending iggy. Pop-02-Nazi_gitfriend ANS.mp3-.. {1 ob1)

L
|

Note: Sonic Foundry recommends allowing
Siren to complete this operation. Clicking

Cancel may leave the portable player in an
unknown state.
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After Siren downloads all selected songs, the Portable Player Manager dialog displays a list of
songs in the player.

Portable Player(s):
- Intemal Fla h Memory (1.38MB Free/32 77MB Total)

J] Cyptess Hill] - Dr Greenthumb (5.17MB)
J] Henry Rollins & Goldis - T-4 Strain (4.99M8)
J] Crystal Method, Ozzy Ozbourne, OI Duty Bastard, [
J] DMX- whats my name (5.44MB)
47 DMX Fea™ Marilyn Manson - The omen (5.79MB)
J] Iggy_Pop-02-Nazi_girlfriend-RNS (4.16MB)

x Diamond Multimedia & RioPort.com Rio PMP500

: 2

Automatically detect when Rios are connected.

L LL .

Glose

Managing the Portable Player

In addition to downloading .mp3 files to portable players, Siren can also manage files.
However, management options vary based on the make and model of the player.

To manage music in a portable player:

1. Verify that the portable player is properly connected to the computer, as described in the
player’s documentation.

2. Choose Manage Portable Player from the File menu. The Portable Player Manager dialog is
displayed, listing songs in the player’s memory.

Portable E!ayet(sl

& - Diamond Multimedia & RioPort.com Rio PMP300 Send...
= Interral Flash Memery (15.40ME Frae/32.77MB Total)

Cypress Hillf - Dr Greenthumb (5.17MB) Ipitiafze
. J] Henry Rolling & Goldie - T-4 Strain (4.99MB)
: J] lggy_Pop-02-Nazi_gilfriend-BNS (4.16MB) Delete
- -3 Diamond Multimedia & RioPart.com Rio PMP500
Bename
NewF"
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From this dialog, users are able to download .mp?3 files to the portable player, as well as
manage the .mp3 files stored in the player’s memory. Management options vary based on
the make and model of the portable player.

,

Note: For more information on portable
player management features, refer to Siren’s
online help.
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CHAPTER 2

How Does the Player Work?

In this chapter you'll learn how to operate Windows Media Player 7. You’ll
see how to play files, use the buttons to navigate, change the settings, use the
menus, and switch to different views and modes. You’ll also be shown how
to find files on the Internet, copy music from CDs, and use playlists.

Playing a file in only three steps

Playing music or video on the Player is a simple 1-2-3 process:
1. Go to the Now Playing view.
2. Pick a song from a playlist and click the song title.
3. Then click the Play button to begin playing.

The three'steps to playing a song are shown below in more detail.

Step 1: Start with the full mode Player

When you start Windows Media Player 7 for the first time, and you are con-
nected to the Internet, you should see the full mode Player in the Media
Guide view. Figure 2.1a shows a typical Media Guide view.

25
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EI 5 o owe, Mvithg PLige

6o to dowilopd.
It's o't

Figure 2.1a - Full mode Player in Media Guide view with Internet connection.
The Media Guide is a Web site that gives you a doorway into the world of

audio and video on thé Internet. The contents change nearly every day, giv-
ing you new audio and video selections, current entertainment news, and free

downloads.

If you are not connected to the Internet, you’ll see a screen similar to Figure
2.1b.
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You can now get started using Windows Media Player. Click Now Playing on
the left side of the full mode Player. You should see a view similar to Figure

2.2. :

Beautiful Way

Figure 2.2 — Windows Media Player in ﬁll mode in the Now Playing view.

If you don’t see something like Figure 2.2, you’re probably looking at a skin.
A skin may have been loaded by the last person to use the Player; you won’t
be able to see the Now Playing view when a skin is running. If you are view-
ing a skin, you will want to return to the full mode of Windows Media Player.

Windows Media Player comes in two modes: full mode and compact mode.
The compact mode is used to display skins, and the-full mode displays the
standard Player. To return to full mode from any skin, right-click anywhere
on the skin and then click Return to Full Mode on the shortcut menu that

appears.
The full mode has several different views it can display. Right now, all you
want to do is play a file, so click Now Playing at the left side of the full
mode Player. You should now see something that looks close to Figure 2.2.
You probably will have a different visualization or a different playlist loaded
on your computer, but you're ready to start. '

27
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Step 2: Choose a song

There are several ways to choose a file to play, but the easiest way is to use a
playlist. Playlists will be covered in greater detail later in this chapter, but to
get you started, use the playlist that should be visible on the right side of the
Now Playing view.

Figure 2.3 shows a Now Playing view with a playlist named “All Audio” that
contains all the songs that the Player has information about. The third song,
“Laure”, is selected and playing. You can double-click any item in the
playlist to start playing that item. | '

Figure 2.3 — A playlist with more than one item.

You can learn more about using playlists later in this chapter. There are other
ways to choose audio and video files as well, and they will also be covered
in this chapter. ]

Step 3: Click Play

Now that you’ve selected a song title, click the Play button. It looks like an
arrow that is pointing to the right. You can see it in Figure 2.4.
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Figure 2.4 — The Play button of the full mode Player.

When you click the Play button, two things happen. The music starts playing
and the button changes. The button now looks like Figure 2.5.

Figure 2.5 — The Pause button of the full mode Player.

This new button is the Pause button. Any time you want to stop the Player,
just click the Pause button. That will stop the music playing and change the
Pause button back to a Play button.

Using the navigation buttons

Windows Media Player has several other buttons you can use to enhance
your playing experience. The following buttons are always at the bottom of
the window in the full mode Player and are listed here from left to right:

¢ Play/Pause

e Stop

e Seek

e Mute

s Volume

e Previous

¢ Fast Reverse

¢ Fast Forward

o Next

e Switch to compact mode

If you hover over a button with the mouse pointer, the name of the button
will appear.
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Figure 2.6 shows the navigation buttons for the full mode Player. These but-
tons are also called transport buttons and use symbols that are common to the
electronic industry for controlling tape recorders, VCRs, and CD players.
You’ll often see the same button symbols in skins, but because every artist
designs skins his own way, and the artwork varies widely, you won’t neces-
sarily find all the same buttons in each skin, or the buttons may not be in the
same order.

Figure 2.6 — Navigation buttons.

Here is a brief explanation of each button.

Play/Pause
This button toggles back and forth between two states: Play and Pause.
Play starts the selected music or video playing, and Pause pauses it.
Clicking Play from a paused state will start the program playing from the
same position it was paused at.

Stop
This button stops a currently playing program. If you click Play after
clicking Stop, the program will start over at the beginning.

Seek
This is the long bar that extends above the other buttons. The Seek bar

shows the current position in the file. If you click and drag the tiny box,
you can change the current position in the file to anywhere you want.
The left end of the Seek bar represents the beginning of the file, and the
right end represents the end of the file. So the midpoint of the bar
represents the midpoint of the file, regardless of its length.

Mute
‘Click this to mute the sound of the currently playing file. Click it again to

return the sound to its previous volume.

‘ - Volume -
i This is a short triangular bar with a box above it. Click and drag the box
left or right to increase or decrease the volume of the sound.

i i (208
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Previous ‘
Click this to go to the previous title in a playlist.

Fast Reverse
Click this to move the current seek position of the file backward. Click it

again to start playing from the new seek position. This button only works
for video files that use the Windows Media video file format.

Fast Forward
Click this to move the current seek position of the file forward. Click it

again to start playing from the new seek position. This button only works
for video files that use the Windows Media video file format.

Next
Click this to go to the next title in the playlist.

Switch to compact mode
Use this to change the Player display to compact mode. This will change
the user interface to the default skin or the last skin you selected.

Watching visualizations

At the bottom of the left side of the Now Playing pane, you’ll see two but-
tons. Click these to change visualization presets. These buttons are shown in

Figure 2.7.

Figure 2.7 — Previous visualization and Next visualization preset buttons.

Visualizations draw moving shapes and colors on the screen that rise and fall
in time to the beat and tone of the music. Several visualizations are included
with Windows Media Player, and more are available from the Windows Me-
dia Player Visualizations Gallery. Click Download Visualizations on the

Tools menu to go there.

Each visualization has several presets. Each preset gives a different “flavor”
or “twist” to the visualization; for example, one preset might make all the
colors soft pastels and another preset would make them vivid primary colors.
You can change visualizations and presets by clicking the Previous visual-
ization and Next visualization buttons. The visualization and preset names
are displayed to the right of the buttons, with the visualization name first, and
the preset name following, separated by a colon.
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You won’t see a visualization if you’re playing a video, because they both
use the same display pane.

Changing other settings

There’s one other button that can be useful when playing audio and video. At
the top of the full mode Windows Media Player, just to the right of center,
you’ll see the Show Equalizer & Settings button that looks like Figure 2.8.

Figure 2.8 - Show/Hide Equalizer & Settings in Now Playing button.

Clicking this button will show a new pane in the Now Playing area that is
below the visualization/video pane. This pane covers several settings. To
move to a new setting, click the Previous setting or Next setting button.
s These buttons are shown in Figure 2.9.

i
|
| |
; I ; Figure 2.9 — Previous setting and Next setting buttons.
!

The following settings are accessed from this pane by clic:kingr the Previous
setting and Next setting buttons:

I ¢ SRS WOW Effects

E ¢ Graphic Equalizer

i ‘e Video Settings

| i e  Windows Media Information
o Captions

Here is a brief explanation of each setting.

SRS WOW Effects settings

This pane allows you to adjust the SRS WOW settings. SRS is a type of sur-
round sound that makes your audio sound more lifelike and three-dimen-
sional. You can see the SRS WOW Effects pane in Figure 2.10.
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Figure 2.10 — SRS WOW Effects pane.

On the right is the logo for SRS. Click it to find out more about SRS. On the

left are two horizontal sliders that adjust the TruBass and WOW Effect. Be-

tween the two sliders and the SRS logo are two buttons: the top turns SRS on
and off, and the bottom one toggles between various presets.

Here is a brief explanation of each button:

TruBass
Sliding this all the way to the right increases the bass enhancement of the

audio. Sliding to the left decreases it.

WOW Effect
Sliding this to the right increases the perceived height and width of the

audio image.

On/Off
Click this toggle button to turn the SRS WOW Effects on or off.

Speaker Settings
Click this to toggle through the following speaker settings: normal

speakers, large speakers, and headphones.
Graphic Equalizer settings

This pane allows you to adjust the audio to make it sound exactly the way
you’d like. If you want to boost the bass or cut out high notes, this is the
place to do it. Figure 2.11 shows the Graphic Equalizer pane.

Figuré 2.11 — Graphic Equalizer pane.

On the left you see ten sliders that correspond to ten divisions of the audio
spectrum, Move the leftmost slider up to increase the power of the lowest fre-
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quencies, move it down to reduce them. Similarly, the rightmost slider con-
trols the upper tenth of the spectrum (the highest frequencies). Play with the
sliders to see what sounds good to you.

To the immediate right of the sliders are two buttons. The top one turns the
graphic equalizer on or off. If it is off, the settings are completely “flat” that
is, no modification is made to the sounds. The bottom button toggles through
several presets that are based on popular styles of music. For example, the
Jazz preset will boost the middle frequencies more than the Acoustic setting,
If you make changes in the Custom preset, those changes will be saved for
the next time you use the Player.

To the right of those two buttons is a final horizontal slider that allows you to
adjust the stereo balance. Move it to the left to increase the apparent volume
of the left channel and to the right to increase the right volume.

Video settings

This pane allows you to adjust the video to make it look the way you like it.
If you want to adjust the brightness or the intensity of the color, this is the
place to do it. Figure 2.12 shows the Video Settings pane.

Figure 212 — Video Settings pane.

On the left side of the pane are four horizontal sliders. They adjust the
5 Brightness, Contrast, Hue, and Saturation of the video picture. To the right
i of these sliders is a button that resets all the sliders to their default (centered)

positions.

Here is a brief explanation of each slider:

5 Brightness
e This adjusts the brightness of the video picture. Slide it all the way to the

‘ left to make the picture completely black and all the way to the right to
it make it completely white. Usually you’ll want it somewhere in between.
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Contrast
Use this to sharpen or blur video images. Moving this slider all the way

to the left makes the picture sharper. This effect is sometimes known as
posterization. Moving it to the right makes the image look blurry, as if
everything was photographed in a dense fog or underwater.

Hue
Adjust the hue for basic color changes. Slide it to the left to make

everything more red/purple and to the right for green.
Saturation : :
This adjusts how much color is shown in the video. Slide the slider all the

way to the left, and only the gray tones are used, with no color at all.
Slide it all the way to the right, and the colors are extremely intense

(saturated).

Windows Media Information

This pane isn’t really a setting, but shows additional information about a par-
ticular item. For example, if you load the Sample Playlist, and open the Win-
dows Media Information pane, you’ll see something like Figure 2.13.

Figure 2.13 — Windows Media Information pane.

The Windows Media Information pane can display details such as genre and
label, but can also display pictures, links, and other useful information. In
this example, if you click the album cover or the link to the right of it, you’ll
‘be taken to a Web page that gives more details about the artist, album, label,
and so on. For more information on how to create advertising information
such as the kind you see in the Windows Media Information pane, see

Chapter 13.
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Captions

L This pane isn’t really a setting either, but shows captions for video files. See
1 Figure 2.14 for a typical caption file.

Figure 2.14 — Captions pane.

|
fk | For more information about captions, see Chapter 13.
n

Using menus

Many of the operations you can perform with buttons can also be done
through menus. The File menu is always available in the full mode view but
is also available in skins that provide menus. Here is a bnef listing of each
menu item and what it does.

File menu

The File menu helps you work with files. The followmg commands are avall—
able on the File menu:

Open
Use this to load a file, using the standard Windows Open dialog box. The
file you select will be loaded into anew playlist, and the file will start
playing.

Open URL _
Use this to load a file from a Web site or over a network. A URL

g (Uniform Resource Locator) is a path to a file; for example, http://

A internalsite/laure.wma is a URL. You must type a URL that links to an

: audio or video file. If you type a URL to a Web page, you will get an

aiii ' CITOr.

Close
This doesn’t close the Player; it closes the media file that is playing. It
stops the Player and deselects the current item in the current playlist.
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Add to Library
Use this to add a track to the media library. The media library is the
collection of all audio and video that the Player has information about.
When you select this option, you are given three choices: Add Currently
Playing Track, Add File, and Add URL. The first choice is useful when
you want to add the content that is currently playing to the media library.
The second and third choices are similar to the Open and Open URL
commands on the File menu except that instead of playing the file, the
Player just adds it to the media library.

Import Playlist to Library
Use this to import a playlist into the media library. Playlists are Windows
Media metafiles that have an extension of .asx, .wax, .wvx. You can also
import a .m3u file which will automatically be converted to a playlist.

Export Playlist to File
Use this to save a selected playlist in a text file. If you don’t have any
playlists selected (or any playlists at all), the media library will be saved

as a playlist.

Copy to CD
Use this to copy files to a CD. You must have a CD-ROM that is

recordable and a CD drive capable of recording. For more information
about copying files to a CD-ROM, see Chapter 3. You may not see this
menu item if you do not have a recordable CD drive installed on your

computer.
Properties
~ Selecting this will display information about the audio or video that is
currently playing. .

Work Offline
Use this option if you don’t want the Player to go out to the Internet to

gather information about CDs.
Exit
This will shut down Windows Media Player.

" View menu

The View menu helps you see all the different parts of Windows Media Player
and work with visual elements. The following commands are available

through the View menu:
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: Full Mode
This option returns you to the full mode view.

Compact Mode
Use this to change from full mode to a skin. Whatever skin you used last

will be the default skin.

Now Playing Tools
Select this to change how the Now Playing area looks. You can choose to
hide or display the playlist, title, and visualization portions of the pane.
You can also show or hide the following settings: SRS WOW Effects,
Graphic Equalizer, Video, Windows Media Information, and Captions.
Finally, you can also hide or show the resize bars, which are the bars that
separate the sub-panes of the Now Playing area.

Task Bar
The Task Bar menu command provides access to the same features
found on the Task Bar tabs at the left side of the full mode Player. The
following features are provided: Now Playing, Media Guide, CD Audio,
Media Library, Radio Tuner, Portable Device, and Skin Chooser. For
more information about the Task Bar, sec the “Changing views in full
mode” section of this chapter.

S L R A e

Visualizations ,
Selecting this option provides a list of the currently loaded visualizations.
Selecting a visualization shows you the presets that are available for each
visualization.

File Markers
Use this to go to a specific position in a file that has markers. If a file
doesn’t have markers, you can’t select this option. For more information
about file markers, see Chapter 12.

i Statistics

“ Selecting this option can show you how well the file is playing. This can
be particularly useful if you want to report problems with files that you
are receiving in real time through the Internet (called streaming). If there
are problems, you usually will know, but this option can give you exact
answers, such as how many packets are being lost during transmission.

Kull Screen

‘. If you are playing a visualization that supports it, use this option to have
‘ the visualization display over the full screen of your computer. Once in
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full screen, you can return to normal mode by pressing the ALT and
ENTER keys simultaneously.

Refresh
Use this to refresh the page when you are using the Media Guide,
.Portable Device, or Radio Tuner panes. If you think you’re looking at
yesterday’s Web page, you may be right. Some information in these task
panes is cached, that is, stored on your hard disk, depending on the
settings in Internet Explorer or your portable device.

Zoom
This allows you to change the size of a v1deo that is playing. You can
choose to make it fit the screen, or pick a specific percentage of the
original. The percentages are 50%, 100%, and 200%.

Play menu

The Play menu gives you most of the same options that the transport buttons
offer. The following commands are available through the Play menu:

Play/Pause
This starts the music or video program playing, or if it is already playing,
. pauses it. The Player must have at least one item in the media library in
order to play. Playing a paused file starts the file playing at the same
position it was paused at.

Stop
This stops the currently playing program. If you click Play after stopping
~ the program, the song or video will start over at the beginning.

Sklp Back |
This stops the currently playing item in the playlist and plays the
previous item in the same playlist. This corresponds to the Previous
button in the Player buttons at the bottom of the full mode Player. If you
are at the first item in a playlist and you select Skip Back, the last item in
the playlist will be played. ‘

Skip Forward
This stops the currently playing item in the playlist and plays the next
item in the same playlist. This corresponds to the Next button in the

Player buttons at the bottom of the full mode Player. If you are at the last -

item in a playlist and you select Skip Forward, the first-item in the
playlist will be played.
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Rewind
This rewinds a video in short intervals. You can only rewind videos that
are encoded in Windows Media Format. This corresponds to the Fast
Reverse button in the Player buttons at the bottom of the full mode
Player.

r Fast Forward

il This fast forwards a video in short intervals. You can only fast forward
il videos that are encoded in Windows Media Format. This corresponds to
| the Fast Forward button in the Player buttons at the bottom of the full
mode Player. '

Shuffle
This plays the items in the current playlist in a random order. It does not
change the order of the items in the playlist, only the order in which they
bl are played while the shuffle option is selected.

Repeat -
This repeats the playing of the entire current playlist, not specific items in
a playlist. If you want to repeat only one item, create a new playlist, put
only that item in it, and repeat that playlist.

Volume

This lets you nudge the volume up or down by a small amount, It also
allows you to mute the volume.

Tools menu

The Tools menu is for advanced features of Windows Media Player. The fol-
lowing commands are available through the Tools menu:

Download Visualizations

Select this to go to 2 Web page that will let you download new
visualizations. -

Search Computer for Media _

Use this to search your computer for all audio and video files. The Player
will add the files it finds to your media library and divide them between
the audio and video collections. If you choose the option to search for
WAYV and MIDI files, you will add a lot of Windows sound effects that
you may not want to play with the Player; on the other hand, you may
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discover some interesting MIDI files that are hidden away inside your
Windows folder. You can choose to load from local drives, network
drives, all drives, or a specific drive, and even a specific directory. If you
have mapped a network drive to your computer, you can search that
drive as well. For example, if drive X: is mapped to a network drive, you
can search that drive, or directories on that drive.

License Management
If you download music that requires a license, or make copies of CD
tracks, this option specifies where you want to store the licenses on your
computer. You might want to pick a folder that you can find easily so you
can conveniently back up your licenses to another drive or storage
medium. If you pay for a song and the song needs a license to play,
you’ll want to take good care of your licenses. For more information
about licensing, see “Understanding digital rights” in Chapter 3.

Options
This is the option for everything else not covered in other menu items.
The following section, “Options dialog box,” provides more information
about this menu itemn.

Options dialog box

If you go to the Tools menu and click Options, the Options dialog box is dis-
played. It covers various options you may want to change. The following
tabs are included in the Options dialog box:

Player

- 'This tab lets you set how often you want Windows Media Player to check
for software upgrades (daily, weekly, monthly), whether you want the
Player to automatically download codecs it needs (See Chapter 3 for

- more about codecs.), whether you want the Player to identify itself to
Web sites and download licenses automatically, whether you want the
Player to start up in Media Guide (instead of whatever you mode you
used last time), and whether you want skins to be on top of other
windows. You can also decide whether you want the anchor to be
displayed when using skins. The anchor window is a small window that
appears in the lower right corner of the screen when Windows Media
Player is in compact mode. You can click the anchor window, and then
click Return to Full Mode to return to the full mode of the Player. Most
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of the time you’ll want to leave these options the way they were initially
set.

Network .
If you are an advanced networking user, you can use this tab to set

’ proxies, ports, and protocols.

f ‘ CD Audio

T Use this to set up how you will play or record CDs. For playing CDs, you
can choose whether to use digital playback, if your computer supports it,
1. and whether to use error correction. Change these options if you are
having problems playing CDs. For copying music from CDs, you can

‘ select how much compression to use when converting music from CD

I format to music file formats. You’ll have to choose between smaller file

' sizes and better quality. You can also choose whether to use digital
copying or error correction, and whether to use personal rights
management. Finally, you can choose what folder you want the copied
audio files to be created in. For more information about copying CDs and
digital rights, see Chapter 3.

Portable Device
If you have a portable device, you can use this pane to decide whether to
let the Player convert the music automatically or let you pick a tradeoff
between file size and audio quality. You can also click a button and find
out what devices are supported by Windows Media Player. For more
information about portable devices, see Chapter 5.

Performance
You might want to use this tab if you are having trouble with viewing live
files (streaming). You can tell the Player what network connection you
have, how much buffering to do, whether you want to use hardware
acceleration with video, and how to adjust digital video settings. For
more information about streaming, see. Chapter 4.

Media Library
Use this tab to set access rights to your media library. You can specify
what levels of access you want to grant outside Web sites to read or
modify the media in your library. This involves both security and privacy
issues. This also specifies whether you want Internet music purchases to
be added to your library automatically.
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Visualizations :
If you have installed a visualization that has properties you can change,
go to this tab to change them. For example, the Ambience visualization
will let you set the full-screen size and offscreen buffer size. You can also
use this tab to load a visualization that is stored on your computer but
that is not registered with the Player. Be sure you know the source of any
visualization before loading, and load them from only trusted sites, so
that you can avoid viruses.

Formats
Use this tab to make sure the Player plays the file formats you want it to

play. If another brand of player starts playing a file that you want
Windows Media Player to play, change the file association here, if it is a
file format the Player can play.

Help menu

The Help menu gives you help and information. This menu has the following
three commands:

Help Topics

This command launches the Help file that comes with Windows Media
Player. The Help file covers all the features you need to know about to
use the Player. You can also get the Help file by pressing the F1 key on
your computer at any time while Window Media Player is the active
Window.

Check For Player Upgrades
. Use this command any time you’re curious about upgrades to Windows
Media Player. The Player will do this automatically for you, but you may
want to do it yourself if you’ve heard news of a new version.

About Windows Media Player
This will display the name, copyright, version number, and product ID of

Windows Media Player.
Compact mode shortcut menu

When Windows Media Player is in compact mode, you can right-click the .
skin and get a menu. Each of the commands on the menu corresponds to a
similarly named command on one of the menus of the full mode Player.
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Table 2.1 shows the commands on the menu of the compact mode along with

their corresponding full mode menu commands.

Compact mode menu comménd Full mode menu command
Open File menu Open option
Open URL File menu Open URL option
Shuffle Play menu Shuffle option
Repeat Play menu Repeat option
Volume Play menu Volume option
Play/Pause Play menu Play/Pause option
Stop Play menu Stop option
Skip Back Play menu Skip Back option
Skip Forward Play menu Skip Back option
Return to Full Mode Play menu Skip Forward option
Full Screen View menu‘ Full Screen option
Properties File menu Properties option
Staﬁstics View menu Statistics 6pﬂon
Options Tools menu Options option
Help Help menu Help Topics option
About El:ll;e:lsgz c:Iklbout Windows Media
| Exit File menu Exit option

Table 2.1 — Menu commands of the compact mode Player.
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Changing views in full mode

The full mode of Windows Media Player has seven views that are accessed
by clicking tabs on the Task Bar, which is on the left side of the window.
Each view gives you a different way to interact with audio and video. Here is
a list of the views:

Now Playing
This view shows a visualization or video on the left pane and a playlist
on the right. You can also display a hidden settings pane to make various
adjustments or see additional information. You’ll spend most of your time

in this view.

Media Guide
This is the default view of the Player and opens up a world of audio and
video through the Internet. You can get daily news of new audio and
video releases, tune in to Internet radio stations, and download tons of
things to see and hear, most of it free! For more help with downloading,
see the “Finding files on the Internet” section in this chapter.

CD Audio
If you have a CD player in your computer, you can play your CD tracks
using Windows Media Player. For more information about using CDs, see
the “Copying music from CDs” section in this chapter. For more
information about creating your own CDs, see Chapter 3,

Media Library
This is where you can organize all your audio and video. You can search

for audio and video files on your computer, create playlists, and change
your Internet radio presets here. For more information about working
with playlists, see the “Using playlists” section of this chapter.

Radio Tuner
Use this feature to search out and sort Internet radio stations. From
around the world or around the block, you can listen to music every hour
of every day and never hear the same thing twice!

- Portable Devices
Use this pane to download music to your Pocket PC or other portable
device. For more information about portable devices, see Chapter 5.
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Skin Chooser
Use this to apply skins that came with your installation. You can also use
this feature to download new skins from the Windows Media Skins
- Gallery Web site. Once you try one skin, you’ll never want to stop! New
skins will be appearing frequently, so check this site often.

Finding files on the Internet

Now that you know how to use the Windows Media Player, you can go out
on the Web and find more music. You can use a browser to do this of course,
but Windows Media Player gives you a special window to the world of music
and video. This window is called the Media Guide. Earlier in this chapter
you saw a typical view of the Media Guide in Figure 2.1a.

The Player will start up with the Media Guide view. You can always get to it
by using the full mode of the Player and clicking Media Guide on the Task
Bar on the left side of the Player. If you don’t want Media Guide to be the
default view, go to the Tools menu and click Options; then click the Player
tab and clear the Start Player in Media Guide check box.

The Media Guide is a window to the WindowsMedia.com Web site. The Me-
dia Guide has hundreds of links to new audio and video files to play and
download, and gives you lots of information about what’s new in the world
of audio and video. You can spend hours and hours exploring the Media
Guide. -

For more information about file formats you can download, see Chapter 3.
For information about seeing and hearing files without waiting to download
them (streaming), see Chapter 4.

Copying music from CDs

If you want to listen to music from different CDs without inserting and re-
moving your CDs all the time, Windows Media Player can save you a lot of
time. All you have to do is copy the CD (or just the tracks you want) onto
your computer, then assemble the tracks into playlists and create your own
customized musical experience.

1 Also, you can have the Player compress the files so they won’t take up as
i much room on your hard disk. You can control the amount of compression
i you need. Choosing high compression will create files that won’t sound as
| good but will take up less space.
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Copying tracks

Copying CD tracks is extremely easy. All you need to do is load a CD into
your CD-ROM drive and start Windows Media Player. When the Player starts,
it loads the CD tracks into a playlist and displays the CD Audio pane of the
full mode Player. Figure 2.15 shows a typical CD Audio pane, which you can
always get to from the full mode view of the Player by clicking the CD Audio
tab of the Task Bar on the left side of the Player.

If you are connected to the Internet, the Player will go out to a database and
get information about each track on the CD, showing you not only track
names and lengths, but artist, genre, style, and so on. On many CDs, you can
even click the Album Details and go to a Web site that contains more infor-
mation about the CD.

After you’ve loaded your CD, all you have to do is decide which tracks you
want to copy to your computer. After you've decided, select the check box at
the left of each track to select the tracks you want to copy.
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Figure 2.15 — Audio CD pane.

When you’re ready to copy, just click the red Copy Music button. You’ll see
that the Player starts copying because there is a Copy Status column in the
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i CD Audio playlist, and the status will be displayed: Files that are being cop-
i ied will have a percent-copied display; files that will be copied are labeled
i “Pending” and when a file is finished copying, it will be labeled “Copied to
Library” in the status columnn.

Selecting copy options

There are several options you can select that will allow you to change the
way that the Player copies files from a CD to your computer. Click Options
on the Tools menu, and then click the CD Audio tab. You’ll see the following

choices:

Digital playback (under Playback Settings)
This setting only applies to playback, not to copying CDs. If your
computer supports digital playback, select this check box and see how
digital playback sounds. If you don’t select this option, you will not be
able to see visualizations.

Use error correction (under Playback Settings)
This setting only applies to playback, not to copying CDs. If you are
experiencing a lot of errors, selecting this check box may help correct
them during playback. You’ll know you’re getting errors if the audio
sounds as if parts are missing or the video starts jumping around and
missing frames. You can only select this if you have also selected the
Digital playback check box.

Copy music at this quality (under Copying Settings)
Windows Media Player can compress the digital information in the files it
creates so that the files will be smaller. It does this using a variety of
techniques. Depending on the type of music you’re copying, you may or
may not notice the difference. You can choose the amount of
compression with a slider bar. An average music CD can be compressed
from as small as 28 MB to as large as 70 MB. The larger the file, the

better the sound quality.

Digital copying (under Copying Settings)
Select this check box to copy CD tracks to audio files that enable digital

playback. Not all computers and sound cards have digital playback. If

yours do, this is a good option to use, and the sound'doesn’t need to be :
P converted to analog and back to digital. If you’re not sure, try a track f
il both ways and see what you like. ‘
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Use error correction (under Copying Settings)
You can only select this check box if you’ve also selected the Digital
copying option. Use this if your tracks are producing errors. Once again,
if you're not sure whether to use this, try a track both ways and listen to
the results.

Enable Personal Rights Management (under Copying Settings)
If this check box is selected, the files you create will have information
attached to them indicating that they were created on your computer. You
will definitely want to keep this option checked if you want to copy your
files to a portable device such as a Pocket PC; many portable devices will
not play music if you have not licensed the appropriate rights for a
particular file. However, if you keep this option checked, you cannot
play files you have copied on another computer. So if you want to copy
files from your CD and then transfer them to another computer, you
should not select this option. Of course, before copying and transferring,
be sure you have the legal right to do so. The issues of digital rights are
covered in Chapter 3.

Using playlists

A playlist is a convenient way to organize groups of audio and video files.
The term comes from the radio industry and refers to the list of songs that a
disc jockey plays on a particular radio program. ‘ :

You might want to make up playlists for different performers or different
kinds of music or videos. You can shuffle playlists or repeat them endlessly.
This way, you can create a media experience that is continuously entertain-
ing. |

You can see which playlist is playing by looking in the upper-right corner of
the full mode Player. You will see a drop-down list box, which shows the cur-
rent playlist.

Using the Media Library

. The Media Library is the key to understanding playlists. The Media Li-
brary is where you create your playlists. You can get to the Media Library
by choosing the Media Library tab on the Task Bar of the full mode Win-
dows Media Player. Figure 2.16 shows a typical view of the Media Library.
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Figure 2.16 — Media Library.

On the left side of the Media Library you’ll see a tree-like list of all the au-
dio and video that the Player has information about, as well as all playlists
and radio presets. This is set up similar to Microsoft Windows Explorer in
that you click an item on the left and the contents of: that item appear on the

right.
The Media Library is divided into the following sections:

Audio

Video

My Playlists

Radio Tuner Presets

Deleted Items :

Each section is a node in the tree. Figure 2.17 shows the five nodes of the
Media Library. ’

50

BHM Ex. 2007




Chapter 2: How Does the Player Work?

Figure 2.17 — Five nodes of the Media Library.

Figure 2.18 shows the nodes expanded by one level for each node. You can
expand a node to show the items inside it by clicking the plus sign to the left
of the node name. '

Figure 2.18 — Media Library nodes expanded by one level.

You can explore the contents of the Media Library by expanding the nodes.
Any time you click one of the node item names, the contents of that node, if
it is a folder, will be displayed in the right pane of the Media Library.

Understanding the audio collection

The audio collection is the part of the library that keeps track of audio files
on your computer and other audio files that the Player has information about
(for example, files on the Internet).

Adding Audio Files

You can add to the audio collection in several ways:

e Click the File menu, click Open, and then choose an audio file, ,

* Click the File menu, click Open URL, and then choose an audio file.

e Click the File menu, click Add to Library, and then choose an audio file.
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* Click the File menu, and click Import Playlist to Library (if the playlist
+ has links to audio files in it).

* From the CD Audio task pane, copy a CD track to your computer.

¢ Start an audio file playing by double-clicking it.

 Start an audio file playing by right-clicking it and selectlng the Play op-
I tion.

Sorting audio files

You can find a file by clicking the Search button at the top of the Media Li-
brary pane.

i The Audio collection is a database of audio files, and like other databases, it
stores not only the file name and location of audio files, but additional infor-
mation such as artist, album, and genre. This additional information is used
to sort the Audio collection into at least four categories. You can see the cat-
egories by clicking the nodes to the left of the Audio label. Figure 2.19 shows
the four nodes inside the Audio collection.

Figure 2,19 — The four nodes of the audio collection.

" Here is an explanation of each category:

All Audio

This includes a list of all audio that Windows Media Player has
1 information about.
] Album
This shows a list of all music that is associated with albums. The album
il information can come from a CD, from a playlist, or can be embedded in
the file itself. The Player can get album information about CDs from
Internet databases.

BHM Ex. 2007



Chapter 2: How Does the Player Work?

Artist
You can see a list of all the artists that are associated with the audio files

in the Audio collection.

Genre
If you want to find audio files that have a genre associated with them,

this 1is the place to look. 7
Understanding the video collection

The video collection uses the same concepts as the audio collection except
that it keeps track of video files. Instead of All Audio, the video collection
will refer to All Clips, Artist becomes Author, and there is no album or genre
equivalent for videos.

Understanding My Playlists

This is a collection of all playlists that the Player has information about.
Playlists are lists that you create of audio and video content.

Creating playlists

Creating playlists couldn’t be simpler. Click the New Playlist button at the
top left of the Media Library and enter the new playlist name.

Adding to playlists

You can add to playlists by doing the following:
1. Create your playlist.

2. Find the audio or video file you want to add. You must open an Audio or Video
collection and select a file from the collection. For example, open the Audio
collection, then open the Artist collection, choose an artist you like, displaying

all the songs by that artist in the right pane.

Select the audio or video file, and add it to the playlist. You can do this in one of
two ways. The easy way is to right-click the file and choose the Add to Playlist
option. You’ll be provided with a list of playlists. Pick one and you're done.
There’s also an Add to Playlist button at the top of the Media Library pane if
you prefer to click a button.

You can also select the audio or video file and drag it to the playlist in the left
pane. This requires a bit of opening and closing of nodes in the collection, but
after you get used to it, you’ll find that this is a useful way to work with
complicated playlists,
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Deleting and renaming playlists

You can also delete and rename playlists by right-clicking a playlist and
choosing the delete or rename option. Deleted playlists aren’t really deleted,
they are transferred to the Deleted Items part of the Media Library.

Deleting media items and playlists

I you delete an item in the audio or video collection, the item is transferred
to the Deleted Items part of the Media Library. The same is trne for deleted
playlists. This is similar to the Recycle Bin in Windows.

Restoring media items and playlists

You can get the file or playlist back by right-clicking it and selecting the Re-
store option. The file or playlist will return to the place you deleted-it from.

Permanently deleting media items and playlists

If you want to permanently erase the media items and playlists you deleted,
I you can reclaim their disk space by right-clicking the Deleted Items node

¢ and choosing the Empty Deleted Items option. Be careful! After you do this,
i you can’t go back! But at least you’re given an option to change your mind
before the media files and playlists are gone forever.

Using the Radio Tuner

The Radio Tuner feature lets you use the Player to listen to Internet radio sta-
tions from around the world. Thousands of stations broadcast audio pro-
4 grams of music, news, and commentary.

- Figure 2.20 shows the Radio Tuner view, which you can get to by clicking
Radio Tuner in the task bar on the left side of the full mode of Windows Me-
dia Player.
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Figure 2.20 — Radio Tuner view in the full mode Player.

The Radio Tuner view has two panes: Station Finder and Presets.

Using Station Finder

The Station Finder can help you tune in to Internet Radio stations. Even
though there are thousands of stations around the globe, you can easily find
one you like with only a few clicks. The contents of the Station Finder are
updated frequently by WindowsMedia.com so that as new stations go on the
air, you can tune in to them right away.

All the stations are listed in a table that sorts them by station name, speed,
frequency, and format or city. You can sort the table rows by clicking the col-
umn heading you want to sort on. Double-click a station listing to start it
playing.

Above the table of radio stations is one or more list boxes. The box on the
left has several categories that you can use to find particular radio stations,
including the following: :

Format
This gives you a set of predefined radio station formats ranging from

Alternative Rock to Classical to News Radio.
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Band
‘You can choose to search through the AM band or FM band, or choose

Internet-only.

Language
There are several spoken langunages to choose from, including Chinese,
English, Latvian, and 20 others.

Location
Countries such as the United States, Finland, Korea, and 30 others are

represented in the table listings with radio stations. If you choose the
United States, you can search by state.

Callsign
If you know the call letters of a radio station, you can find the station by
typing the call letters in the search box. For example, if you type
“CKWW?”, you’ll listen to station CKWW in Detroit, Michigan, that
specializes in big band music.

Frequency
You can tune in to a station by typing the frequency; for example, 88.5
on the FM dial would give you radio station KPLU in the Seattle,

Washington, area.

Keyword _
If a station has a slogan, you can find it with a keyword. For example,
searching for “oldies” will give you several stations to choose from.

Using station presets

There are two default presets that you can use to sort radio stations that you
will want to use often. One is called Featured and has stations that are cur-
rently featured by Windows Media Player. You can’t add stations to Featured.
But you can add radio stations that you want to use frequently to My Presets.

You can create your own preset categories by élicking the Edit button above
the Presets list.

Working with radio stations in the Media Library

All presets created in the Radio Tuner are automatically copied to the Media
‘ i Library in the Radio Tuner Presets category.
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